Copyright

Copyright © 2002-2013 Intergraph® Corporation. All Rights Reserved. Intergraph is part of Hexagon.

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software license agreement; contains confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law, trade secret law, and international treaty, and may not be provided or otherwise made available without proper authorization from Intergraph Corporation.

U.S. Government Restricted Rights Legend

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was developed at private expense and is “restricted computer software” submitted with restricted rights in accordance with subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal Acquisition Regulations (“FAR”) and its successors, and is unpublished and all rights are reserved under the copyright laws of the United States. For units of the Department of Defense (“DoD”): This is “commercial computer software” as defined at DFARS 252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3.

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
300 Intergraph Way
Huntsville, AL 35813

Documentation


Other Documentation

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on eCustomer, SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph as guidance for using a software product.

Terms of Use

a. Use of a software product and Documentation is subject to the End User License Agreement ("EULA") delivered with the software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take precedence and govern the use of this software product and Documentation. Subject to the terms contained within the applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal, non-commercial use. The Documentation may not be printed for resale or redistribution.

b. For use of Documentation or Other Documentation where end user does not receive a EULA or does not have a valid license agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial use. The Other Documentation may not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and for any reason by Intergraph Corporation by giving written notice to Licensee.

Disclaimer of Warranties

Except for any express warranties as may be stated in the EULA or separate license or separate terms and conditions, Intergraph Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its publication date. The information and the software discussed in this document are subject to change without notice and are subject to applicable technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document.

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.

Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. Users should verify for themselves that the data is accurate and suitable for their project work.

Limitation of Damages

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL, SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2) YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW.

Export Controls

Intergraph Corporation's software products and any third-party Software Products obtained from Intergraph Corporation, its subsidiaries, or distributors (including any Documentation, Other Documentation or technical data related to these products) are subject to the export control laws and regulations of the United States. Diversion contrary to U.S. law is prohibited. These Software Products, and the direct product thereof, must not be exported or re-exported, directly or indirectly (including via remote access) under the following circumstances:

a. To Cuba, Iran, North Korea, Sudan, or Syria, or any national of these countries.


c. To any entity when Licensee knows, or has reason to know, the end use of the Software Product is related to the design, development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive nuclear uses.

d. To any entity when Licensee knows, or has reason to know, that an illegal reshipment will take place.

Any questions regarding export or re-export of these Software Products should be addressed to Intergraph Corporation's Export Compliance Department, Huntsville, Alabama 35894, USA.

Trademarks

Intergraph, the Intergraph logo, PDS, SmartPlant, SmartMarine, FrameWorks, I-Convert, I-Export, I-Sketch, IntelliShip, ITools, ISOGEN, MARIAN, SmartSketch, SPOOLGEN, SupportManager, and SupportModeler are trademarks or registered trademarks of Intergraph Corporation or its subsidiaries in the United States and other countries. Microsoft and Windows are registered trademarks of Microsoft Corporation. MicroStation is a registered trademark of Bentley Systems, Inc. Other brands and product names are trademarks of their respective owners.

Portions of the user interface copyright 2012 Telerik AD.
# Contents

## Preface
- SmartPlant Foundation Product Documentation ................................................................. 9
- Documentation Comments ........................................................................................................ 9

## Welcome to SmartPlant® Foundation.................................................................................. 15
- SmartPlant Foundation Internationalization ........................................................................ 17

## SmartPlant Foundation Hardware and Software Recommendations ............................... 21
- SmartPlant Foundation Recommendation Summary ............................................................. 22
- SmartPlant Foundation Database Server .............................................................................. 23
- SmartPlant Foundation Application Server .......................................................................... 25
- SmartPlant Foundation License Server ................................................................................ 26
- SmartPlant Foundation Alternate Server ............................................................................. 27
- SmartPlant Foundation File Server ..................................................................................... 28
- SmartPlant Foundation Workstation .................................................................................... 29
- SmartPlant Foundation Web Portal Server .......................................................................... 30
- SmartPlant Foundation Web Portal Client ........................................................................... 30

## Setting Up Databases............................................................................................................. 33
- Setting Up the Database Server ............................................................................................ 33
  - Install Database Software on the Database Server ............................................................. 33
  - Create the SmartPlant Foundation Database Instance ...................................................... 34
  - Set Security on the Oracle Home Folder .......................................................................... 35
  - Maximum Positive and Negative Database Values ............................................................ 35
  - Optimizing Oracle Databases ............................................................................................ 36
- Setting Up Database Access on the Application Server ......................................................... 36
  - Install Database Software on the Application Server ........................................................ 36
  - Set Up Database Access .................................................................................................... 37

## Setting Up the Application Server ...................................................................................... 39
- Installing Prerequisite Software on the Application Server ................................................ 39
- Installing Software on the Application Server ...................................................................... 40
  - Install Schema Component.NET ..................................................................................... 40
  - Install Schema Component .............................................................................................. 41
  - Install SmartPlant Foundation .......................................................................................... 42
  - Installing the Software in Silent Mode .............................................................................. 44
  - Installing Hot Fix Packages .............................................................................................. 47
- Using Server Manager to Configure the Application Server ................................................ 48
  - Configuring the Application Server .................................................................................. 48
  - Defining the Application Server Default Folder Structure ................................................. 49
  - Granting Permissions ........................................................................................................ 50
  - Setting Up Sites ................................................................................................................ 53
- Configuring Windows Server 2008 R2 ............................................................................... 64
  - IIS Requirements for an Integrated Environment ............................................................... 65
  - Configure Maximum Worker Processes .......................................................................... 65
  - Minimum IIS Application Mappings .................................................................................. 66

---

SmartPlant Foundation Installation and Setup Guide
# Contents

Define MIME Types ................................................................. 66  
Suggested IIS Configuration Settings .................................................. 69  
Edit IIS Site Bindings ................................................................. 69  
Configure Office Reference Files ..................................................... 71  
Setting the Theme for Running the Desktop Client on the Server .............. 72  
Configuring Security for the Application Server .............................. 73  
Changing Security Settings in Excel ................................................ 73  
IIS Security .................................................................................. 80  
Set Up Integrated Windows Authentication ........................................ 80  
Set Up HTTPS ............................................................................ 83  
Configuring FTR and Remote Services for HTTPS ......................... 85  
Permissions for SmartPlant Foundation Processes .......................... 86  
Security for IIS Sites .................................................................. 87  
Port Assignments for SmartPlant Enterprise .................................... 89  

Upgrading SmartPlant Foundation .................................................. 93  

Setting Up SmartPlant Foundation File Servers ............................... 95  
Remote File Service Overview ....................................................... 96  
Install the File Server Software .................................................... 97  
Configuring Virtual Directories for a Remote File Server .................. 97  
Configure a Remote File Service with Server Manager ..................... 98  
Configure a Remote File Service Manually .................................... 99  
Configuring Vaults on the File Server .......................................... 100  
Setting up a Host for the File Server ............................................ 101  
Create a New Vault ..................................................................... 103  
Configure Document Management for a Vault ............................. 104  
Force a Class of Object to a Vault ............................................... 105  
Configuring Vault Replication ..................................................... 105  
Considerations for Setting Up Vault Replication ............................ 108  
Vault Replication Configuration Checklist .................................... 108  
Set Up Remote File Services for Vault Replication ....................... 108  
Relate Replicated Vaults to Source Vaults .................................... 109  

Configuring SmartPlant Foundation .............................................. 111  
Setting Up PDF Generation ....................................................... 112  
Configuring PDF Generation with SmartPlant Markup Plus .............. 112  
PDF Generation with Custom .INI Settings .................................... 113  
SmartPlant Foundation Settings for SmartPlant Markup Plus .......... 114  
Additional Settings and Tips Required for Generating a PDF/CSF ........ 115  
Setting Up E-mail for SmartPlant Foundation ................................. 125  
Change the E-mail Transport Method for SmartPlant Foundation .......... 125  
Test Email Configuration Command .......................................... 125  
Setting Up an Alternate Scheduler Server .................................... 126  
Setting Up Enhanced Mechanical Equipment Data Sheets ................ 127  
Install Enhanced Mechanical Equipment Data Sheets .................... 127  
Setting Up Enhanced Mechanical Equipment Data Sheets .............. 128  
Delivered Data Sheets .................................................................. 130  
Configuring the Security Model .................................................. 131  
Security Model Configuration ..................................................... 131  
Enhancing Performance ............................................................. 131  
Remove Audit Domain from an Upgraded Database ...................... 131
Setting Up a SmartPlant Foundation License Server ................................................................. 133
  Installing Prerequisite Software on the License Server .......................................................... 134
  Installing the SmartPlant License Manager Client on the License Server .............................. 134
  Configuring a License Server .................................................................................................... 134
  Defining the Application Server Default Folder Structure ...................................................... 135
  Grant permissions ....................................................................................................................... 135
  Permissions Script Files ............................................................................................................. 137
  Set Up a License Manager Site .................................................................................................. 139
  Start the license server wizard ................................................................................................. 139
  Configure the license server for performance ......................................................................... 142
  Link the License Server to a SmartPlant Foundation Site ....................................................... 143
  Configuring the SmartPlant License Manager Client ............................................................... 143

Configuring Web Portals ............................................................................................................ 145
  Create a New Web Portal .......................................................................................................... 145
  Delete a Web Portal .................................................................................................................. 146
  Add a Web Portal Server .......................................................................................................... 146
  Modify Web Portal Server Settings .......................................................................................... 146
  Delete a Web Portal Server ....................................................................................................... 147
  Configure the Web Portal Authentication Method .................................................................... 147
  Configuring Integrated Windows Authentication (IWA) in a Double Hop Web Portal Configuration .......................................................... 148
  Move a Web Portal onto a New Server ...................................................................................... 150
  Using the Web Portal with Microsoft Internet Explorer 8 or 9 ................................................ 151
  Add a Custom HTTP Header on the Web Portal Server ............................................................ 151
  Add a Server to the Compatibility View Settings in Internet Explorer 8 or 9 .......................... 152

Setting Up Client Workstations ................................................................................................ 153
  Install Prerequisite Software on the Client Workstations ....................................................... 153
  Permissions for Users on a Windows 7 Client with UAC Enabled ......................................... 154
  Install Schema Component.NET .............................................................................................. 154
  Install the Desktop Client ........................................................................................................ 155
  Installing the Desktop Client in Silent Mode ............................................................................ 155
  Disabling the Business Intelligence Module ............................................................................ 156

Backing Up and Restoring Data ................................................................................................ 157
  Back Up the SmartPlant Foundation Server ............................................................................ 157
  Data Protection and Recovery for Installations Using Oracle ................................................... 158
  Data Protection and Recovery for Installations Using SQL Server ......................................... 159
  Performing a Cold Database Backup on the SmartPlant Foundation Server ........................ 160
  Restore SmartPlant Foundation Databases Using Oracle ....................................................... 160
  Restore SmartPlant Foundation Databases Using SQL Server .............................................. 161

Customer Support .................................................................................................................... 163

Appendix A: Alternate Desktop Client Deployment ................................................................. 165
  Running Desktop Client from a UNC Share ............................................................................. 165
  Running Desktop Client from a URL ....................................................................................... 166
  Increasing Trust for Deploying the Desktop Client ................................................................. 167
Contents

Appendix B: Desktop Client and Web Portal Launch Parameters ..................................................... 169
  Desktop Client Command Line Parameters ................................................................. 169
    Parameter Formatting .............................................................................................. 169
  Command Line Parameters ....................................................................................... 170
  API Parameters ....................................................................................................... 171
  Web Portal URL Parameters ..................................................................................... 173

Appendix C: Configuring Citrix® for SmartPlant Foundation ..................................................... 175
  System Requirements for Citrix Servers ..................................................................... 175
  Install Citrix Software .............................................................................................. 175
  Install and Configure the Software for Citrix .......................................................... 176

Appendix D: Configuring IIS Application Pools and User Accounts Manually .......................... 177
  Create a New User Account for Application Isolation .................................................. 177
  Creating and Configuring Application Pools in Windows Server 2008 ....................... 178
    Create a New Application Pool in Windows Server 2008 .......................................... 179
    Configure an Application Pool Identity Using a Configurable Account in Windows Server 2008 ................................................................. 179
    Assign the Software to an Application Pool in Windows 2008 ................................. 180
  Configuring COM+ Applications in Windows Server 2008 ....................................... 180
  Configuring Folder Permissions in Windows Server 2008 .......................................... 181

Appendix E: Setting Up a FLEXlm License Server ............................................................... 183
  Installing License Manager on a Remote Server ....................................................... 183
  Obtaining Your Host ID and Disk Serial Number ...................................................... 184
  Activating Licensing ................................................................................................ 184
    Activate the Token License File ............................................................................... 185

Glossary ........................................................................................................................... 189

Index ................................................................................................................................. 209
Preface

This document contains information about the installation and configuration of SmartPlant® Foundation. This document is intended for system administrators and users who are installing and setting up SmartPlant Foundation.

You can install SmartPlant Foundation as a stand-alone application or as part of SmartPlant Enterprise. When you install SmartPlant Foundation as a stand-alone product, all the standard SmartPlant Foundation data management functionality is available to you, but SmartPlant Enterprise-specific authoring tool integration is not available. Typically, each customer uses SmartPlant Foundation either as a stand-alone product or as part of SmartPlant Enterprise, but not both.

**IMPORTANT** If you want to install and configure SmartPlant Foundation and other products that are part of SmartPlant Enterprise, see the *Integration Setup Guide*, delivered with SmartPlant Foundation.

**SmartPlant Foundation Product Documentation**

SmartPlant Foundation documentation is available as Help and as Adobe® PDF files. To view printable guides for SmartPlant Foundation, click **Help > Printable Guides** in the software.

Intergraph gives its customers permission to print as many copies of the delivered PDF files as they need for their non-commercial use. Do not print the PDF files for resale or redistribution.

**Installation and Overviews**

- **SmartPlant Foundation Core Functionality & Enterprise Integration Capabilities Release Bulletin** - Provides information on new SmartPlant Foundation and integration features for the current release.
- **SmartPlant Foundation Installation and Setup Guide** - Provides installation and setup instructions and troubleshooting information for stand-alone SmartPlant Foundation.
- **SmartPlant Foundation Licensing Guide** - Provides information for installing and configuring licenses in SmartPlant Foundation.
- **SmartPlant Foundation Upgrade Guide** - Provides step-by-step instructions for upgrading from SmartPlant Foundation or SmartPlant Basic Integrator version 2008 and later to the current version.

**User’s Guides**

- **SmartPlant Foundation Desktop Client User’s Guide** - Provides instructions for creating, viewing, updating, and managing objects and their relationships. Additionally, it provides information about completing workflow steps and using SmartPlant Foundation in an integrated environment.
- **SmartPlant Foundation Business Intelligence User’s Guide** - Provides information and procedural instructions for using the SmartPlant Foundation Business Intelligence module.
Preface

Administrative Guides
- **SmartPlant Foundation Administrator's Guide** - Provides SmartPlant Foundation administrators with basic information about how to administer standalone SmartPlant Foundation.
- **SmartPlant Foundation Server Manager User's Guide** - Provides instructions for using SmartPlant Foundation Server Manager to configure the SmartPlant Foundation server and to upgrade SmartPlant Foundation databases.

Troubleshooting Guide
- **SmartPlant Foundation Troubleshooting Guide** - Contains information about troubleshooting the installation and configuration of SmartPlant Foundation.

Reference Guide
- **SmartPlant Foundation/Integration Architecture Guide** - Describes the architecture of the SmartPlant Foundation and integration software.

Model Configuration Guides
- **How To Guide Master Table of Contents** - Provides a copy of the table of contents of each "How to" document in the SmartPlant Foundation documentation set. Use this document to locate the guide that contains a particular topic without opening each "How to" guide to search for the topic.
- **How to Configure the Authoring and Data Warehouse Models** - Provides information for system administrators on how to configure the authoring and data warehouse models in SmartPlant Foundation and describes the underlying data model.
- **How to Configure Classified Objects** - Provides information for system administrators on how to configure classified objects in SmartPlant Foundation and describes the underlying data model.
- **How To Configure the Consolidated Data Warehouse (CDW)** - Provides information for system administrators on how to configure the CDW in SmartPlant Foundation and describes the underlying data model.
- **How to Configure Concurrent Engineering** - Provides information for system administrators on how to configure concurrent engineering in SmartPlant Foundation and describes the underlying data model.
- **How to Configure the Data Sheet Model** - Provides information for system administrators on how to configure the data sheets model in SmartPlant Foundation and describes the underlying data model.
- **How to Configure Document Management** - Provides information for system administrators on how to configure document management in SmartPlant Foundation and describes the underlying data model.
- **How to Configure the GUI Model** - Provides information for system administrators on how to configure the graphical user interface (GUI) model in SmartPlant Foundation and describes the underlying data model.
- **How to Configure the Infrastructure Model** - Provides information for system administrators on how to configure the infrastructure model in SmartPlant Foundation and describes the underlying data model.
- **How to Configure the Line List Model** - Provides information for system administrators on how to configure the line list application in SmartPlant Foundation and describes the underlying data model.
Preface

- **How to Configure Performance** - Provides information for system administrators on how to enhance the performance of SmartPlant Foundation.
- **How to Configure the Progress Model** - Provides information for system administrators on how to configure the progress model in SmartPlant Foundation and describes the underlying data model.
- **How to Configure Reports** - Provides information for system administrators on how to configure reporting in SmartPlant Foundation and describes the underlying data model.
- **How to Configure the Security Model** - Provides information for system administrators on how to configure the security model in SmartPlant Foundation and describes the underlying data model.
- **How to Set Up and Configure SmartPlant Foundation** - Provides information for system administrators on how to set up and configure SmartPlant Foundation after install.
- **How to Configure the Workflow Model** - Provides information for system administrators on how to configure the workflow model in SmartPlant Foundation and describes the underlying data model.

Integration Guides

- **SmartPlant Enterprise Overview** - Provides an overview of SmartPlant Enterprise and integration concepts and data exchange among integrated SmartPlant Enterprise authoring tools.
- **SmartPlant Enterprise Data Exchange Diagrams** - Includes full-size graphics that describe the exchange of data among SmartPlant Enterprise authoring tools. These graphics are also included in the SmartPlant Enterprise Overview.
- **SmartPlant Enterprise Integration Example Guide** - Provides an overview of integrating SmartPlant Enterprise and describes a typical example of full integration within SmartPlant Enterprise, including publishing and retrieving plant information using SmartPlant authoring tools and Aspen Basic Engineering™.
- **SmartPlant Enterprise Hardware and Software Recommendations** - Provides information about the hardware recommendations and software requirements of the authoring tools that are part of the SmartPlant Enterprise suite.
- **Integration Setup Guide** - Provides information about setting up and using SmartPlant Enterprise products in an integrated environment. Also provides integration troubleshooting information.
- **SmartPlant Enterprise Backup and Restore Guide** - Provides backup, restore, and resynchronization procedures for SmartPlant Foundation, SmartPlant Basic Integrator, and integrated SmartPlant Enterprise authoring tools. The procedures are designed to minimize data loss and downtime when restoring data in an integrated environment.
- **Integration: A Gentle Introduction to the SmartPlant Schema** - Provides an introduction to the SmartPlant schema and the data model that describes how the SmartPlant schema is constructed.
- **Integration: A Gentle Introduction to SmartPlant Schema Patterns, Process & Practice** - Provides an introduction to patterns in the SmartPlant schema.
- **Integration User's Guide** - Provides information about using SmartPlant Enterprise products in an integrated environment. Also provides a basic understanding of integration and common integration tasks.
- **Integration Administrator's Guide** - Provides information for system administrators on how to set up and configure an integrated environment.
- **Schema Editor User’s Guide** - Provides instructions for using the Schema Editor to view and extend the SmartPlant schema, view and modify authoring tool mapping, and compare schema files.
Preface

- **SmartPlant Mapping User's Guide** - Provides guidelines, procedures, and examples of mapping between the SmartPlant schema and integrated authoring tools.
- **SmartPlant Model Loader User's Guide** - Provides instructions for using the Model Loader to load documents exported from PDS® or AVEVA PDMS into the SmartPlant Foundation database.
- **SmartPlant Enterprise Citrix Configuration Guide** - Provides information on configuring integrated SmartPlant® Enterprise applications to run in a Citrix environment.

**Intergraph Work Process Guides**

Intergraph Work Process guides map the process, power, and marine industries' basic work processes to SmartPlant Enterprise and SmartPlant Marine Enterprise solutions. This documentation helps your organization transition from previous work practices to using Intergraph tools as the new way of executing projects. These documents are available on [http://crmweb.intergraph.com/](http://crmweb.intergraph.com/) [https://crmweb.intergraph.com](https://crmweb.intergraph.com) under **Product Documentation > Enterprise Work Processes**.

**Enterprise Work Processes** describe an entire engineering discipline or process at two different levels, including:

- Providing a swim lane diagram to define the typical roles and high-level processes involved in a project
- Showing how Intergraph tools are used to produce required deliverables

**Integration Capability Statements** describe a specific work process among a set of Intergraph tools, including:

- Explaining the out-of-the-box capabilities of the tools and their recommended use
- Providing a swim lane diagram to show how the tools interact in the work process
- Stating critical requirements and precautions
- Enterprise Work Processes and Integration Capability Statements offer a better understanding of how Intergraph tools work together and how to adapt the tools to improve existing work processes.

**Programming Guides**

To view customization and programming documentation for SmartPlant Foundation and integration, browse to the ..\SmartPlant\Foundation\<version>\ProgrammingHelp folder on a computer where the SmartPlant Foundation server components are installed.

- **SmartPlant Foundation Server Customization Guide** - Provides information for developers on customizing the SmartPlant Foundation Server.
- **SmartPlant Foundation Client Customization Guide** - Provides information for developers on customizing the SmartPlant Foundation Client.
- **SmartPlant Foundation Web Portal Customization Guide** (SPFWebPortalCustomization.chm) - Provides information about customizing and configuring the SmartPlant Foundation Web Portal.
- **SmartPlant Foundation Web Services Guide** - Describes SmartPlant Foundation web methods used for uploading data from and downloading data to the SmartPlant Foundation Server.
- **SmartPlant Adapter Interfaces Reference Guide** - Provides information for tool developers about the interface classes used to communicate data between the authoring tool and the common user interface and the common user interface and the tool adapter.
- **SmartPlant Common UI Interfaces Reference Guide** - Provides information for tool developers about the API exposed through the EFCommonUI.dll, which is used by authoring tool developers to access integration functionality.
- **SmartPlant Metadata Adapter Reference Guide** - Provides information for tool developers about programming the metadata adapter. The tool metadata adapter allows communication between the SmartPlant Schema Editor and the tool database to manage mapping between the tool and the SmartPlant schema.

- **SmartPlant Schema Component API Reference Guide** - Provides information for developers about the Schema Component API.

- **SmartPlant Enterprise SmartPlant Adapter for SmartPlant Electrical** - Describes the SmartPlant Adapter details, functionality and configuration in SmartPlant Electrical.

- **SmartPlant Enterprise SmartPlant Adapter for SmartPlant Instrumentation** - Describes the SmartPlant Adapter details, functionality and configuration in SmartPlant Instrumentation.

- **SmartPlant Enterprise SmartPlant Adapter for SmartPlant P&ID** - Describes the SmartPlant Adapter details, functionality and configuration in SmartPlant P&ID.

- **SmartPlant Enterprise SmartPlant Adapter for SmartPlant 3D** - Describes the SmartPlant Adapter details, functionality and configuration in SmartPlant 3D.

- **SmartPlant Enterprise SmartPlant Adapter for PDS 3D** - Describes the SmartPlant Adapter details, functionality, and configuration in PDS 3D.

### Documentation Comments

Send documentation comments or suggestions to [PPMdoc@intergraph.com](mailto:PPMdoc@intergraph.com).
Welcome to SmartPlant® Foundation

SmartPlant Foundation is a process industry standards-based data warehouse that uses a business object data model for plant information management. The SmartPlant Foundation data model ensures an open, independent data storage system to protect plant information, regardless of the information technology infrastructure in place in your organization. SmartPlant Foundation can preserve data for the entire lifecycle of the plant.

SmartPlant Foundation provides a platform for data exchange, sharing, and integration across technical systems. The software enables concurrent use and rapid communication among all project participants, according to the demands and practices of a global industry. Critical information is stored only once in a data-neutral warehouse, eliminating duplication, and ensuring that accurate, timely data is always available.

SmartPlant Foundation is also an integration point to the financial, commercial, and operational systems within an organization, linking these different yet related domains. SmartPlant Foundation enables the consideration of technical specifications, procurement requirements, impacts of change from a maintenance perspective, and cost roll-ups of project deliveries within a consistent, deployable environment.

Facilitating e-commerce through standard equipment definitions, context-sensitive multi-discipline access, Web-based deployment, and more, SmartPlant Foundation is helping organizations worldwide push back the boundaries of plant information management.

Additionally, SmartPlant Foundation includes all server-side components of SmartPlant Enterprise, a collaborative engineering workflow management and standards-based integration architecture for engineering tools.

The SmartPlant Foundation software suite consists of the following components.

**SmartPlant Foundation Server Manager**

SmartPlant Foundation Server Manager provides the tools system administrators need to specify configuration information required for launching SmartPlant Foundation. Tasks that system administrators can perform in Server Manager include:

- Create and manage the default folder structure for the SmartPlant Foundation server files
- Import and export Server Manager configuration settings
- Create and remove SmartPlant Foundation sites
- Test database connections
- Import database dump files
- Activate license files and define settings for the License Manager
- Define settings for the SmartPlant Foundation File Service, Remote Services, and Web Portals

For more information, see the *SmartPlant Foundation Server Manager User's Guide*.

**SmartPlant Foundation Desktop Client**

The SmartPlant Foundation Desktop Client provides the functionality of the SmartPlant Foundation client system through a windows based client. Based on the software configuration and authorization of the System Administrator, you can perform the following functions:

- View information from the database about a specific object
Welcome to SmartPlant® Foundation

- View a data sheet or history for a particular object
- Update existing objects
- View relationships between objects
- Remove objects or object relationships
- Create new objects and revisions
- Complete steps in workflows
- Interact with the integrated environment

For more information, see the *SmartPlant Foundation Desktop Client User’s Guide*.

**SmartPlant Foundation Web Portal**

The SmartPlant Foundation Web Portal provides the functionality of the SmartPlant Foundation client system through an easy-to-deploy Internet Explorer web browser. Based on the software configuration and authorization of the System Administrator, you can perform the following functions:

- View information from the database about a specific object
- Search for objects in the database
- View drawings and 3D models
- View a history for a particular object
- View relationships between objects

For more information, see the *SmartPlant Foundation Web Portal User’s Guide*.

**SmartPlant Foundation License Manager**

The SmartPlant Foundation License Manager controls licensing for SmartPlant Foundation. For more information, see the *SmartPlant Foundation Licensing Guide*.

**The SmartPlant Enterprise Components**

SmartPlant Enterprise supports the integration of engineering tools, such as SmartPlant 3D, SmartPlant Instrumentation, SmartPlant P&ID, and Aspen Basic Engineering™. This integration addresses the flow of data as it moves from one engineering application to another through its lifecycle.

Integration provides the following features:

- Transfer of engineering data from one tool to another, eliminating the need for manual re-entry of data
- Management of change resulting from ongoing engineering in upstream applications
- Accessibility of engineering information to other collaborators without requiring the original engineering tools
- Recording of change in data as it moves through the plant lifecycle
- Correlation of shared objects from multiple authoring tools. For example, the full definition of a pump may come from multiple disciplines (electrical, mechanical, and so on), and the data comes from different authoring tools.
- Support for engineering workflows, especially versioning, approval/release, and configuration control

At the center of integration is SmartPlant Foundation, which provides the repository for data published by the authoring tools. Integration components make the exchange of data from the authoring tools to SmartPlant Foundation and back possible.

For more information about installing SmartPlant Enterprise and the authoring tools, see the *Integration Setup Guide*, delivered with SmartPlant Foundation.
SmartPlant Foundation Internationalization

Supporting internationalization in a homogeneous environment is one of the enhancements available in SmartPlant Enterprise. A homogeneous environment uses elements from only a single locale. For example, a German customer running on a German operating system using only German characters and German cultural conventions is a fully supported homogeneous environment configuration.

Homogeneous Environments

When starting a new project, use extra care during installation and configuration to ensure the proper creation and maintenance of homogeneous environments:

- All the computers (servers and clients) within an integrated SmartPlant Enterprise implementation must have the same regional settings, and no one should change the regional settings after the project has started.
- Do not cross the decimal locale boundary. This is the most common cause of numeric data corruption and calculation errors. Having users with different regional settings (like with a period versus a comma for the decimal point) causes the software to interpret values unpredictably. For example, a pipe run with a pressure of 35.3 psi can be read by the software as 353 psi to the user with different regional settings. A cable length defined as 39 ft 11.21 inches has been interpreted as 121718910971323 meters when published to an XML file. These incorrect interpretations may be used in internal software calculations and can be impossible to backtrack or correct. Do not change the decimal point character to try to solve an issue. Doing so will only corrupt values in the database or in text files.
- Do not cross the character-set locale boundary. For example, the character set boundary between Western (Latin-based) and Eastern Europe (Cyrillic-based), or between Eastern Europe and Japan.
- Create Oracle databases using AL32UTF8 for the database character set and AL16UTF16 for the NLS character set.
- Never modify the NLS_LANG registry entry on an Oracle client. Doing so causes the character data not to convert to Unicode.
- Create Microsoft SQL Server databases with locale-specific collation settings and ensure that all databases have the same setting.

Heterogeneous Environments

In contrast, a heterogeneous environment using elements from different, or even multiple locales, is not supported. Many customers are currently operating in unsupported heterogeneous environments and are often not aware of that fact. Examples of heterogeneous environments:

- Entering or viewing Japanese data on an US/English operating system
- Using German Regional Settings (where the decimal point is a comma) on a US/English operating system
- Using databases with different character encodings such as CL8MSWIN1251 or JA16SJIS
- Using multiple languages in a project, especially when crossing language-group boundaries
- Using an English server with different local language clients

International / Bi-lingual Projects

International bi-lingual projects are possible; however, great care must be used when configuring these environments. Limitations exist and must be properly understood:
Oracle and MS SQL Server databases can reside on any language operating system, as long as the databases have been created and configured with proper Unicode and collation settings.

All SQL Server databases must have the same collation setting and reflect the “master” language. Text is stored, sorted, indexed, and presented based on the collation setting. You must determine which language will be used primarily to generate output (P&IDs, SLDs, reports, approval documents, and so forth.) If Russian and English text is entered, and Russian is the target locale, the chosen collation should be based on the Cyrillic character set.

All Microsoft operating systems (Japanese, Russian, German, and so forth) can enter English characters. The reverse, however, is not true in most cases. Keyboard-locale can be changed as long as a character-set and code-page boundary is not crossed. For example, English, German, French, and Spanish characters can all be used in the same project because the same Windows® code-page (1252) is used. However, Russian characters (code-page 1251) cannot be used in a US/English environment.

You must decide which language operating system will be the master for bi-lingual projects.

The following is an example of a Russian-based project:

Companies in the United States and the United Kingdom are working a project with a Russian company and the deliverables (drawings, reports, and so forth) must ultimately be provided in Russian. The companies in the U.S. and the U.K. are working the project using the “master” Russian operating systems (possibly using virtual Russian operating systems running on VMware Workstation). The U.S. and U.K. companies can install and use English Microsoft Office products on the Russian operating system because Office products are globally enabled. If a Russian interface exists for the SmartPlant Enterprise application, then Russian users can use the Russian interface while the English-speaking users would continue to use the US/English interface. English-speaking engineers can enter English characters. Russian-speaking engineers can enter Russian characters.

However, because the Russian locale uses different decimal and character-set locales, everyone (English and Russian engineers) must use the Russian decimal symbol which is a comma. For customization purposes, databases can be modified to accommodate new Russian-specific requirements (fields, properties, and so forth.) Using filters, display sets, and other software features, bi-lingual projects can be further customized. Graphic data, reports, and so forth can be created in either or both languages.

CAUTION Do not change regional settings to reflect a U.S. environment in order to resolve problems in a non-US/English homogeneous configuration. Doing this creates a heterogeneous configuration that will cause other possibly hidden problems that cannot be corrected. Everyone working on a project must use the same regional settings and character set throughout the life of the project.

Citrix XenApp Solutions for International Projects

Using Citrix XenApp Solutions, you can define environments that isolate users from having to interact with non-native language operating systems while improving data integrity and minimizing opportunities for data corruption. However, users still have to enter data using master locale conventions for the project (decimal separator and date conventions, for example). You can create these environments using different combinations of languages, but some limitations exist. For example, you cannot use Russian and Chinese text together in a project. In addition, special language characters (the German ä and ß for example) cannot be used if the master locale is outside the western Latin-based languages (the master locale is Russian, Chinese, Japanese, or Korean for example).
Questions and Assistance

Please contact your support representative for assistance and answers to your questions: see Intergraph Customer Support at [http://support.intergraph.com/](http://support.intergraph.com/).
Before beginning an installation of SmartPlant Foundation, verify that your servers and workstation computers meet the following hardware recommendations and software requirements.

**NOTES**

- On the Windows Server 2008 platform, SmartPlant Foundation Core is a 64-bit application with all other components (such as File Service and Remote Services) being 32-bit applications. It was certified on 64-bit hardware with a 64-bit operating system (with IIS configured to run SmartPlant Foundation Core as a 64-bit application and the other components as 32-bit applications).
- SmartPlant Foundation Desktop Client is a 32-bit application certified on 64-bit hardware with a 64-bit operating system and 32-bit operating system.
- For increased performance for the SmartPlant Foundation database server, Intergraph recommends using a 64-bit database server.
- Intergraph highly recommends installing database software on a database server separate from the SmartPlant Foundation application server for improved performance.
- SmartPlant Foundation supports the Enterprise Platform 2013, but is deferring support of Microsoft SQL Server 2012 to a later release.
- Intergraph recommends setting up Development and Test environments, in addition to the Production environment, for preparing and testing updates, customizations, and other configuration changes. For more information on how to set up these environments, contact your Intergraph services team.
- Full Text Retrieval is a 32-bit application and was certified on 64-bit hardware with a 64-bit operating system.
SmartPlant Foundation Recommendation Summary

The following diagram represents a summary of the recommendations for a SmartPlant Foundation installation. The recommended hardware platform, memory size, and operating system or client software are listed for each server and client.

**NOTE** Some of the servers illustrated here are optional, as those functions can be hosted on the application server.

*Optional license server specifications are for a SmartPlant License Manager implementation; FLEXlm specifications differ. See the detailed recommendations for more information.*
SmartPlant Foundation Database Server

Please refer to your Oracle or Microsoft SQL Server product documentation for information on configuring your database server hardware.

Hardware Recommendations

These hardware recommendations are based on a 64-bit platform and should be used for comparison with other hardware platforms.

- 8 core 3 GHz processor
- 32 GB RAM
- Fast disk storage (for example, 1TB with I/O throughput better than 3GBps with 2 or more data channels)
- Data Backup/Recovery
- 1000 BaseT or higher network interface connection to the Application Server

**NOTES**

- Hardware sizing, especially for servers, depends on many factors such as the number of concurrent users per site, the size of the project (which translates into the size of the database), and other software that is running on the machine.
- Multiple physical drives should be used on the database server to distribute file read/write operations and improve performance. For example, the operating system should be installed on its own drive, with separate drives containing the core database files and user data files.

Recommended Operating System

- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit)

**NOTE** For an Oracle database implementation, the Oracle database server may be deployed on any Oracle-supported platform, provided that the Oracle client prerequisites are met on the SmartPlant Foundation application server.
Supported Database Servers

- Microsoft SQL Server 2008 R2 (64-bit)
- Oracle Enterprise Edition 11g Release 2 (64-bit)

**IMPORTANT:** Oracle Standard Edition may be used as the database server platform. For improved performance and scalability, Intergraph recommends Oracle Enterprise Edition.

**NOTES**

- Oracle 11.2.0.2 is supported with or without Patch 8.
- For more information about SmartPlant authoring tools and the databases they support, see The SmartPlant Enterprise Product Compatibility Matrix on the Intergraph Process, Power & Marine eCustomer Web site. To view this matrix, browse to the following Web address, and type your eCustomer user name and password: https://crmweb.intergraph.com/ecustomer_enu/. Click **Download Software Updates > Products**, and then click the **Compatibility Matrices** link on the right side of the page. In the list of product compatibility matrices, click **HTML or Excel** for the version of the product.
- For information about supported databases for each authoring tool, see the matrix for the appropriate authoring tool.
- SmartPlant Foundation does not support Global Workshare Configuration for database replication.
SmartPlant Foundation Application Server

Hardware Recommendations

- 8 core 3 GHz processor
- 32 GB RAM
- 5 GB free disk space for software installation
- 1000 BaseT or higher network interface
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection

**NOTES**
- Hardware sizing, especially for servers, depends on many factors such as the number of concurrent users per site, the size of the project (which translates into the size of the database), and other software that is running on the machine.
- These SmartPlant Foundation application server hardware recommendations also apply to virtual servers hosted on Citrix XenServer. For virtual deployments, the same amount of RAM, disk space, and CPU capacity that would be required for a similar physical deployment should be available to the virtual machine.

Supported Operating System

- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit) with IIS 7

**NOTES**
- Be sure to install the most recent Microsoft security patches, available from http://www.microsoft.com/.
- Windows Server 2008 R2 is supported with UAC enabled and set to Level 3 (Default).
- For a server with more than four cores, the Enterprise edition of Windows Server 2008 R2 is required.
- Both the Web Server (IIS) role and the Application Server role must be installed on the server, with the ASP.NET, .NET Extensibility, Windows Process Activation Service Support, TCP Activation, and Named Pipes Activation role services installed.

**IMPORTANT** For a FLEXlm licensing implementation, the FLEXlm server software must be installed on a 32-bit operating system. For a SmartPlant License Manager licensing implementation, the SmartPlant License Manager server software can be installed on a 32-bit or 64-bit operating system.

For further information on setting up either a FLEXlm or a SmartPlant License Manager server, see the SmartPlant Foundation Server Manager User’s Guide.

Software Prerequisites

- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5
- Microsoft XML (MSXML) 6.0 (required for Schema Editor or data sheets only)
- SmartPlant Schema Component.NET
SmartPlant Foundation Hardware and Software Recommendations

- SmartPlant Schema Component (required for integration with tools that do not support Schema Component.NET)
- Oracle 11g R2 64-bit client software (required if using Oracle database server)
- Microsoft SQL Server 2008 Client Management Tools - Complete installation (required if using SQL Server database server)

**NOTE** When you install Management Tools - Complete, the following additional required tools are also installed: Client Tools Connectivity, Client Tools Backward Compatibility, Client Tools SDK, and Management Tools.

- Microsoft Office Excel 2007 or 2010 (with VBA installed)
- SmartSketch 2011 R1, installed with the SmartSketch CAD Translators and Programming Tools custom installation options (only required for automatic hotspotting with the SmartConverter)

**IMPORTANT** Some SmartSketch installations require SmartPlant License Manager. Ask your system administrator or contact Intergraph Support Services if you have a question about SmartSketch licensing requirements.

- SmartPlant Markup Plus 2011 (available with Intergraph information management products and required for viewing MicroStation V8, AutoCAD 2004 and later, Microsoft Office, PDF, Solid Edge, or other third-party formats)
- SmartPlant Markup Plus Server 2011 (required to perform View and Markup command with Microsoft Office files)

**NOTE** SmartPlant Markup Plus Server must be installed on both the application server and file server.

### SmartPlant Foundation License Server

The License manager software can be hosted on the application server or on this optional license server.

#### Hardware Recommendations

- 2 core 3 GHz processor
- 4 GB RAM
- 5 GB free disk space for software installation
- 1000 BaseT or higher network interface
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection

**NOTE** Hardware sizing, especially for servers, depends on many factors such as the number of concurrent users per site and other software that is running on the machine.

#### Supported Operating System

- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit) with IIS 7

**NOTES**

- Be sure to install the most recent Microsoft security patches, available from http://www.microsoft.com/.
- Windows Server 2008 R2 is supported with UAC enabled and set to Level 3 (Default).
Software Prerequisites

- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5
- Microsoft XML (MSXML) 6.0
- Oracle 11g R2 64-bit client software (required if using Oracle database server for SmartPlant License Manager)
- Microsoft SQL Server 2008 Client Management Tools - Complete installation (required if using SQL Server database server for SmartPlant License Manager)

**NOTE** When you install Management Tools - Complete, the following additional required tools are also installed: Client Tools Connectivity, Client Tools Backward Compatibility, Client Tools SDK, and Management Tools.

- SmartPlant License Manager 2012 client software (or greater)

SmartPlant Foundation Alternate Server

An alternate or secondary server can host SmartPlant Foundation scheduler components that support functions such as reporting, loading, and batch printing.

**Hardware Recommendations**

- 4 core 3 GHz processor
- 16 GB RAM
- 5 GB free disk space for software installation
- 1000 BaseT or higher network interface
- For SmartPlant Enterprise and SmartPlant Foundation installation, DVD drive access, either locally or through a network connection

**NOTE** Hardware sizing, especially for servers, depends on many factors such as the number of concurrent users per site and other software that is running on the machine.

**Supported Operating System**

- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit) with IIS 7

**NOTES**

- Be sure to install the most recent Microsoft security patches, available from http://www.microsoft.com/.
- Windows Server 2008 R2 is supported with UAC enabled and set to Level 3 (Default).

Software Prerequisites

- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5
SmartPlant Foundation File Server

File services can be hosted on the application server or on this optional file server.

Hardware Recommendations
- 2 core 3 GHz processor
- 8 GB RAM
- 5 GB free disk space for software installation
- 1000 BaseT or higher network interface
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection

**NOTE** Hardware sizing, especially for servers, depends on many factors such as the number of concurrent users per site and other software that is running on the machine.

Supported Operating System
- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit) with IIS 7

**NOTES**
- Be sure to install the most recent Microsoft security patches, available from http://www.microsoft.com/.
- Windows Server 2008 R2 is supported with UAC enabled and set to Level 3 (Default).

Software Prerequisites
- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5
- SmartPlant Markup Plus 2011 (available with Intergraph information management products and required for viewing MicroStation V8, AutoCAD 2004 and later, Microsoft Office, PDF, Solid Edge, or other third-party formats)
- SmartPlant Markup Plus Server 2011 (required to perform View and Markup command with Microsoft Office files)

**NOTE** SmartPlant Markup Plus Server must be installed on both the application server and file server.
SmartPlant Foundation Workstation

Hardware Recommendations
- 2 core 3 GHz processor
- 4 GB RAM
- 1 GB of free disk space for software installation
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection
- 100 BaseT network interface

Supported Operating Systems
- Windows Vista Business Service Pack 2 (32-bit)
- Windows 7 Professional or Enterprise Service Pack 1 (64-bit)
  
  **NOTE** Windows 7 is supported with UAC enabled and set to Level 3 (Default).
  
  **TIP** To increase performance on Windows Vista, the 3 GB option can be used.

Software Prerequisites
- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5
- Microsoft XML (MSXML) 6.0 (required for Schema Editor or data sheets only)
- Microsoft Data Access Components (MDAC) 2.8 Service Pack 1 (2.8.1) (required for Model Loader)
- SmartPlant Markup Plus 2011 (available with Intergraph information management products and required for viewing MicroStation V8, AutoCAD 2004 and later, Microsoft Office, PDF, Solid Edge, or other third-party formats)
- Microsoft Office Excel 2007 or 2010 Service Pack 1
- SmartPlant Client (required for integration)
- SmartPlant Schema Component.NET
- SmartPlant Schema Component (required for integration with tools that do not support Schema Component.NET)
- Active CGM 6.0 P7 (only required for existing .cgm files with SmartPlant Foundation 2D Navigator, new conversions can use .igr files and SmartPlant Markup Plus)

  **TIP** If a SmartPlant Foundation workstation is expected to be used for viewing 3D models, the client configuration should match the recommendations for SmartPlant Review Workstation. For more information, refer to the *SmartPlant Review Installation Guide*.
SmartPlant Foundation Web Portal Server

A SmartPlant Foundation Web Portal can be hosted on the application server or on this optional Web Portal server.

**Hardware Recommendations**
- 4 core 3 GHz processor
- 16 GB RAM
- 5 GB free disk space for software installation
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection

**Supported Operating System**
- Microsoft Windows Server 2008 R2 Service Pack 1 (64-bit) with IIS 7

**Software Prerequisites**
- Microsoft Internet Explorer 9.0 (required for viewing the online documentation delivered with the software)
- Adobe Reader 9 or later compatible version, downloadable from the Adobe website (required to view the Software License Agreement and Printable Guides)
- Microsoft .NET Framework 4.5

SmartPlant Foundation Web Portal Client

**Hardware Recommendations**
- 2 core 3 GHz processor
- 4 GB RAM
- 80 MB of free disk space for software installation
- For SmartPlant Enterprise installation, DVD drive access, either locally or through a network connection
- For SmartPlant Foundation installation, DVD drive access, either locally or through a network connection
- 100 BaseT network interface

**Supported Operating Systems**
- Windows Vista Business Service Pack 2 (32-bit)
- Windows 7 Professional or Enterprise Service Pack 1 (64-bit)

**NOTE** Windows 7 is supported with UAC enabled and set to Level 3 (Default).
Software Prerequisites

▪ Microsoft Internet Explorer 8.0 or 9.0 (in IE-7 compatibility mode)
▪ Microsoft XML (MSXML) 6.0 (required for data sheets and Web Portal File Save Target As functionality)
▪ SmartPlant Markup Plus 2011 (available with Intergraph information management products and required for viewing MicroStation V8, AutoCAD 2004 and later, Microsoft Office, PDF, Solid Edge or other third-party formats)
▪ Microsoft Office Excel 2007 or 2010 (for extracting to Excel or viewing/printing Excel files)
▪ Active CGM 6.0 P7 (only required for existing .cgm files with SmartPlant Foundation 2D Navigator, new conversions can use .igr files and SmartPlant Markup Plus)

**NOTE** The Web Portal supports Microsoft Internet Explorer 8 or 9 in IE-7 compatibility mode. For more information on how to configure the Web Portal to work with Internet Explorer 8 or 9, see Using the Web Portal with Microsoft Internet Explorer 8 or 9 (on page 151).

**TIP** If a Web Portal client is expected to be used for viewing 3D models, the client configuration should match the recommendations for SmartPlant Review Workstation. For more information, refer to the SmartPlant Review Installation Guide.
SECTION 3

Setting Up Databases

This section describes how to set up your SmartPlant database server and database connectivity on the SmartPlant Foundation server. Before you begin setting up your database servers, verify that they meet the requirements described in *SmartPlant Foundation Database Server* (on page 23).

Setting Up the Database Server

SmartPlant Foundation allows for numerous client/server configurations. However, if you have an Oracle database and you are running the Oracle Web Server component, Intergraph recommends that you install Oracle and the Oracle Web Server component on a database server and have a separate server for SmartPlant Foundation. This configuration is recommended because the IIS component, which is required by the SmartPlant Foundation server software, and the Oracle Web Server component use the same port number (port 80) by default. When the database server and the SmartPlant Foundation application server are on different computers, both the Oracle Web Server component and the IIS software component can use the same default port number of 80.

**IMPORTANT** If you choose to have only one server act as both the database and application server and you have the Oracle Web Server component and IIS software installed, the port number for one of the components must be a value other than port 80. If both these components use the default port number of 80, SmartPlant Foundation will have communication problems. The Oracle Web Component is not required for SmartPlant Foundation.

**NOTE** SmartPlant Foundation does not support Global Workshare Configuration for database replication.

Regardless of the configuration, the SmartPlant Foundation database server contains the SmartPlant Foundation data database.

Install Database Software on the Database Server

Load the Relational Database Management System (RDBMS) database networking component software on your database server. See the documentation delivered with your database software for instructions on installing and setting up the database.

**Oracle Notes**

- For important internationalization information, see the Oracle encoding instructions in *Create the SmartPlant Foundation Database Instance* (on page 34).
- For Oracle databases, you must install Oracle Net Server and Client on the database server.
- On Oracle database servers, use Oracle Net Configuration Assistant to create a database alias that SmartPlant Foundation can use to communicate with the database.

**IMPORTANT** All domain verified user names and passwords must use ASCII7/English characters. Oracle does not support non-ASCII / English characters in domain user names or passwords and will not work. This limitation applies only to Oracle, not Intergraph.
Microsoft SQL Server Notes

- For SQL Server databases, there are internationalization considerations concerning the collation settings you specify that relate to reference data, using SmartPlant Enterprise integrated systems, Global Workshare Configuration, multiple locales, backup/restore, reports, and upgrading to future releases.
- Please contact Intergraph Customer Support for specific configuration questions about SQL Server.

See Also
Optimizing Oracle Databases (on page 36)

Create the SmartPlant Foundation Database Instance

Before installing the SmartPlant Foundation software on the application server, create a database instance on the database server that will be used to contain the SmartPlant Foundation application data.

Refer to your database software documentation for information on creating instances and databases.

Oracle

A single Oracle database instance must be created, which will contain one or more tablespaces for SmartPlant Foundation data. No tablespaces need to be created at this time. They can be created after the application software is installed.

SQL Server

Once the database server instance is running, no additional databases need to be created. The databases can be created after the application software is installed.

- Intergraph recommends that the name of the Oracle or SQL Server instance match the name of the SmartPlant Foundation database.

- All products in SmartPlant Enterprise that participate in integration should set their Oracle 11g encodings to the following:
  
  a. **Database Character Set** option - **Use Unicode (AL32UTF8)**
     
  - See your Oracle documentation for information about changing the encodings on your existing projects to match the AL32UTF8 setting.

  b. **National Character Set** option - **AL16UTF16 (the default)**
    
  - The **Default Language (American)** and **Default Date Format (America)** options will, of course, reflect locale-specific information.

- The Oracle client installation does not involve any checking or modifying the Oracle client character set. After the installation, you must not change any of the default values of the **NLS_LANG** parameter on the client.

- For more information about support and known issues for internationalization and localization in SmartPlant Enterprise, request the **SmartPlant Enterprise Internationalization** document from Intergraph Support.

See Also
Optimizing Oracle Databases (on page 36)
Set Security on the Oracle Home Folder

Oracle Client software requires that you give the Authenticated User privileges to the Oracle Home folder.
1. Log on to the database server as a user with administrative privileges.
2. Launch Windows Explorer from the Start menu and navigate to the ORACLE_HOME folder.
   [TIP] For Oracle 11g, this is typically the Ora11g folder (for example, D:\App\Administrator\product\11.2.0).
3. Right-click the ORACLE_HOME folder, and click Properties.
4. In the Properties dialog box, click the Security tab.
5. Click the Advanced button.
6. In the Permissions list verify that the Authenticated Users are listed with Read & Execute in the Permission column and This folder, subfolders and files in the Apply to column.
7. If the permissions are not set correctly, select the appropriate row in the table, and click Edit.
8. Make sure the Apply onto list contains This folder, subfolders and files and that the appropriate permissions have been checked in the table. This should already be set properly, but it is important that you verify this.
9. Click OK to close the Permission Entry for Checklists dialog box.
10. Select the Replace permission entries on all child objects with entries shown here that apply to child objects check box.
11. Click OK until you close all the security properties dialog boxes. An hourglass cursor may appear for a few seconds as the system applies the permissions you just changed to all subfolders and files.
12. Restart the application.
   [NOTE] Any application that is using Authenticated User privileges will not work. A notable example is IIS, which might service some of the requests based on the Authenticated User privileges.

See Also
Optimizing Oracle Databases (on page 36)

Maximum Positive and Negative Database Values

SmartPlant Foundation can support the following maximum and minimum positive and negative values for the database versions listed:

<table>
<thead>
<tr>
<th>Database</th>
<th>Largest Negative Values</th>
<th>Largest Positive Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 11g R2</td>
<td>-7.92281625142643E+28</td>
<td>7.92281625142643E+28</td>
</tr>
<tr>
<td>SQL Server 2008</td>
<td>-1.7976931348623E+308</td>
<td>1.7976931348623E+308</td>
</tr>
</tbody>
</table>
Optimizing Oracle Databases

Relational databases like Oracle automatically optimize based on the data that is loaded. If data is loaded or changed, the relational database needs to rescan the data to achieve the best performance. With Oracle databases, you can optimize database performance by using the Analyze utility. The more the database changes, the more often the database administrator should run the Analyze utility.

See the Oracle documentation for information on the use of the Analyze utility and other maintenance tasks.

Setting Up Database Access on the Application Server

Before you install the SmartPlant Foundation software, you must configure database access on the application server.

Install Database Software on the Application Server

Refer to the software recommendations for the SmartPlant Foundation Application Server (on page 25) for details on the particular versions and configurations that are required and supported on the application server.

For Oracle database access, install the following:

- Oracle client software
  
  **NOTE** After installing the Oracle client on the application server, the server should be rebooted.

- Oracle Net Server database software, to configure a local net service name pointing to the database server.
  
  **TIP** For more information about installing Net Server, see the Oracle documentation.

For SQL Server database access, install the following:

- Microsoft SQL Server Management Studio
- Microsoft SQL Server client software

See Also

*Configuring SmartPlant Foundation* (on page 111)

*Setting Up the Application Server* (on page 39)
Set Up Database Access

The SmartPlant Foundation database can be located on any host that is accessible through the network.

For an Oracle database, use the Oracle Net Configuration Assistant to configure a local net service name that points to the database server. You will also need to ensure that your Oracle Client is the correct version for the Oracle database server. Refer to the Oracle documentation for details on configuring local net service names.

**NOTES**

- If the Oracle database instance ever goes down, once it is restarted you must recycle the IIS application pools on the SmartPlant Foundation application server in order to restore their worker process connections to the database.
- After installing the Oracle 64-bit client on the application server, the server should be rebooted.
To set up the application server, you must do the following:

- Install prerequisite software. For more information, see *Installing Prerequisite Software on the Application Server* on page 39.
- Set up access to the SmartPlant Foundation database. For more information, see *Setting Up Database Access on the Application Server* on page 36.
- Install SmartPlant Foundation software. For more information, see *Install SmartPlant Foundation* on page 42.
- Configure the application server using Server Manager. For more information, see *Using Server Manager to Configure the Application Server* on page 47.
- Configure the software to run on the application server. For more information, see *Configuring Windows Server 2008 R2* on page 64.
- Configure security on the application server. For more information, see *Configuring Security for the Application Server* on page 73.

### Installing Prerequisite Software on the Application Server

The following server roles, role services, and prerequisite software should be installed on the application server before you install SmartPlant Foundation.

#### Roles

- Web Server (IIS)
- Application Server

#### Role Services

- ASP.NET
- .NET Extensibility
- Web Server (IIS) Support
- Windows Process Activation Service Support
- TCP Activation
- Named Pipes Activation

**TIP** You can install roles and role services on the application server using the Windows Server 2008 R2 Server Manager administrative tool.
Prerequisite Software

- Internet Explorer
- Adobe Acrobat Reader (required to view the Software License Agreement and Printable Guides)
- MSXML (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)
- .NET Framework (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)

**NOTES**

- The software checks for these prerequisites during installation.
- For information on the required versions of the prerequisite software, see SmartPlant Foundation Application Server (on page 25).

Installing Software on the Application Server

After you set up database access on the application server, you are ready to begin installing SmartPlant Foundation software on the application server.

**IMPORTANT** Before you install SmartPlant Foundation, decide whether to install the software on the C or D drive. By default, the software is installed in the following location: C:\Program Files\SmartPlant\Foundation\2014. Check with your IT department for specific guidelines about where to install the software.

**NOTE** You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see Installing the Software in Silent Mode (on page 44).

Install Schema Component.NET

The Schema Component.NET software installs the Schema Editor, which is required for editing the SmartPlant Foundation data model.

**NOTE** You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see Installing the Software in Silent Mode (on page 44).

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click `setup.exe` on the CD.
2. Click SmartPlant Software in the SmartPlant Foundation Installation window.
3. Click SmartPlant Schema Component.NET Installation.

**TIPS**

- If you have previously installed Schema Component.NET, the software prompts you to remove the older version of the Schema Component.NET before installing the new version. After you uninstall the older version, click Schema Component.NET Installation again in the SmartPlant Foundation Installation window.
- The installation process checks whether Microsoft Excel is installed on the server. If Excel is not installed, the Schema Component.NET installation will display a message box stating that Excel is required. Click No to dismiss the message box and continue the Schema Component.NET installation.

4. Click Next in the Welcome to SmartPlant Schema Component.NET Setup and Select Optional Features dialog boxes.
The Schema Editor, which allows you to view and edit the SmartPlant schema, tool schemas, and authoring tool mapping, is installed with the Schema Component.NET by default.

5. In the Select Program Folder dialog box, select an installation location and click Next.
6. Click Finish.

**NOTE** In order to uninstall Schema Component.NET when it is installed on the same machine as SmartPlant Foundation, you must always uninstall SmartPlant Foundation before uninstalling Schema Component.NET.

### Install Schema Component

The Schema Component software installs the Schema Editor, which is required for editing the SmartPlant Foundation data model.

**IMPORTANT** You must install this version of Schema Component alongside the newer version, Schema Component.NET, in order to work with the schema of tools that do not yet support Schema Component.NET.

**NOTE** You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see Installing the Software in Silent Mode on page 44.

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click setup.exe on the CD.
2. Click SmartPlant Software in the SmartPlant Foundation Installation window.
3. Click SmartPlant Schema Component Installation.

**TIPS**
- If you have previously installed Schema Component, the software prompts you to remove the older version of the Schema Component before installing the new version. After you uninstall the older version, click Schema Component Installation again in the SmartPlant Foundation Installation window.
- The installation process checks whether Microsoft Excel is installed on the server. If Excel is not installed, the Schema Component installation will display a message box stating that Excel is required. Click No to dismiss the message box and continue the Schema Component installation.
4. Click Next in the Welcome to SmartPlant Schema Component Setup and Select Optional Features dialog boxes.

**TIP** The Schema Editor, which allows you to view and edit the SmartPlant schema, tool schemas, and authoring tool mapping, is installed with the Schema Component by default.

5. In the Select Program Folder dialog box, select an installation location and click Next.
6. Click Finish.

**NOTE** In order to uninstall Schema Component when it is installed on the same machine as SmartPlant Foundation, you must always uninstall SmartPlant Foundation before uninstalling Schema Component.
Install SmartPlant Foundation

**NOTES**

- You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see *Installing the Software in Silent Mode* (on page 44).
- For SmartPlant Basic Integrator, perform the installation below. Licensing determines the features available to SmartPlant Basic Integrator.

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click `setup.exe` on the CD.
2. Click **SmartPlant Foundation Installation** in the **SmartPlant Foundation Installation** window.
3. Click **Next**.
   - **TIP** The SmartPlant Foundation installation stops IIS services when you click **Next**. The software restarts these services after SmartPlant Foundation installation is complete. Be sure that these services have started successfully before using the SmartPlant Foundation software.
4. Enter your **User Name**, **Company Name**, and **Serial Number**, and then click **Next**.
5. Verify that the registration information is correct, and then click **Yes**.
6. Select your country from the list, and click **Display** to view the license agreement.
   - **IMPORTANT** The license agreement is delivered as a PDF file; consequently, you must have Acrobat Reader installed on your computer to view the license agreement.
7. Carefully read the licensing agreement. When you are finished, close the PDF file and click **Yes** to accept the terms.
8. To accept the default installation location for SmartPlant Foundation, click **Next**.
   - **TIP** If you want to change the installation location, click **Browse** and navigate to the new folder. Then, click **Next**.
9. In the **Setup Type** dialog box, click **Custom** to select the SmartPlant Foundation software that you want to install, and click **Next**. Selecting **Custom** allows you to install any SmartPlant Foundation components, including server components.
10. In the **Select Features** dialog box, click **Next** to accept the default features.

   To install individual components, click those components in the list. All items are selected by default. Available components include the following.
   - **SmartPlant Foundation Desktop Client** - Installs the Desktop Client, which provides the SmartPlant Foundation client functionality on the user's local computer. For the Desktop Client to work properly, you must also install SmartPlant Foundation Server.
   - **SmartPlant Foundation Server Components:**
     - **Server** - Installs the SmartPlant Foundation Server.
     - **License Manager** - Installs the SmartPlant Foundation License Manager, which controls licensing for SmartPlant Foundation. While this component does not have to be installed on the SmartPlant Foundation server, there must be at least one License Manager server in the SmartPlant Foundation architecture.
     - **File Server** - Installs a service that handles direct file transfer between vaults and the SmartPlant Foundation client.
     - **FTR Service** - Installs the Full-Text Retrieval module, which allows you to store, index, and search for text contained in or associated with objects managed by SmartPlant Foundation.
Setting Up the Application Server

- **Remote Services** - Installs a set of web services that perform tasks such as printing and titleblocking.

- **SmartPlant Foundation Web Portal** - Installs the Web Portal, which provides a web-based interface for accessing SmartPlant Foundation data.

**TIPS**

- You can clear the check boxes for any software that you do not want to install. However, if this software installation is a modification to a previous installation, do not clear any selected check boxes unless you want those components to be uninstalled.

- You can install the File Server on the SmartPlant Foundation server, on both the SmartPlant Foundation server and other computers, or on other computers besides the SmartPlant Foundation server. For information on installing these components elsewhere, see Configuring SmartPlant Foundation (on page 111).

11. Click **Next**.

**NOTE** At this point, the installation process checks whether the World Wide Web Publishing service and IIS Admin service are installed. If these services are not installed, warning dialog boxes will display to inform you that they are missing. Click **OK** to dismiss each warning box. You can either click **Cancel** in the **Installation for SmartPlant Foundation** dialog box to stop the SmartPlant Foundation installation, install the required services while the SmartPlant Foundation installation dialog box is still displayed, or continue with the SmartPlant Foundation installation and install the required services later.

12. To accept the default installation location for License Manager, click **Next**.

**TIP** If you want to change the installation location, click **Browse** and navigate to the new folder. Then, click **Next**.

13. Type the name of the SmartPlant Foundation Web server, and click **Next**.

**IMPORTANT** If you make a typographical error in the host name you enter during the software installation process, you may receive an error when you try to log on to any of the SmartPlant Foundation software components. You can edit this value in Desktop_Client.exe.config and SPFDataLoader.exe.config in the SmartPlant Desktop Client program installation folder (for example, C:\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion).

14. Type the name of the virtual Web directory that maps to the physical folder that contains the client .asp pages, and click **Next**.

**TIP** After installation, you can edit this value in Desktop_Client.exe.config and SPFDataLoader.exe.config in the SmartPlant Desktop Client program installation folder (for example, C:\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion).

15. Select the program folder where you want SmartPlant Foundation to appear on your **Start** menu, and click **Next**.

16. Verify the installation settings, and click **Next** to copy files to your computer.

**TIP** If the settings are not correct, click **Back** to change the installation options.

17. Click **Finish**.
Installing the Software in Silent Mode

There are two methods for installing software in silent mode, depending on how the software is installed.

- For files that are installed via a Setup.exe file, silent mode installation is a two-stage process. First, you perform a normal installation by running the setup.exe file from the command line, using special parameters that cause the software to record the installation session and the options you choose in an .iss file. Then, you can run setup in silent mode on another computer, using the recorded .iss file to provide the necessary setup information.

  IMPORTANT: The environment of the computer on which you run the normal setup to create the .iss file and of the computers on which you perform the silent mode installation must be identical; that is, they must have the same database platforms, software versions, installed files, and so forth. For example, if you create the .iss file and install the software on D drive, you must have a D drive on all the computers.

- For software that is installed using an .msi file, you can execute the installation in silent mode using the msiexec.exe command.

Each of the following SmartPlant Foundation software components has its own setup.exe file on the product CD. For example, the path to the setup executable for the Schema Component is E:\SmartPlant Software\Schema Component\setup.exe. You must use a separate command line string to install each component and record each .iss file. The list below includes the path to the setup.exe for each component.

- SmartPlant Foundation - <setup source folder path>\SmartPlant Foundation\setup.exe
- SmartPlant Schema Component - <setup source folder path>\SmartPlant Software\Schema Component\setup.exe

The .NET version of the Schema Component software, Schema Component.NET, is installed using an .msi file. You must use the msiexec.exe command to silently install this software.

  NOTE: The Schema Component and Schema Component.NET are prerequisites for the SmartPlant Foundation software. You must first record the Schema Component installation, install Schema Component.NET, and then record the SmartPlant Foundation installation. To perform a silent installation of SmartPlant Foundation on another computer, run the Schema Component .iss file, install the Schema Component.NET silently, and then run the SmartPlant Foundation .iss file.

See the product documentation for information about installing other components and applications in silent mode.

Install in Silent Mode Using a Setup.exe File

1. Prior to running a silent setup of SmartPlant Foundation components over a network, ensure that the following conditions exist:
   - All existing versions of the software have been uninstalled prior to network installation.
   - The target computer meets the free disk space recommendations specified in SmartPlant Foundation Hardware and Software Recommendations (on page 21).
   - All applications are closed.

2. Open a Command Prompt window from the Start menu.

3. At the command prompt, type:
   "<setup source folder path>\setup.exe" /r /f1"<path>\<filename>.iss"

   CAUTION: Be sure the <setup source folder path> specifies the path to the folder that contains the setup.exe file that launches the software component InstallShield Wizard, not...
Setting Up the Application Server

the setup.exe file that launches the SmartPlant Foundation AutoPlay executable. For example, on the SmartPlant Foundation CD, the setup.exe file in the SmartPlant Foundation subfolder is the file that launches the InstallShield Wizard for the SmartPlant Foundation software. Double quotes are required only if the path to the setup.exe file contains spaces.

**TIPS**

- The /r parameter tells setup to automatically generate the silent setup file (setup.iss), which is a record of the setup input.
- The /f1"<path>\<filename>.iss" parameter specifies the path and filename for the silent setup file. The double quotes are required around this path, with no space between the /f1 and the opening double quotes. For example, if you type the following command string, the software places the resulting silentsetup.iss file to the c:\installfiles folder.

```
\sourceserver\spf\setup.exe /r /f1"c:\installfiles\silentsetup.iss"
```

4. Work through the standard installation as documented in the component installation procedure.

**NOTE** When you click Display on the License Agreement dialog box while running setup in record mode, you are required to acknowledge that you are accepting the license agreement for all users on whose computers you will install the product. Setup then returns you to the normal installation process by displaying the license agreement and enabling the Yes button on the License Agreement dialog box.

5. To silently install the software component using the newly created .iss file, open a Command Prompt window on each computer on which you want to install the software and type:

```
"<setup source folder path>\setup.exe" /s /f1"<path>\<filename>.iss"
/f2"<path>\<filename>.log"
```

**IMPORTANT** Be sure to use the same setup executable that you used in step 3 of this procedure.

**TIPS**

- The /s parameter tells setup to run in silent mode using the indicated .iss file.
- The /f1"<path>\<filename>.iss" parameter specifies the path and filename for the silent setup (.iss) file you want to run. The double quotes are required, with no space between the /f1 and the opening double quotes. For example, /f1"c:\installfiles\silentsetup.iss".
- (Optional) Use the /f2"<path>\<filename>.log" parameter to record a log file of the setup process. The double quotes are required, with no space between the /f2 and the opening double quotes. For example, /f2"c:\installfiles\silentsetup.log". If /f2 is not defined, a log file is created in the same location as the .iss file.

6. Check the .log file to ensure that the installation proceeded without errors. A successful silent installation produces a .log file looking something like this:

```
[InstallShield Silent]
Version=v6.00.000
File=Log File
[ResponseResult]
ResultCode=0
[Application]
Name=SmartPlant Foundation
Version= 05.00.00.18
```
Setting Up the Application Server

Company=Intergraph
Lang=0009

In general, if an error occurred, the ResultCode will be a number less than zero. Possible result codes include the following:

Any value greater than 0 = Success.
-1 General error.
-2 Invalid mode.
-3 Required data not found in the Setup.iss file.
-4 Not enough memory available.
-5 File does not exist.
-6 Cannot write to the response file.
-7 Unable to write to the log file.
-8 Invalid path to the InstallShield Silent response file.
-9 Not a valid list type (string or number).
-10 Data type is invalid.
-11 Unknown error during setup.
-12 Dialog boxes are out of order.
-51 Cannot create the specified folder.
-52 Cannot access the specified file or folder.
-53 Invalid option selected.

Install in Silent Mode Using an MSI File

Components that are installed using a Microsoft Installer package (MSI) file can be silently installed using the msiexec.exe command.

To view a list of command line arguments for the silent install MSI, enter `msiexec.exe /?` in a Command Prompt window. By default, the arguments for the command line executable are case-sensitive and using upper-case characters is required.

Required Silent Install Parameters

/qn Indicates that no user interface displays during the silent install. If you do not include /qn on the command line, dialog boxes are displayed during the installation process.

/i <path and file name of msi file> Defines the location of the silent installation msi.

SERIALNUMBER=<serial number> Defines the serial number for your product.

SLAACCEPT=Yes Yes indicates that you agree to the software license agreement. If you enter No, setup will not complete.

Optional Silent Install Parameters

INSTALLDIR=<path to install to> Defines where the software will be installed. If no path is defined, then the default installation location is used.
Setting Up the Application Server

/l*v <path, file name of logging file> Defines the location for a log file. If you do not specify a name or location for the log file, it is automatically given a unique name beginning with the characters MSI and ending with the .LOG file extension. The log file is created in the %temp% folder.

/x <path to msi file for uninstall> Defines the path to the uninstall executable.

To run the silent install, execute the msiexec.exe command defining parameters for the software's MSI file.
The following example installs Schema Component.NET silently, accepting the SLA and creating a log file:
msiexec.exe /qn /i "INSTALLER PATH\Intergraph SmartPlant Schema Component.NET 2014.msi" SLAAccept=Yes /l*v "E:\EFSchemLogNet.log"

Installing Hot Fix Packages

**IMPORTANT** Be sure to read the Readme file delivered with the hot fix installation package for important instructions, as well as a cumulative list of fixes.

Backup the current installation
Before installing a hot fix package, you should perform a backup of your database and your SmartPlant Foundation sites, vaults, and installation folders to preserve such items as customized configurations and other files. The backups also provide a fall-back should the hot fix installation need to be rolled back for any reason.

Install the hot fix package
The most recent hot fix package for a release contains all previous hot fix updates. Before installing a new hot fix package, you must remove the previous one.
To install a hot fix package on the SmartPlant Foundation application server:
1. Remove the previous hot fix package installed on the server, if present.
   **TIP** Use Add or Remove Programs in the Control Panel to remove the outdated hot fix package from the server.
2. Run the Setup Wizard for the hot fix package to be installed.

**NOTE** When applying hot fixes to an installation of SmartPlant Client, you must also apply any pre-requisite hot fix to the SmartPlant Foundation installation on the application server. The SmartPlant Client readme will reference any pre-requisite SmartPlant Foundation hot fixes.

**TIP** It is possible to automate the installation and uninstallation of hot fix packages. In order to do so the following parameters should be passed to the relevant hot fix setup.exe:

- To automatically install the hot fix package: <full path to hot fix package>/setup.exe /s /v"/qn"
- To automatically uninstall the hot fix package: <full path to hot fix package>/setup.exe /s /v"/qn" /x
Using Server Manager to Configure the Application Server

SmartPlant Foundation Server Manager provides the tools system administrators need to specify configuration information required for launching SmartPlant Foundation. Tasks that system administrators can perform in Server Manager include:

- Create and manage the default folder structure for the SmartPlant Foundation server files
- Import and export Server Manager configuration settings
- Create and remove SmartPlant Foundation sites
- Test database connections
- Import database dump files
- Activate license files and define settings for the License Manager
- Define settings for the SmartPlant Foundation File Service

Many of the tasks listed above are covered later in this guide. Refer to the SmartPlant Foundation Server Manager User's Guide for additional command descriptions and procedures.

**IMPORTANT** You can use Server Manager to configure SmartPlant Foundation servers only for the computer on which Server Manager is currently installed.

The following procedure describes at a high level a recommended configuration order for SmartPlant Foundation.

1. **InstallShield Setup** - The installation process copies files, checks for prerequisites, updates registry entries, creates Start menu shortcuts, and installs services necessary for running SmartPlant Foundation.

2. **SmartPlant Foundation Server Manager** - After installing SmartPlant Foundation, run Server Manager to create sites and enter information such as data sources, user IDs, passwords, and various file paths.

   **NOTE** The first time you run Server Manager, you are prompted to define a default folder structure for the SmartPlant Foundation server files. For more information, see Defining the Application Server Default Folder Structure (on page 49).

3. **Configuration** - After configuring the server using Server Manager, use SmartPlant Desktop Client to complete the SmartPlant Foundation configuration.

   **IMPORTANT**

   - SmartPlant Foundation supports Oracle and SQL Server databases.

   SmartPlant Foundation Server Manager uses a file named `web.config` to read and store configuration information. When Server Manager is launched for the first time, it checks for a `web.config` file in the installed directory of the SmartPlant Foundation server. If the `web.config` file is not found there, it searches the installed directory of the license server and then in the Web Portal directory. If the `web.config` file is not found in any of these locations, an error message is displayed, and Server Manager closes.

Configuring the Application Server

This section provides an overview for using SmartPlant Foundation Server Manager to configure a SmartPlant Foundation server. The following list outlines a typical application server configuration process.
NOTE: The first time you open Server Manager, the file service and remote services are created. Also, a permissions script runs, setting the default application pool to LocalService and giving LocalService access to folders.

1. Define or accept a default root path for the SmartPlant Foundation server. See Defining the Application Server Default Folder Structure (on page 49).

2. Grant permissions:
   - Give the application server user access to the folder structure.
   - Give Temp folders (within the root path for Server Manager) Read and Write access.
   - Give Web_Sites folder (within the root path for Server Manager) Read and List permissions.

3. Create new SmartPlant Foundation sites. See Create a New Site (on page 54).


5. Configure the application server using SmartPlant Foundation Desktop Client. See How To Set Up and Administer SmartPlant Foundation for instructions.

Defining the Application Server Default Folder Structure

The application server root path defines one location for all of your SmartPlant Foundation server files and defines all of the paths needed to run SmartPlant Foundation. The root path is created and modified through Server Manager. The first time you launch Server Manager, you are prompted to define a root path or accept the default root path (C:\SmartPlant Foundation 2014 Server Files).

Server Manager also uses the root path to set default paths for specific Server Manager nodes. For example, the SmartPlant Foundation Sites node uses default paths for Web site creation and for debugging.

You can use the Tools > Options command to modify the default path.

The Default Server Root Path

If you launch Server Manager without defining a root path, a default folder structure containing the following folders is created.

**Backups** - Used for database backups that are created by the Upgrade Wizard.

**CacheServers** – Keeps all cache server files in one place.

**FileService** - Used by the SPFViewDir virtual directory and for operations involving checking in/out files associated with documents.

**FTP_Vaults** - Keeps all the vaults in one location for easy management.

**LicenseServers** - Keeps all license server files in one place.

**Temp** - Used to create subfolders and log files for the SmartPlant Foundation server and debugging.

**TraceLogs** - Default location for the outputs of trace logs from the server, cache, config, and license server tracing.

**Web_Sites** - Keeps all the sites in one location for easy management.

**WebPortals** - Keeps all the Web Portal sites in one location for easy management.
Modify the Default Folder Structure

1. In SmartPlant Foundation Server Manager, click Tools > Options. The Options dialog box is displayed.
2. To reset the root path, in the SmartPlant Foundation Server root path box, type or browse to the path that you want to specify as the root path and click OK.

**NOTE** All the default paths (for example, Temp and debug paths) for all nodes will be reset to the new path. If a site or vault is already created, the path for the site or vault will still point to the same location as before.

Granting Permissions

Some basic folder permissions must be set in order for SmartPlant Foundation to run. The following permissions are recommended in order for SmartPlant Foundation to run securely.
- The server user needs access to the SmartPlant Foundation server directory.
- The server user needs Read and Write access of the Temp folders (within the root path for Server Manager).
- The server user needs Read and List permissions for the Web_Sites folder (within the root path for Server Manager).

Permissions can be set manually, or administrators can run scripts in Server Manager to grant basic permissions.

Manually Grant Permissions

For more information about manually setting permissions and a comprehensive list of recommended permissions settings, see Permissions for SmartPlant Foundation Processes (on page 86).

Grant Permissions Using Batch Scripts

Permissions can be set using batch scripts in Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions. You can run the scripts from the prompt, or you can choose to run the scripts at a later time.

The first time you start Server Manager, the program creates a new local user group, SPFUsers. By default, the scripts grant permissions to the SPFUsers group. If you choose to run the scripts at a later time, you can edit the files to grant personalized permissions settings to specific users and groups.

The following three batch scripts set permissions.

<table>
<thead>
<tr>
<th>Script</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>SettingPermissions.bat</td>
<td>Grants permissions for the SPFUsers group on multiple folders.</td>
</tr>
<tr>
<td>SettingPermissionsOracleClient.bat</td>
<td>Grants permissions for the SPFUsers group on the Oracle client home directory</td>
</tr>
<tr>
<td>SettingPermissionsLocalService.bat</td>
<td>Grants permissions for Local Service if using a 64-bit operating system and IIS 7 on a Windows Server 2008.</td>
</tr>
</tbody>
</table>
Setting Up the Application Server

All three batch files call XCACLS.vbs. All files are delivered in the UsersAndPermissionsScripts folder (for example, browse to C:\Program Files\SmartPlant\Foundation\2014\ServerManager\UsersAndPermissionsScripts). A log file for the permissions scripts can be found at [drive]:\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log. For more information, see Permissions Script Files (on page 52).

Set Permissions for Running SmartPlant Foundation Loader

To use the SmartPlant Foundation Loader on the application server, additional permissions need to be set manually. This setting will not be performed by the automated scripts.

The Users group on the client workstation must have the following permissions:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;\Program Files\SmartPlant</td>
<td>READ, EXECUTE, LIST,</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td>WRITE</td>
</tr>
</tbody>
</table>

Run Server Manager Permissions Scripts

1. Start SmartPlant Foundation Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions.
2. Click Yes on the dialog box to have Server Manager set up basic permissions.
3. Click OK on the dialog box when permissions are set up.
4. Review the log files for the permissions at [drive]:\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

Manually Edit and Run Server Manager Permissions Scripts

The first time you start Server Manager, the program creates a new local user group, SPFUsers. By default, the scripts grant permissions to the SPFUsers group. If you choose to manually edit and run the scripts at a later time, you can edit the files to grant personalized permissions settings to specific users and groups.

**NOTES**

- For more information, see Permissions Script Files (on page 52).
- Intergraph suggests you make a copy of the script file. Edit the copy, and then run the script file from the copy.

1. Start SmartPlant Foundation Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions.
2. Click No on the dialog box to set up permissions at a later time.
3. Browse to the script files. The scripts can be found in the UsersAndPermissionsScripts folder (for example, browse to C:\Program Files\SmartPlant\Foundation\2014\ServerManager\UsersAndPermissionsScripts).
4. Make a copy of the script file.
5. Using the copy of the script file, edit the keywords in the permissions script with the required values.
6. Double-click the script name to run and set permissions.
7. Repeat steps 3-6 for each script file.
8. Review the log files for the permissions at [drive]\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

**Permissions Script Files**

The first time you open Server Manager, the SPFUsers local user group is created. The following script files are used to set permissions for the SPFUsers group. A log file can be found at SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

**SettingPermissions.bat**

For Windows Server 2008, this file gives the following permissions to the SPFUsers group in the following folders.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SystemRoot%\Temp</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\System\inetsrv\config</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>&lt;drive&gt;\Program Files\SmartPlant\Foundation</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>&lt;drive&gt;\Program Files\Common Files\Intergraph</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>&lt;drive&gt;\SmartPlant Foundation 2014 Server Files</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists the variables for the script file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1% Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.</td>
<td></td>
</tr>
<tr>
<td>2% Common Files\Intergraph directory. For example, C:\Program Files\Common Files\Intergraph.</td>
<td></td>
</tr>
<tr>
<td>3% SmartPlant Foundation installed directory. For example, C:\Program Files\SmartPlant.</td>
<td></td>
</tr>
<tr>
<td>4% SmartPlant Foundation server files directory. For example, C:\SmartPlant Foundation 2014 Server Files.</td>
<td></td>
</tr>
<tr>
<td>5% RSA directory. For example, C:\Program Data\Microsoft\Crypto\RSA.</td>
<td></td>
</tr>
</tbody>
</table>

**SettingPermissionsOracleClient.bat**

For Windows Server 2008, this file gives the following permissions to the SPFUsers group on the Oracle client home directory.
Setting Up the Application Server

Directory Permissions
Oracle Client installation directory
This folder, subfolders, and files
Read, Execute, List

The following table lists the variables for the script file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1%</td>
<td>Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.</td>
</tr>
<tr>
<td>2%</td>
<td>Oracle Home Client directory. For example, C:\app\Administrator\Product\11.2.0.</td>
</tr>
</tbody>
</table>

SettingPermissionsLocalService.bat
For Windows Server 2008, this file sets permissions for Local Service if using a 64-bit operating system and IIS 7.

Directory Permissions
<drive>:\SmartPlant Foundation 2014 Server Files
This folder, subfolder, and files
Read, Write, Execute, List
%SystemRoot%\Temp
This folder, subfolders, and files
Read, Write, Execute, List

The following table lists the variables for the script file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%1</td>
<td>Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.</td>
</tr>
<tr>
<td>%2</td>
<td>SmartPlant Foundation server files directory. For example, C:\SmartPlant Foundation 2014 Server Files.</td>
</tr>
</tbody>
</table>

Setting Up Sites
A SmartPlant Foundation site contains the server configuration and connection settings for accessing and managing your plant and project data in the database.

Each site is defined as either a primary or secondary site.

- A **primary site** contains the SmartPlant Foundation application server, file service, cache, and configuration services.
- A **secondary site** contains the SmartPlant Foundation application and communicates with the existing cache and configuration services on the primary site. Secondary sites are optional and can be used to offload the scheduler service from the primary site's server.

**NOTES**
- Each primary site is associated with a virtual directory in IIS. When you create a new primary site, this virtual directory is also created.
- An optional secondary site can be set up only on a different server from the one where the primary site is set up; this allows you to offload the scheduler from the primary SmartPlant Foundation server to an alternate secondary server.
Setting Up the Application Server

- You can create and manage sites according to your data-modeling needs. For example, you might have a single primary site containing one or more plants on a single server, or have a single primary site with a secondary site on another server to offload the scheduler, or you might have multiple sites on a single server, using a different site per plant. Maintaining multiple sites on a single server requires multiple, customized versions of the SmartPlant schema file. See the SmartPlant Schema Editor User’s Guide for information about customizing SmartPlant schema files.

The SmartPlant Foundation Sites node contains all sites created on the server on which Server Manager is running.

- Site nodes - Each represents a site. The Settings node under each site node contains configuration information for that site, such as the database user IDs, data sources, and passwords.

- System Settings node - Used to configure registry settings that are available for the Server component. The settings configured in this node apply to all the sites in the SmartPlant Foundation Sites node.

Create a New Site

The SmartPlant Foundation Server Manager Edit > New command allows you to create new sites using the Server Manager New Site Wizard. The Server Manager New Site Wizard allows you to create new SmartPlant Foundation sites using new or existing Oracle and SQL Server databases.

IMPORTANT

- You must have IIS installed on your computer before you can use this command.
- Intergraph recommends that you add and delete sites only through the Server Manager application. Do not use IIS to delete any virtual directories created using this command.

NOTES

- Creating a new site also creates a set of virtual directories in Internet Information Service (IIS) on your computer.
- You can allow the wizard to automatically create local users on the operating system, set them to run as the identity of the related application pool, and set permissions for the users. If you prefer to do this manually, refer to Appendix D: Configure the Software to Run Independently of Other Applications (see "Appendix D: Configuring IIS Application Pools and User Accounts Manually" on page 177).
- The wizard logs information about site creation in a log file located in the Temp\ServerManager directory of the default path (for example, C:\SmartPlant Foundation 2014 Server Files\Temp\ServerManager). The log file name is SiteCreation#date_time#.log, where #date_time# represents the date and time of the database creation (for example, SiteCreation6.20.2014_3.46.log).

The operation of the wizard differs depending on the type of site you are creating.

Creating a Primary Site

For a primary site, the wizard performs the basic steps required for creating a new site, including creating the server service, cache service, and configuration service, creating IIS virtual directories, and importing database dump files.

IMPORTANT When creating a new site for a SQL Server database, please note the following:

- When the application server is separate from the database server and you are using a backup file to load the data schema to the database, you must share the folder in which
the file is located before you run the New Site Wizard. When specifying the path to the backup file in the wizard, you must use UNC format. (For example, \\SPFServer\SQLDataShare\SPF42ADW.BAK)

- If you are using one of the delivered backup files, after you copy the file to the shared folder, you must unzip the file before you run the wizard. By default, this zip file is delivered in \Program Files (x86)\SmartPlant\Foundation\2014\Database\SQL Server.

**NOTES**

- See *Completing the Configuration of a New Site* (see "Complete the Configuration of a New Site" on page 56) for information about ensuring optimum performance.
- Server Manager uses template script files for importing dump files and for creating new sites using new databases. See *Database Creation Script Files* (on page 59) for information about modifying the template script files.
- When a new site is created, the trace log file paths for the server, cache service, and configuration service are automatically created. For more information, see the *Setting Up SmartPlant Foundation Logging* section in the *SmartPlant Foundation Troubleshooting Guide*.

**Creating a Secondary Site**

For a secondary site, the wizard performs a smaller set of tasks than is performed for a primary site, including establishing a connection to the primary site and creating the IIS virtual directory for the secondary site.

**Define the site schema location**

**NOTE** If you create a new site without using an existing database, after the new site is created you must specify the location of the new site's schema file in the site's SiteSchemaLocation property.

1. Select the **Settings** node under the new site and edit the **SiteSchemaLocation** property.
2. In the **Properties** dialog box, type or browse to the path of the *efschema.cmf* file for this site and click **OK**.

The default location for the delivered SmartPlant schema CMF file and folder structure is `<drive>:\Program Files\Common Files\Intergraph\EFSchema`.

**IMPORTANT**

- If multiple sites share the same SmartPlant schema file, then any changes that you make to the shared schema file will affect every site. Therefore, Intergraph strongly recommends that you make a copy of the delivered SmartPlant schema folder for each site. Store each customized folder within the site folder, for example, `<drive>:\SmartPlant Foundation 2014 Server Files\Web_Sites\<site_name>\EFSchema`.

The folders containing the customized schema files must be shared with Read-only access. The path to these files can be either a path to a location on the local computer or a UNC path to a location on a remote computer.
**Complete the Configuration of a New Site**

To ensure that the new site is fully configured for optimum performance in the SmartPlant Foundation environment, Intergraph recommends the following:

- A qualified network system administrator should configure IIS and assign proper security settings.
  
  **IMPORTANT** For detailed information and procedures on configuring the application server, and IIS and security settings in particular, see *Configuring Windows Server 2008 R2* (on page 64).

- A qualified database administrator should make necessary adjustments to the physical database design and performance.

  **NOTE** The product installation documentation provides additional information about configuring sites; however, the documentation is not a substitute for a qualified expert.

**Modifying Site Settings**

The **Settings** node under each site node contains the following configuration information for the site.

- **Data Source** - Oracle alias/instance/database name or SQL Server machine name used in the connection string to connect to the data database.

- **User ID** - Name of the user needed to access the data database.

- **Password** - Password needed to log on to the data database.

- **Initial Catalog** - Name of the database to be opened upon connecting (SQL Server only).

- **Multiple active result sets** - Indicates if more than one SQL command can be run simultaneously using a single connection (SQL Server only).

- **Site path** - Physical path to the SmartPlant Foundation Server files for this site on this server (physical location of the virtual directory).

- **Site virtual directory** - Name of the Web site as defined in IIS.

- **ConfigServiceURL** – Location and name of the machine hosting the configuration service.

- **CaselnSensitiveOracle** - Indicates if all user interactive queries to an Oracle database will ignore whether the value is typed in upper or lower case or a mix of lower and upper case characters.

  **IMPORTANT** When changing this property, you must also run the script associated with that condition to set up the appropriate indexes in the Oracle database. If the script is not run, the system will be case insensitive or sensitive as the property indicates, but several indexes will be unusable and performance will suffer.

  - To enable *case insensitivity* on user interactive queries, set this property to True and run the script, RI45067-CaselnSensitiveIndexes-ORACLE.txt, delivered in the Database\Database Scripts folder.

  - To enable *case sensitivity* on user interactive queries, set this property to False and run the script, RI45067-CaselnSensitiveIndexes-ORACLE.txt, delivered in the Database\Database Scripts folder.

  **NOTES**

  - The case sensitivity of Quick Find operations will always respect the user preference setting *Case Sensitive quick find*, regardless of the value of this property.
For newly created sites, the default setting of this property is True. For sites upgraded from a previous version, if this property is not present in the site’s list, the property is added to the site and set to False.

**UnderscoreIsWildcard** - Indicates that the underscore character is used in object name searches as a wildcard. If set to True, underscore is a wildcard in name searches that return any single character. If set to False, underscore is not a wildcard in the search. Default is False.

**Databasetype** - Type of database software used on the database server (ORACLE for Oracle or SQLSERVER for MS SQL Server).

**DefaultConfigTreeLevels** - Number of levels required in the plant breakdown structure (PBS).

**ProgressLogDirectory** - Physical location to which progress log files are stored.

**FileServiceDirectory** - Name of the virtual directory that this site will use for file service operations.

**FileServiceTimeout** - Period of time, in milliseconds, before a file service operation on the server will time out. Default timeout is set to 40000 milliseconds.

**RemoteServiceTimeout** - Period of time, in milliseconds, before a remote service operation on the server will time out. Default timeout is set to 40000 milliseconds.

**FTRServiceTimeout** - Period of time, in milliseconds, before a FTR service operation on the server will time out. Default timeout is set to 100000 milliseconds.

**XMLCompression.Enabled** - Indicates if XML compression is enabled for sending data from this site to other SmartPlant Foundation components. This setting does not affect the compression of files stored in vaults; these files are always compressed regardless of this setting.

**Email:DefaultFromAddress** - Sets the return address for system-generated Emails sent by SmartPlant Foundation.

**Email:MailClient** - Type of Email client software used by SmartPlant Foundation (CDO or JMAIL) to send Emails.

**Email:SMTPHost** - Name of the Email server used by SmartPlant Foundation to send Email.

**DisableAutoLogin** - Indicates if pass-through login is allowed; if disabled, SmartPlant Foundation will always prompt for credentials.

**SiteSchemaLocation** - Physical location of the EFSchema configuration file (EFSchema.cmf).

**NOTE** The default location for the delivered SmartPlant schema CMF file and folder structure is `<drive>:\Program Files\Common Files\Intergraph\EFSchema`.

**IMPORTANT**

- If multiple sites share the same SmartPlant schema file, then any changes that you make to the shared schema file will affect every site. Therefore, Intergraph strongly recommends that you make a copy of the delivered SmartPlant schema folder for each site. Store each customized folder within the site folder, for example, `<drive>:\SmartPlant Foundation 2014 Server Files\Web_Sites\<site_name>\EFSchema`.

  The folders containing the customized schema files must be shared with Read-only access. The path to these files can be either a path to a location on the local computer or a UNC path to a location on a remote computer.

**TIP** For more information about configuration files, see the *Schema Editor User's Guide*. The SmartPlant schema configuration file is delivered with the SmartPlant Server and Client components. By default, it is installed in the following location: ..\Program Files\Common Files\Intergraph\EFSchema.

**DefaultPublishWorkflow** - Specifies the workflow the published documents will be submitted to automatically, if a workflow is not selected in the Publish UI.
Setting Up the Application Server

**NOTE** For additional details on default publish workflow, see *Publish Workflow* in the *Desktop Client User Guide*.

**SkipFailedDocumentsInLoad** - When set to True, allows the SmartPlant Foundation loader to skip a published document that failed during a load or consolidate task and continue processing other documents in the queue. The default value is False.

**LoaderOutputGroupCount** - When loading a schema, the number of rows processed between process reports (ex.: if value is 20, report will show 20 rows processed, then 40 rows processed, etc.).

**DBCommandTimeoutSeconds** - Period of time, in seconds, before the execution of an SQL statement will time out.

**FetchSize** - Specifies the amount of data to return in bytes when the OracleDataReader object fetches data from the database.

**CDWEnabled** - SmartPlant Foundation can be configured to use the Consolidated Data Warehouse by setting the CDWEnabled valid value to True.

**EnableScheduler** - Indicates if scheduler polling is enabled or disabled. The value should be True for normal functioning.

**CacheType** - This is an internal setting. The only valid value is W3WP.

**DTCTitleDisplay** - Text displayed in the title bar of the SmartPlant Foundation Desktop Client main window when connected to this site. Text is appended to the application name after a space. If left blank, the title defaults to “SmartPlant Foundation”. The following arguments can be included in the text string:

- $SERVERNAME – name of the server
- $WEBHOST – web server host name
- $WEBDIR – server web site
- $USER – the Login Name of the user currently logged in (for example, "superuser")

**TIP** For example, for a site named SPFServer on a web host named MyWebHost, the example string (Site: $WEBHOST$WEBDIR) displays "SmartPlant Foundation (Site: MyWebHost\SPFServer)" in the title bar.

**DefaultSPFServerURL** – Location and name of the SmartPlant Foundation server.

**CacheServiceURL** – Location and name of the machine hosting the cache service.

**LicenseServerURL** – Location and name of the SmartPlant Foundation license server.

### Modifying File Service Settings

The File Service Settings node under each site contains properties for configuring the file services for the site.

**File Service virtual directory** - Identifies the name of the virtual directory containing the file services for this site.

**File Service Path** - Represents the path to which the first virtual directory should point, typically the location of the file service web.config settings file (for example, C:\SmartPlant Foundation 2014 Server Files\Web_Sites\SPFFileServer).

**DaysBeforeCleanup** - Determines the age after which to delete files that remain in the temporary directory. This property can be configured and set for the web.config file found in the path of the File Service path property.

**XMLCompression.Enabled** - Determines if XML compression is used when sending data. The default value for this property is False, indicating that data is not compressed.
Decompress3DModel.Timeout - Defines the amount of time, in seconds, after which the operation to decompress a 3D model will timeout. The default setting is 600 seconds (ten minutes).

CachedFileExtensions - A comma-separated list of file extensions used to specify the types of files that should be cached in the site's file service for faster viewing in the Desktop Client. The files are stored in the Cache folder. This folder is created in the site's SPFViewDir directory, for example, C:\SmartPlant Foundation 2014 Server Files\FileService\View\Cache.

DaysBeforeCacheCleanup - Determines the number of days after which to delete cached files that remain in the Cache folder.

Modifying FTR Settings

The FTR Settings node under each site node contains the following configuration information for the site.

FTR virtual directory - Name of the FTR Server's Web site as defined in IIS.

FTR path - Physical path to the FTR Server files for this site on this server (physical location of the virtual directory).

Modifying Site System Settings

The System Settings node under the SmartPlant Foundation Sites node allows you to configure registry settings that are available for the Server component.

License - Location of the token pool license file (tknpool.dat). If License Manager is installed on another server, enter the port number on the License Manager server, followed by @, and the name of the License Manager server computer (for example, 8575@SPFLicenseServer).

Tokens - Location of the daily token file (daily.dat). This path must be preceded by lo: (for example, lo:C:\License Manager\daily.dat).

Post process batch file - Location of a batch file that the software runs when you update a site using the Update Site command. Providing a value for this setting is optional. See Defining the Post Process Batch File for more information about this batch file.

Database Creation Script Files

Server Manager uses template script files for importing dump files and for creating new sites using new databases. The template script files generate script and batch files for performing database operations against an Oracle or Microsoft SQL Server database.

You can modify the template script files to add or remove functionality and to hard code values that you use repeatedly. Once a script file is executed, you can then save the file to be used again.

The database scripts used to create tablespaces, users, logins, and so forth are located in the installation directory under the ServerManager\DatabaseScripts folder (typically C:\Program Files\SmartPlant Foundation\2014\ServerManager\DatabaseScripts). When Server Manager generates the script files and batch files, the new files will have the same name as the template file, without the Template_ prefix.
**Oracle Template Files**

The following script files are used for Oracle operations. The tables below list the variables for each script file.

**Template_CreateTableSpaces.sql**

This file is used for Oracle databases to create the Data permanent and temp databases.

**NOTE** If the tablespace selected by the user in the **New Site Server Wizard** already exists, the creation of the tablespace will not be included in the file generated from the template file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DATA_TS#</td>
<td>Name of the Data permanent tablespace.</td>
</tr>
<tr>
<td>#DATA_TEMP_TS#</td>
<td>Name of the Data temp tablespace.</td>
</tr>
<tr>
<td>#DEFAULT_PATH#</td>
<td>Default path where the DBF file will be created. This value is retrieved from the Oracle database.</td>
</tr>
</tbody>
</table>

**Template_CreateUsers.sql**

This file is used for Oracle databases to create the Data users.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DATA_USER#</td>
<td>Name of the Data user entered.</td>
</tr>
<tr>
<td>#DATA_PWD#</td>
<td>Password entered for the Data user.</td>
</tr>
<tr>
<td>#DATA_TS#</td>
<td>Name of the Data permanent tablespace.</td>
</tr>
<tr>
<td>#DATA_TEMP_TS#</td>
<td>Name of the Data temp tablespace.</td>
</tr>
</tbody>
</table>

**Template_NewSiteOracle.bat**

This file is used to login into the Oracle database and execute the **CreateTableSpace** and **CreateUsers** script files. It also launches the Oracle **imp.exe** command to import the Data dump file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#SYS_USER#</td>
<td>System user name for the Oracle database. This is typically <strong>system</strong>.</td>
</tr>
<tr>
<td>#SYS_PWD#</td>
<td>System password for the Oracle database.</td>
</tr>
<tr>
<td>#DATASOURCE#</td>
<td>Oracle data source\alias of the Oracle database.</td>
</tr>
<tr>
<td>#FROM_USER_DATA#</td>
<td>Variable from the database user who created the Data dump file.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong> This variable is determined through the code. Intergraph recommends that you do not hard code this variable.</td>
</tr>
<tr>
<td>#DATA#</td>
<td>Name of the Data user entered.</td>
</tr>
<tr>
<td>#DATA_DUMP#</td>
<td>Path to the Data dump file.</td>
</tr>
<tr>
<td>#DATA_LOG#</td>
<td>Path to the Data log file generated importing the Data</td>
</tr>
</tbody>
</table>
dump file. This value is generated by is the same as the dump file, with an extension of .log.

Template_ImportOracle.bat
This batch file is used for importing an Oracle dump file into a database that already has the tablespaces and the users already created. Some of the information populated in this script is retrieved from the global.asa file for that site.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#USER_ID#</td>
<td>Name of the user ID for the connection string retrieved from the global.asa file for that site.</td>
</tr>
<tr>
<td>#USER_PWD#</td>
<td>Password for the connection string retrieved from the global.asa file for that site.</td>
</tr>
<tr>
<td>#DATASOURCE#</td>
<td>Data source for the connection string retrieved from the global.asa file for that site.</td>
</tr>
<tr>
<td>#FROM_USER#</td>
<td>Variable from the database user who created the Oracle dump file. IMPORTANT This variable is determined through the code. Intergraph recommends that you do not hard code this variable.</td>
</tr>
<tr>
<td>#TO_USER#</td>
<td>Name of the user ID for the connection string retrieved from the global.asa file for that site.</td>
</tr>
<tr>
<td>#DUMP_FILE#</td>
<td>Path to the dump file.</td>
</tr>
<tr>
<td>#DUMP_LOG#</td>
<td>Path to the log file generated by importing the dump file. This value is generated is the same as the dump file, with an extension of .log.</td>
</tr>
</tbody>
</table>

SQL Server Template Files
The following script files are used for SQL Server operations. The tables below list the variables for each script file.

Template_CreateDBSQL.sql
This template is used to create the database. This will create the MDF and the LDF files for the SQL Server Data database.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DATA_DB#</td>
<td>Name of the Data database to be created.</td>
</tr>
</tbody>
</table>
Setting Up the Application Server

**Template_CreateLoginSQL.sql**
This template is used to create the SQL Server logins.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DATA_USER#</td>
<td>Name of the Data user entered.</td>
</tr>
<tr>
<td>#DATA_PWD#</td>
<td>Password entered for the Data user.</td>
</tr>
<tr>
<td>#DATA_DB#</td>
<td>Name of the Data database to be created.</td>
</tr>
</tbody>
</table>

**Template.ImportDumpSQL.sql**
This template is used to import the dump files into the Data database.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DATA_DB#</td>
<td>Name of the Data database to be created.</td>
</tr>
<tr>
<td>#DATA_DUMP#</td>
<td>Path to the Data dump file.</td>
</tr>
<tr>
<td>#FROM_USER#</td>
<td>Variable from the database user who created the Data dump file.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong> This variable is determined through the code. Intergraph recommends that you do not hard code this variable.</td>
</tr>
<tr>
<td>#DATA_USER#</td>
<td>Name of the Data user entered.</td>
</tr>
<tr>
<td>#DEFAULT_PATH#</td>
<td>The default path of where the LDF and MDF files will be created. This value is retrieved from the SQL Server database.</td>
</tr>
</tbody>
</table>

**Template_NewSiteSQL.bat**
This batch file is used to login into SQL Server and to execute the following script files: CreateDBSQL, CreateLoginSQL, and ImportDumpSQL.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#SYS_USER#</td>
<td>System user name for the SQL Server database. This is typically sa.</td>
</tr>
<tr>
<td>#SYS_PASS#</td>
<td>System password for the SQL Server database.</td>
</tr>
<tr>
<td>#DATASOURCE#</td>
<td>SQL Server data source\alias of the SQL Server database.</td>
</tr>
</tbody>
</table>
Template_ImportSQL.sql

This file is used to import a dump file into a SQL Server database in which the database and the user already exist.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#USER_ID#</td>
<td>Name of the user ID for the connection string retrieved from the global.asa file for that site.</td>
</tr>
<tr>
<td>#DUMP_FILE#</td>
<td>This variable is the path to the dump file.</td>
</tr>
<tr>
<td>#FROM_USER#</td>
<td>Variable from the database user who created the SQL Server dump file.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong> This variable is determined through the code. Intergraph recommends that you do not hard code this variable.</td>
</tr>
<tr>
<td>#MDF_PATH#</td>
<td>The fully qualified path to the MDF file that will have the dump file imported into.</td>
</tr>
<tr>
<td>#LDF_PATH#</td>
<td>The fully qualified path to the LDF file that will have the dump file imported into.</td>
</tr>
</tbody>
</table>

Template_ImportSQL.bat

This batch file is used to login into the SQL Server database and to execute the ImportSQL file to import a dump file either into the Data database.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#SYS_USER#</td>
<td>System user name for the SQL Server database. This is typically sa.</td>
</tr>
<tr>
<td>#SYS_PWD#</td>
<td>System administrator login password (the sa password).</td>
</tr>
<tr>
<td>#DATASOURCE#</td>
<td>Data source\alias of the SQL Server database. This value is taken from the global.asa connection string for the Data database, depending on which database is receiving the dump file.</td>
</tr>
</tbody>
</table>
Configuring Windows Server 2008 R2

Additional configuration is required for SmartPlant Foundation to run correctly on a Windows Server 2008 R2 application server.

Configure IIS 7

In previous versions of IIS, the worker processes ran as the LocalSystem account. Because the LocalSystem account has access to almost all of the resources that are on the operating system, there are serious security implications. IIS 7 offers better security because the worker process runs under the default application pool identity, Network Service.

In IIS 7, you can configure the application pool identity to choose the account under which the worker processes will run. You have the option of using one of the three predefined accounts or creating your own account.

The IIS_IUSRS group is a user group provided by IIS 7. IIS_IUSRS group membership provides the minimum set of user rights and permissions required to run an application. It provides a convenient way to use a specific user account, which would be a member of IIS_IUSRS, for the application pool identity without having to manually assign the user rights and permissions to that account. In a case where the user account is not in the IIS_IUSRS group and it does not have the appropriate permissions, the worker process serving the application pool will fail to start.
### IIS Requirements for an Integrated Environment

For an integrated environment to work properly, the following settings are required in IIS 7.

#### Default Web Site Requirements

The following Default Web Sites must exist:

- SPFServer -- This is the default name, which may be changed during site creation in Server Manager
- SPFCacheService - This is the default name for the cache service, which may be changed during site creation in Server Manager
- SPFConfigService - This is the default name of the configuration service, which may be changed during site creation in Server Manager
- SPFFileServer -- This is the default name, which may be changed during site creation in Server Manager
- SPFRemoteServices
- SPFViewDir
- aspnet_client -- A virtual directory added when ASP.NET is installed.

**NOTES**
- The .NET version required for SmartPlant Foundation is 4.0.30319.
- The Web Site for the virtual Web directory (SPFServer by default) must have the following properties:
  - Execute permissions: Scripts and Executables
  - Read property enabled
  - Enabled parent paths
  - Default ASP language: VBScript

### Configure Maximum Worker Processes

SmartPlant Foundation supports multiple worker processes for the application pool of your primary SmartPlant Foundation site, which is named SPFServer by default. SmartPlant Foundation also supports multiple worker processes for any secondary site application pools, which allows you to offload applications from the primary SmartPlant Foundation server to an alternate secondary server, such as for the scheduler. The optimal value to use is dependent on your system usage and available resources, such as the number of processors, number of applications, number of users, and so on.

**IMPORTANT** The maximum number of worker processes that can be configured for the license, cache, and configuration services application pools is limited to one. Multiple worker processes are not supported for these application pools.

1. Launch **IIS Manager**.
2. Select **Application Pools** in the tree view.
3. Select the application pool for your primary SmartPlant Foundation server. For example, select **SPFServer**.
4. Click **Advanced Settings**.
5. Expand the **Process Model** section of the settings list.
6. Set a value for **Maximum Worker Processes**.
Setting Up the Application Server

7. Click **OK**.
8. Recycle the application pool.

**Minimum IIS Application Mappings**

The table below lists the minimum IIS application mappings required by SmartPlant Foundation.

<table>
<thead>
<tr>
<th>Virtual Directory</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPFServer</td>
<td>.asmx, .aspx, .config, .vb, .vbproj, .webinfo</td>
</tr>
<tr>
<td>SPFCacheService</td>
<td>.asmx, .svc</td>
</tr>
<tr>
<td>SPFConfigService</td>
<td>.asmx, .svc</td>
</tr>
<tr>
<td>SPFViewDir</td>
<td>none</td>
</tr>
<tr>
<td>SPFFileService</td>
<td>.asmx, .aspx, .config, .vb, .vbproj, .webinfo</td>
</tr>
<tr>
<td>SPFRemoteServices</td>
<td>.asmx, .aspx, .config, .vb, .vbproj, .webinfo</td>
</tr>
</tbody>
</table>

**Define MIME Types**

Windows Server 2008 R2 has enhanced security that controls viewing and downloading files by their extension. To be able to use the View, View and Markup, Save Target As and Navigate commands in the SmartPlant Foundation client, you must add the appropriate extensions to the Internet Information Services utility.

MIME types configured using the following procedure apply to all Web applications on the computer, not just SmartPlant Foundation, so be sure to configure MIME types for only those file extensions that you want Web applications to be able to download and open.

- When you create a site with SmartPlant Foundation Server Manager, the software sets many of the necessary MIME types on the Web site for you. Before adding MIME types, be sure that Server Manager has not already added the ones you need. By default, MIME types are configured in the SPFViewDir site.
- Set MIME types at the Web site level, not the server level.

1. On the application server, open the **Control Panel**.
2. Open **Administrative Tools > Internet Information Services**.

---

66 SmartPlant Foundation Installation and Setup Guide
3. In the tree view, select the site for which you need to define MIME types (for example, SPFViewDir), and then double-click **MIME Types** in the **Features View** window.

**TIP** If the **Features View** window is not visible, right-click the site in the tree view and select the **Switch to Features View** command.
4. If the file extension for files that you want to download and view using the SmartPlant Foundation client does not appear in the list, click Add in the Actions window.

5. In the Add MIME Type dialog box:
   - In the File name extension box, type the file extension.
   - In the MIME type box, type the MIME type for the file type. For example, for .pid files, type application/octet-stream.

   **TIPS**
   - For more information about choosing the correct MIME type for a file type, see the Microsoft IIS Help.
   - If you do not know the correct MIME type for a file extension, you can use application/octet-stream as the default.

6. Click OK to save the new MIME type.
Suggested IIS Configuration Settings

In IIS 7, configuration information is accessed via the IIS Manager administrative tool.

1. Launch IIS Manager.
2. Select the server icon.
3. Double-click ASP under the IIS section.
4. Expand the Limits Properties item in the Behavior section.
5. Set the properties as noted below.
6. Click Apply to save the changes.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Default Value</th>
<th>Updated Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Requesting Entity Body Limit</td>
<td>200000</td>
<td>1073741824</td>
</tr>
<tr>
<td>Queue Length</td>
<td>3000</td>
<td>6000</td>
</tr>
<tr>
<td>Response Buffering Limit</td>
<td>4194304</td>
<td>1073741824</td>
</tr>
<tr>
<td>Threads Per Processor Limit</td>
<td>25</td>
<td>100</td>
</tr>
</tbody>
</table>

**NOTES**

- These settings are suggestions only. You can fine tune the settings based on your performance requirements. See the Microsoft Support Knowledge Base for more information on IIS configuration.
- Properties set at the server level will apply to all sites on that server.
- The ASP role service must be installed in IIS in order to access these configuration properties.

**IMPORTANT** If you configure automatic recycling of your application pools while also running scheduled tasks in SmartPlant Foundation, be sure to set the application pool's Shutdown Time Limit for a duration that would allow all scheduled jobs in progress to complete should the recycle be initiated while the job is still running. For example, if a scheduled task such as a load operation could take twenty minutes to complete, make sure the Shutdown Time Limit (in seconds) is set to a value greater than twenty minutes.

Edit IIS Site Bindings

**NOTE** This procedure is required to support the concurrent caching service on the application server.

1. Open Internet Information Services Manager.
2. Expand the Sites node.
3. Select the Default Web Site node.
4. Under **Edit Site** in the Actions pane, click **Bindings**.

5. Select **net.pipe** type and click **Edit**.

6. Type * in the **Binding information** field to show all bindings and click **OK**.
Setting Up the Application Server

7. Select **net.tcp** type and click **Edit**.

8. Type **808:*** in the **Binding information** text box to show the bindings and click **OK**.

9. Click **Close** to finish editing bindings.

Configure Office Reference Files

In order for Office reference files to work with Windows Server 2008 R2 and SmartPlant Foundation, you must configure a folder on the SmartPlant Foundation application server and add the File Service user to the Administrators group on the application server.

Create a Folder on the SmartPlant Foundation Application Server

1. Browse to C:\Windows\SysWOW64\config\systemprofile on the SmartPlant Foundation application server.
2. Create a new folder in the **systemprofile** folder and name the new folder **Desktop** (for example C:\Windows\SysWOW64\config\systemprofile\desktop).

Add the File Service User to the Administrator Group

1. Log on to the SmartPlant Foundation application server.
2. Open **Administrative Tools > Computer Management**.
3. On the **Computer Management** window, browse to the **Groups** folder (click **Computer Management > System Tools > Local Users and Groups > Groups**).
4. Right-click the **Administrators** group and select **Properties**.
5. On the **Administrators Properties** dialog box, click **Add** to open the **Select Users, Computers, Service Accounts, or Groups** dialog box.

6. On the **Select Users, Computers, Service Accounts, or Groups** dialog box, click **Object Types...** to open the **Object Types** dialog box.

7. Select the types of objects you want to find and click **OK** on the **Object Types** dialog box.

8. On the **Select Users, Computers, Service Accounts, or Groups** dialog box, select **Locations...** to open the **Locations** dialog box.

9. Browse to and select a location and click **OK** on the **Locations** dialog box.

10. On the **Enter the object name to select** section of the **Select Users, Computers, Service Accounts, or Groups** dialog box, type the name of the file service user. For example, type **SPFFileServer**.

11. Click **Check Names** to verify the correct name.

12. Click **OK** on the **Select Users, Computers, Service Accounts, or Groups** dialog box to add the user.

13. Click **OK** on the **Administrators Properties** dialog box to save the settings and close the dialog box.

14. Close the **Computer Management** window.

### Setting the Theme for Running the Desktop Client on the Server

If you run the SmartPlant Foundation Desktop Client on the application server, you must set the desktop theme to Windows 7 Basic in order to display the Desktop Client properly.

1. Log on to the SmartPlant Foundation application server with user credentials that allow you to alter personalization settings.

2. Start the **Windows Server 2008 Server Manager**.

3. Click **Features**.

4. Click **Add Features**.

5. Select **Desktop Experience**.

6. Click **Yes** to add the required services.

7. Click **Next**, and then click **Finish**.

8. Restart the application server.

9. Log on again, and if prompted after logon, click **Close** to complete the wizard.
10. Start the **Windows Server 2008 Server Manager** again, and click **Configuration > Services**.
11. Start the **Themes** service manually.
12. In the **Windows Control Panel**, click **Change the theme** under **Appearance and Personalization**.
13. Select the **Windows 7 Basic** theme.

**NOTE** The default theme on Windows Server 2008 is Windows Classic.

**Configuring Security for the Application Server**

SmartPlant Foundation security is dependent on access to the following components:

- IIS and Web sites
- Oracle Client components
- Microsoft .NET Framework
- SmartPlant Foundation applications
- Microsoft Excel

**Changing Security Settings in Excel**

Perform one of the procedures below for the version of Excel you have installed on the application server.

**Change Security Settings in Microsoft Excel 2007**

1. Log on to the application server as the local SPF_Server user.
2. Open Microsoft Excel.
3. In Excel, click the **Office button** in the upper left corner.
4. Click **Excel Options**.
5. Click **Trust Center**.
6. Click **Trust Center Settings**.

7. Click **Macro Settings**.

8. Click **Disable all macros with notification**.
Setting Up the Application Server

9. Click the **Trust access to the VBA project object model** check box.

10. Click **OK**.

11. Click **OK** in the **Options** dialog box to save your changes.


13. Log out of the server computer.

**Tip** The above procedure lowers the security for only the one logged-in user. If necessary, you can set the default macro security settings for all users on the computer by editing the following registry key to add the value shown.

**Caution** Intergraph recommends only experienced users edit the registry settings.

```
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\12.0\Excel\Security]
"AccessVBOM"=dword:1
```

**Note** On a 64-bit system, the registry key is located at

```
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\12.0\Excel\Security
```
Change Security Settings in Microsoft Excel 2010

1. Log on to the application server as the local SPF_Server user.
2. Open Microsoft Excel.
3. In Excel, click the File tab on the menu bar.
4. Click Options.
5. Click Trust Center.
Setting Up the Application Server

6. Click **Trust Center Settings**.

7. Click **Macro Settings**.

8. Click **Disable all macros with notification**.
9. Click the **Trust access to the VBA project object model** check box.

10. Click **OK**.

11. Click **OK** in the **Options** dialog box to save your changes.


13. Log out of the server computer.

**TIP** The above procedure lowers the security for only the one logged-in user. If necessary, you can set the default macro security settings for all users on the computer by editing the following registry key to add the value shown.

**CAUTION** Intergraph recommends only experienced users edit the registry settings.

```
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\14.0\Excel\Security]
"AccessVBOM"=dword:1
```

**NOTE** On a 64-bit system, the registry key is located at

```
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\14.0\Excel\Security
```
IIS Security

There are two IIS security scenarios for which SmartPlant Foundation can be configured:

- Anonymous Authentication
- Integrated Windows Authentication

For information on IIS 7.0 security/permissions, please refer to the following article:
http://support.microsoft.com/kb/981949

Anonymous Authentication

Anonymous users are used for running all server-side processes; these are the only SmartPlant Foundation/IIS users.

Integrated Windows Authentication

The client user credentials are passed to the server to be used by IIS to run server-side processes, making all domain users SmartPlant Foundation/IIS users. For instructions, see Set Up Integrated Windows Authentication (on page 80).

Set Up Integrated Windows Authentication

When you set up integrated Windows authentication on the SmartPlant Foundation server, the user logging on to the server must have a valid Windows account on the server as well as a user account in the SmartPlant Foundation database.

You can use an existing SmartPlant Foundation user and create a matching Windows user, or you can create a new user.

**Important** On Windows Server 2008, to enable Windows Authentication, your SmartPlant Foundation application pool identity must be set to a domain user account, not a local user account, and this domain user account must be a member of the SPFUsers group on that server. If a local account is used, logging on will result in a 401 (unauthorized access) error.

**Note** Integrated Windows authentication cannot be set up to work over HTTP proxy connections. This limitation is imposed by Microsoft.

Enable Integrated Windows Authentication for IIS 7

If you are using IIS 7, you must enable Integrated Windows Authentication because it is not enabled by default. Follow the instructions below.

1. On the SmartPlant Foundation server, open the Control Panel.
2. Open Administrative Tools > Internet Information Services.
3. If you want IWA to be specific to a web site, select the web site in the tree view. Otherwise, select the local computer.
4. Double-click Authentication in the Features View window.
5. Enable Windows Authentication.
Setting Up the Application Server

Install Windows Authentication
If Windows Authentication is not in the list, follow the instructions below to install the role service.

a. Open Server Manager (Start > Administrative Tools > Server Manager).
b. In the tree, expand the Roles node.
c. Right-click Web Server (IIS), and then click Add Role Services.
d. On the Add Role Services dialog box, in the Role services box, select Windows Authentication.
e. Click Next.
f. Click Install.

Configure the SmartPlant Desktop Client Logon
If you are logged on to the computer as the Windows authenticated user, when you start the Desktop Client, the Logon Information dialog box appears by default with the User name and Password boxes grayed out.

1. Click Start > All Programs > Intergraph SmartPlant Foundation > SmartPlant Foundation Desktop Client.
2. Select the server, and click OK to log on to the Desktop Client.

Use the SmartPlant Foundation Authentication Dialog Box
You can configure the system to use the SmartPlant Foundation Authentication logon dialog box, which prompts you for the Windows account user name, password, and domain. Use the following instructions to configure the Desktop Client to prompt you for the Windows user name.

1. Double-click the Desktop_Client.exe.config file located in the installation directory, for example, C:\Program Files\SmartPlant\Foundation\2008\SPFDesktopClient\CurrentVersion. The file opens in Notepad.
2. Scroll down to find this line in the servers section: <add key="server_name" value="server_name:SPFServer" />.

   <!-- servername -->
   <add key="CERT2K3DRA38" value="CERT2K3DRA38:SPF42Server" />
   </servers>

   <!-- servername -->
   <add key="CERT2K3DRA42" value="CERT2K3DRA42:SPF42Server" />
   </servers>

3. Add the three Boolean values **False:True:True** to the line as shown below.

```xml
<add name="webhost:webdirectory" value="cert2k3ora42:smartplant" /></add>
```

**NOTE** The values correspond to the properties **Secure:Internet:IWA**. The first value controls the HTTPS setting. If you are also using HTTPS, set the values to **True:True:True**, and for more information about setting up the server for HTTPS, see **Set Up HTTPS** (on page 83).

4. Save and close the config file.

5. Start the Desktop Client (**Start > All Programs > Intergraph SmartPlant Foundation > SmartPlant Foundation Desktop Client**).

6. Type the **User name**, **Password**, and **Domain** for the Windows authenticated user, and click **OK** to log on to the Desktop Client.

---

### Enabling Integrated Windows Authentication for the Business Intelligence Service

1. Edit the **web.config** file for the site.

   **NOTE** By default, the web.config file is installed under the SmartPlant Foundation server files folder, under `Web_Sites\[site_name]\`.

2. Under the **basicHttpBinding** node, uncomment the line:

   ```xml
   <transport clientCredentialType="Windows" />
   ```

3. Reset IIS.
Setting Up the Application Server

Set Up HTTPS

If the application server is to be set up for a secure HTTPS connection, perform the following procedure.
1. Install an SSL Certificate.
2. Configure the Desktop Client for secure communications.

Secure the Host for HTTPS

**NOTE** Before setting up HTTPS on a server, its host object in SmartPlant Foundation must be secure.
1. Start the SmartPlant Foundation Desktop Client.
2. Find the host for your server.
   - **TIP** Click Find > Administration > Host.
3. Right-click the host and select Update.
4. Select the Is host secure check box.
5. Click OK.

Install an SSL Certificate

Follow the instructions provided by the third-party certificate provider for installing and creating the SSL certificate.

**NOTE** When installing and creating an SSL certificate, the certificate computer name and the SmartPlant Foundation host computer name must match exactly. If the names do not match, SmartPlant Foundation will not work.

After the certificate is installed, to eliminate the use of HTTP and require SSL for communication, perform the following optional procedure.
1. In IIS Manager, expand the Sites folder, and select your web site.
2. In the IIS section, double-click SSL Settings.
3. Select Require SSL and click Apply.

**NOTE** This is a system-wide parameter. This step is optional, depending on the desired security level for your servers.

**IMPORTANT** Before SSL can be enabled, an HTTPS binding for secure communications must be added to the web server. To add a binding, right-click the web site and click Edit Bindings. Click Add, select https from the Type list box, assign an IP address or range, select the certificate from the SSL certificate list box, and click OK.

Setting HTTPS on the DefaultSPFServerURL

When you setup a server site to HTTPS in SmartPlant Foundation Server Manager, you must edit the server site’s setting DefaultSPFServerURL to include the HTTPS setting.
Configure the Desktop Client for Secure Communications

To enable Desktop Client to use SSL to communicate with the server

1. In the Logon Information dialog box, click Edit Server.
2. Select Secure channel (SSL).
3. Click OK.

Manually Edit the Desktop Client Configuration File

As an alternative to the above procedure, if you would prefer to modify the Desktop Client's configuration file manually, perform the following procedure:

1. Double-click the Desktop_Client.exe.config file located in the installation directory, for example, C:\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion. The file opens in Notepad.
2. Scroll down to find this line in the servers section: <add key="server_name" value="server_name:SPFServer"/>

3. Modify the server name to reflect the fully qualified domain name, for example <add key="server_name:domain_name.com" value="server_name:domain_name.com:SPF42Server"/>

4. Add the three Boolean values True:True:True to the line as shown below.

<servers>
  <add key="name" value="webhost:webdirectory[optional :true denotes a" -->
  <add key="CERT2K3O4A2" value="CERT2K3O4A2:SPF42Server"/>
</servers>

NOTES The values correspond to the properties Secure:Internet:IWA. The third True value enables Integrated Windows authentication (IWA). If you are using IWA, for more information, see Set Up Integrated Windows Authentication (on page 80).

5. Save and close the config file.

Your changes are reflected in the Logon Information dialog box when you log in to the Desktop Client. The Secure Channel (SSL) option is checked.

Enabling HTTPS for the Business Intelligence Service

1. Edit the web.config file for the site.

   NOTE By default, the web.config file is installed under the SmartPlant Foundation server files folder, under Web_Sites\[site_name].

2. Under the basicHttpBinding node, comment out the line:

   <security mode="TransportCredentialOnly" />

3. Uncomment the line:

   <security mode="Transport" />

4. Reset IIS.
Configuring FTR and Remote Services for HTTPS

To allow FTR indexing and metadata searching to work in an HTTPS/SSL environment, both of the following conditions must be met:

- The FTR main host software must be installed on the SmartPlant Foundation application server with the SmartPlant Foundation Server component, and SSL security should be applied to or removed from both these components together.
- The File Service and FTR Webservice must be installed on the same server, and SSL security should be applied to or removed from both these components together. (Note that it is not required to install the File Service on the application server.)

For Remote Services to work in an HTTPS/SSL environment, both of the following conditions must be met:

- Remote Services must be installed on the SmartPlant Foundation application server with the SmartPlant Foundation Server component.
- SSL security must be applied to or removed from the SmartPlant Foundation Server and Remote Services together.
Permissions for SmartPlant Foundation Processes

Below are recommendations for setting permissions for SmartPlant Foundation processes on the application server.

NOTE: Server Manager on initial launch displays the Create local operating system users for site application pools option. The option is selected by default, and it creates local users on the operating system, sets them to run as the identity of the related application pool, and adds the local user to the SPFUsers group. If you prefer to perform this process manually, do not select the option and refer to Appendix D: Configuring IIS Application Pools and User Accounts Manually (on page 177).

Oracle Client

Make sure the entire Oracle Client folder from the root drive has read/execute/list permissions propagated for the IIS users.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Client installation directory</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
</tbody>
</table>

.NET Framework

Make sure all the .NET Framework directories from the root drive have read/execute/list permissions propagated for the IIS users.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SystemRoot%</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\System32</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\System32\Inetsrv</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\Microsoft.NET</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\Globalization</td>
<td>READ, WRITE, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
</tbody>
</table>

File Access

- **Debug/Logs** - Make sure all the debug log directories have read/execute/list/write permissions for SmartPlant Foundation/IIS users if logging is being used.
- **SmartPlant Foundation Program Files** - Make sure all the SmartPlant Foundation program directories have read/execute/list permissions for the SmartPlant Foundation/IIS users.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;\Program Files\Common Files\Intergraph</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>&lt;drive&gt;\Program Files\SmartPlant\Foundation</td>
<td>READ, EXECUTE, LIST</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
</tbody>
</table>
Setting Up the Application Server

File Service Access

- **SmartPlant Foundation Vaults** - Make sure all the vault directories have read/execute/list/write permissions for the SmartPlant Foundation/IIS users.
- **System Temp Directory** - Make sure the system temp directory has read/execute/list/write permissions for the SmartPlant Foundation/IIS users.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;:\SmartPlant Foundation 2014 Server Files This folder, subfolder, and files</td>
<td>READ, WRITE, EXECUTE, LIST</td>
</tr>
<tr>
<td>%SystemRoot%\Temp This folder, subfolders, and files</td>
<td>READ, WRITE, EXECUTE, LIST</td>
</tr>
</tbody>
</table>

RSA Container

Make sure the user account that runs your SmartPlant Foundation application pools in IIS has read/execute/list permissions.

These permissions should be applied only to the user account that runs your SmartPlant Foundation application pools:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Data\Microsoft\Crypto\RSA This folder, subfolder, and files</td>
<td>READ, EXECUTE, LIST</td>
</tr>
</tbody>
</table>

COM+ Access

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;:\SmartPlant Foundation 2014 Server Files This folder, subfolder, and files</td>
<td>READ, WRITE, EXECUTE, LIST</td>
</tr>
<tr>
<td>%SystemRoot%\Temp This folder, subfolders, and files</td>
<td>READ, WRITE, EXECUTE, LIST</td>
</tr>
</tbody>
</table>

Security for IIS Sites

The main SmartPlant Foundation Web site (SPFServer) is the site through which all SmartPlant Foundation client-server transactions occur. This site requires client access and can be secured using Integrated Windows Authentication (IWA) for the validation of domain user credentials. To secure the communications, the https/ssl protocol can be used instead of standard http.

**NOTE** To support View and Markup functionality, you must also allow external access for the SPFViewDir site via an anonymous account.

The other Web sites handle server-side Microsoft .NET functionality and are only accessed from the application server. You can limit access to these sites.
Limit Access to the SmartPlant Foundation Server Web Site for IIS 7

On Windows Server 2008 R2, follow the instructions below.
1. On the application server, open the Control Panel.
2. Open Administrative Tools > Internet Information Services.
3. In the tree view, select the local computer, and expand the Sites node.
4. Select the SmartPlant Foundation server Web site. By default, this site is called SPFServer.
5. In the Features View window, double click IPV4 IP Addresses and Domain Restrictions.
6. In the Actions window, click Add Allow Entry.
   The Add Allow Restriction Rule dialog box appears.
7. In the Add Allow Restriction Rule dialog box, select Specific IPv4 address and enter the IP address for the SmartPlant Foundation server.
   TIP Other computers should not be granted access to this Web site.
Port Assignments for SmartPlant Enterprise

This subsection lists the TCP ports that are used by default for SmartPlant Enterprise server and workstation communications. You should consider these assignments as a starting point that may need to be adjusted and configured for your implementation. 

**NOTE** Stateful packet inspection should be used to control communication through the firewall.

### SmartPlant Foundation Port Assignments

The following TCP ports are used by SmartPlant Foundation and its components.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>TCP/UDP</th>
<th>Communication</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For IIS (used by SmartPlant Foundation and SmartPlant Markup Plus), SmartPlant Review (when opened within SmartPlant Foundation), and SmartPlant Explorer. Can be reassigned.</td>
</tr>
<tr>
<td>139, 445, 137, 138</td>
<td>TCP</td>
<td>From workstation to server; from server to workstation</td>
<td>For Microsoft File Sharing (workstation to server, server to server)</td>
</tr>
<tr>
<td>3389</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For Microsoft Remote Desktop (workstation to server)</td>
</tr>
<tr>
<td>8575</td>
<td>TCP</td>
<td>From workstation to server; from server to workstation</td>
<td>For SmartPlant Foundation License Manager (FLEXlm). Can be changed. For information, see &quot;SmartPlant Foundation License File Activation&quot; in the SmartPlant Foundation Licensing Guide.</td>
</tr>
</tbody>
</table>

### Oracle Database Port Assignments

The Oracle database uses the following port assignments.

**NOTE** These assignments might not be required if Oracle is not used as a database within your SmartPlant Enterprise implementation.

**IMPORTANT** For the Oracle components listed below, port assignments can be custom-configured as indicated. For each component, additional information can be found in the cited Oracle documentation. These Oracle references contain links to additional Oracle content, providing important considerations, including discussions about other affected components that may require matching port changes to be made, as well as the instructions for changing the assigned ports.
<table>
<thead>
<tr>
<th>Port Number</th>
<th>TCP/UDP</th>
<th>Communication</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For Oracle HTTP. Can be reassigned. Configurable port range is 80, 7777-7877, 8888. For information, see <a href="http://download.oracle.com/docs/cd/E12524_01/core.1013/e10403/portnums.htm#i653967">http://download.oracle.com/docs/cd/E12524_01/core.1013/e10403/portnums.htm#i653967</a>.</td>
</tr>
<tr>
<td>1521, 1526</td>
<td>TCP</td>
<td>From workstation to server; from server to workstation</td>
<td>For Oracle Client SQL Net Connection (1521 is default). Can be changed using Oracle Net Configuration Utility to port within range 1024-65535. For information, see <a href="http://download.oracle.com/docs/cd/E11882_01/install.112/e16773/ports.htm#CIHCCJCF">http://download.oracle.com/docs/cd/E11882_01/install.112/e16773/ports.htm#CIHCCJCF</a>.</td>
</tr>
<tr>
<td>1158</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For Oracle Enterprise Console (1158 is default). Configured during database installation. Can be changed within range 5500-5519. For information, see <a href="http://download.oracle.com/docs/cd/E11882_01/install.112/e16773/ports.htm#CIHCCJCF">http://download.oracle.com/docs/cd/E11882_01/install.112/e16773/ports.htm#CIHCCJCF</a>.</td>
</tr>
<tr>
<td>5560, 5580</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For Oracle SQL Plus (5560 is default). Can be changed within range 5560-5579. For information, see <a href="http://download.oracle.com/docs/html/B13805_02/ports.htm#BEHFDBEE">http://download.oracle.com/docs/html/B13805_02/ports.htm#BEHFDBEE</a> – section D.5.</td>
</tr>
<tr>
<td>443</td>
<td>TCP</td>
<td>From workstation to server</td>
<td>For Oracle HTTP Server SSL Port (443 is default). Can be set to either 443 or 4443. For information, see <a href="http://download.oracle.com/docs/cd/E12524_01/core.1013/e10403/portnums.htm#i653967">http://download.oracle.com/docs/cd/E12524_01/core.1013/e10403/portnums.htm#i653967</a>.</td>
</tr>
<tr>
<td>7809</td>
<td>TCP</td>
<td>From server to server</td>
<td>Required for Oracle Global Workshare. GoldenGate is now used for replication and this port is needed for the GoldenGate Manager to handle communication between the servers.</td>
</tr>
<tr>
<td>7810-7820</td>
<td>TCP</td>
<td>From server to server</td>
<td>Required for Oracle Global Workshare. GoldenGate is now used for replication and this port is needed to facilitate the transfer of transaction information between the GoldenGate instances.</td>
</tr>
</tbody>
</table>
### SQL Server Port Assignments

The Microsoft SQL Server database uses the following port assignments.

**NOTE** This assignment might not be required if Microsoft SQL Server is not used as a database within your SmartPlant Enterprise implementation.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>TCP/UDP</th>
<th>Communication</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1433</td>
<td>TCP</td>
<td>From workstation to server; from server to workstation</td>
<td>SQL Server Instance</td>
</tr>
<tr>
<td>1434</td>
<td>UDP</td>
<td>From workstation to server; from server to workstation</td>
<td>SQL 2008 Browser</td>
</tr>
</tbody>
</table>
For information on upgrading to SmartPlant Foundation Version 2014 from versions 2008 and later, refer to the *SmartPlant Foundation Upgrade Guide*.

For information on upgrading from earlier versions of SmartPlant Foundation and migrating data to the current version, contact Intergraph Support or your project team.
SECTION 6

Setting Up SmartPlant Foundation File Servers

SmartPlant Foundation uses file servers to store files for objects that exist in the SmartPlant Foundation database. Files for objects are stored on the file server in a vault. You can have one or more file servers per SmartPlant Foundation installation. Any computer, including the SmartPlant Foundation application server, that contains a vault is a file server and must have the SmartPlant Foundation file server software installed.

You can distribute your SmartPlant Foundation file servers in a variety of ways. The file server can be configured on the SmartPlant Foundation application server or on a remote file server. For example, if you have users distributed across multiple sites, you can create a file server that is local to each site so that users can access files more easily.

You can also use third-party file replication software to copy files to a local file server for viewing from the SmartPlant Foundation clients.

**NOTE** For information on the recommended hardware and required software for a remote file server, see SmartPlant Foundation File Server (on page 28).

File Server Setup Tasks

To set up file servers for SmartPlant Foundation, you must do the following on each file server computer:

- Install prerequisite software on the file server (including any Microsoft Office applications that are needed to view documents).
- Install the SmartPlant Foundation File Server software. See Install the File Server Software (on page 97).
- Configure file services on the server:
  - If the file server resides on the SmartPlant application server, perform the site creation procedure, which will create the file service site. See Using Server Manager to Configure the Application Server (on page 47).
  - If the file server is remote, configure the virtual directories that support file services. See Configuring Virtual Directories for a Remote File Server (on page 97).
- Configure vaults on the file server in SmartPlant Foundation Desktop Client:
  - Create a new host for your file server. See Setting up a Host for the File Server (on page 101).
  - Configure vaults on the file server, relating the vault to the new host. See Create a New Vault (on page 103).
  - Configure document management for the vault by relating the vault to groups or a configuration level. See Configure Document Management for a Vault (on page 104).
  **NOTE** For more information on configuring vaults, refer to How To Configure Document Management and How To Configure the Infrastructure Model.
- Set up file replication, if needed, to copy files from the main SmartPlant Foundation file server to the replicated file server using third-party file replication software. You can set up the replication software to perform constant synchronization or periodic synchronization. For more information, see the documentation for your replication software.

SmartPlant Foundation Installation and Setup Guide 95
Remote File Service Overview

The mechanism for downloading (viewing) and uploading files between a SmartPlant Foundation client workstation and a remote file server is illustrated below.

**File download (viewing)**

1. Client workstation requests file from application server.
2. Application server sends request to file server to copy file to cache.
3. File server sends acknowledgment to application server when copy is complete.
4. Application server sends URL of file to client workstation.
5. Client workstation opens URL on file server.

**File upload**

1. Client workstation sends file transfer request to application server.
2. Application server sends URL of file to client workstation.
3. Client workstation posts file to URL on file server.
4. File server sends acknowledgment to client workstation when file is received.
5. Client workstation sends acknowledgment to application server that file is transferred.
6. Application server sends request to file server to copy file to vault.
7. File server sends acknowledgment to application server when copying to vault is complete.
Install the File Server Software

The File Server software can be installed on the SmartPlant Foundation server or another server. You can have multiple file servers for a single SmartPlant Foundation installation.

TIP If you are using the SmartPlant Foundation application server as your file server and you have already installed the File Server component during SmartPlant Foundation installation on that server, you do not need to repeat this installation procedure for that server.

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click setup.exe on the CD.
2. Click SmartPlant Foundation Installation in the SmartPlant Foundation Installation window.
3. Click Next.
4. Enter your User Name, Company Name, and Serial Number, and then click Next.
5. Verify that the registration information is correct, and then click Yes.
6. Select your country from the list, and click Display to view the license agreement.
   IMPORTANT The license agreement is delivered as a PDF file; consequently, you must have Acrobat Reader installed on your computer to view the license agreement. If the software detects that Acrobat Reader is not installed, a message box displays.
7. Carefully read the licensing agreement. When you are finished, close the PDF file and click Yes to accept the terms.
8. To accept the default installation location for SmartPlant Foundation, click Next.
   TIP If you want to change the installation location, click Browse and navigate to the new folder. Then, click Next.
9. In the Setup Type dialog box, click Custom, and click Next.
10. In the Select Components dialog box, click File Server, and click Next.
11. Select the program folder where you want SmartPlant Foundation to appear on your Start menu, and click Next.
12. Verify the installation settings, and click Next to copy files to your computer.
   TIP If the settings are not correct, click Back to change the installation options.
13. Click Finish.

Configuring Virtual Directories for a Remote File Server

In addition to installing the file server software, you must also set up the file service virtual directories on the remote file server. Remote file services can be configured using either of two methods:

- Set up the virtual directories using SmartPlant Foundation Server Manager.
- Set up the virtual directories manually.

NOTE Intergraph recommends using Server Manager to configure the file services on the remote file server.
Configure a Remote File Service with Server Manager

**IMPORTANT** To use this procedure to configure a remote file service virtual directory, you must install the SmartPlant Foundation Server component as well as the File Server component on the remote file server.

1. Start **SmartPlant Foundation Server Manager**.
2. Accept or enter a new server root path.
3. Allow Server Manager to set permissions for the server, if desired.
4. Create a new site, with the following stipulations:
   - Make sure the site names match for both the sites created on the file server and the sites on the application server (for example, if the site is named *SPFFileService* on the application server, the file service on the remote file server should also be *SPFFileService*).
   - For the database, choose to connect to an existing database, specifying the same database used by the main site on the application server.

**TIP** For more information on creating a site, see *Create a New Site* (on page 54).

5. After the site has been created, under the site’s **File Service Settings** node, enter the information about the file service on the remote file server.

**IMPORTANT** In order for the remote file server to be accessed by the SmartPlant Foundation application server, the **File Service virtual directory** property value on the remote file server must match the value entered for the **FileServiceDirectory** property under the site’s **Settings** node on the application server. As shown in the following graphics, the site name of *PERF433* is used on both the application server and the file server. The set of virtual names (*PERF433* and *PERF433*File) must be identical on both the application server and the file server.

**NOTE** The only virtual directories that are required for remote file services are the two file service virtual directories (for example, SPFViewDir and SPFFileService).
Configure a Remote File Service Manually

1. Copy the **SPFFileService** directory from the SmartPlant Foundation product directory (for example, c:\Program Files (x86)\SmartPlant\Foundation\2014) to a new location on the remote file server.

2. Create a file service virtual directory in IIS with the same name as the SmartPlant Foundation File Service virtual directory on the application server (for example, **SPFFileService**) and set the physical path of the virtual directory to the location where the file service files were copied.
   a. In IIS Manager, right-click **Default Web Site** in the tree view, and select **Add Application**.
   b. Enter the file service name for the **Alias** (for example, **SPFFileService**), set the **Physical path** to the file service files, and click **OK**.

3. Create a second virtual directory in IIS with the name **SPFViewDir**.
   a. Create a folder on the server named **SPFViewDir**.
   b. In IIS Manager, right-click **Default Web Site** in the tree view, and select **Add Application**.
Setting Up SmartPlant Foundation File Servers

c. Enter the name **SPFViewDir** for the **Alias**, set the **Physical path** to the directory you created in the earlier step, and click **OK**.

![Add Virtual Directory](image)

4. Edit the **web.config** file in the File Service virtual directory, ensuring that the following path points to the location of the SPFViewDir virtual directory on the remote file server:

   ```xml
   <add key="SPFViewDir" value="" />
   ```

5. Set permissions for file service access on the remote file server.

   **TIP** For details about the directories that require permissions to be set, see the **File Server Access** section of **Permissions for SmartPlant Foundation Processes** (on page 86).

Configuring Vaults on the File Server

A vault is an identified directory on the network used to store the physical files associated with an object. Vault configuration requires relating the vault to both infrastructure and document management objects. Vaults are configured using the SmartPlant Foundation Desktop Client.

**Infrastructure Configuration for Vaults**

In the SmartPlant Foundation infrastructure model, **vaults** are related to **hosts**:

- Host > Vault(s)

The host identifies the file server on which a vault is configured.

**NOTE** Access to replicated vaults can be configured by relating users to organizations, and organizations to hosts. For more information on configuring relationships between users and organizations, refer to **How to Configure the Infrastructure Model**. For more information on configuring replicated vaults, refer to **How to Configure Document Management**.

**Document Management Configuration for Vaults**

In the SmartPlant Foundation document management model, **vaults** can be related to either an **owning group** (which was standard practice in previous versions of SmartPlant Foundation) or a **configuration** (such as a plant).
Setting Up SmartPlant Foundation File Servers

- If a vault is related to an owning group, objects associated with that owning group are stored in the vault.
- If a vault is related to a configuration (such as a plant), objects associated with that configuration item are stored in the vault.

**NOTE** For more information on relating owning groups and configurations to a vault, as well as using object interface relationships to set conditions on the objects directed to a vault, refer to *How to Configure Document Management*.

### Setting up a Host for the File Server

A host is any computer that stores files. Host identification includes both computers that store files for a long term and computers used for short term processing, such as PDF generation. In order to store and manipulate physical files such as documents and drawings in SmartPlant Foundation, users, organizations, and vaults must be created and then related to a host object. To uniquely identify each directory location on each host where the files are stored, a vault object must be created. The file storage vault is determined by conditions on the relationship between interfaces on the object and the vault.

Hosts are configured using the SmartPlant Foundation Desktop Client.

#### Create a New Host

1. Click **File > New > Administration > Host**.
2. On the **New Host** dialog box, type the host name in the **Name** field and a description in the **Description** field. If the new host is secure, select the **Is host secure** box. If the file server is remote, enter the remote server’s name as the host name.

3. Click **Finish** to create the new host. The new host displays in the **New Items** window.
**Relationships Between Hosts and Organizations**

Users are associated with an organization or company. A host or a collection of hosts are associated with an organization or company. Users have relationships to hosts through their relationship to a company or organization. This set of relationships provides users with access to printer groups and printers as well as replicated vaults.

When you create an organization, you can associate it with one or more hosts. You define the host of your external organization on the **New External Company** form. You define the host of your new internal organization host on the **New Department/Office** form.

If you did not associate the organization with a host when it was created, you can create the relationship by dragging the host on the company object.

For more information, see *SmartPlant Foundation How to Configure the Infrastructure Model*. 
Create a Relationship Between a Host and an Organization

If you did not associate the organization with a host when it was created using the New External Company or New Department/Office form, you can create the relationship by dragging the host on the company object.

1. Click the host and drag it on the company object.
2. On the New Relationship dialog box, click OK to create the new relationship.

Create a New Vault

2. Type a Name and Description for the vault.
   - IMPORTANT:
     - Do not use numbers for the leading characters of the vault name if you will be performing batch print, PDF generation, titleblock, or archive and purge operations on files in the vault. These operations fail if the name begins with numeric characters. For example, "Vault1001" is acceptable, but "1001Vault" is not.
     - Do not use spaces in the vault name.
     - Do not start the name of the vault with the letter combination "xml".
   - Local path: Location in which the files are stored on the server.
   - Sub directory property expression: The name of the property of a file or related object used to name subdirectories when those files or related objects are added to the vault
   - Host: Name of the host for this vault. The host (web server) is where the vault is located.
   - Maximum file count: Maximum number of files to be stored in the vault. To specify no file limit, enter 0
3. Click Finish to create the vault.
In order for objects to be published to the vault, you may need to relate an interface to the vault for the type of object being added to the vault. For more information, see *Force a Class of Object to a Vault* (on page 105).

**Configure Document Management for a Vault**

The configuration of a document management scheme for the vault is typically a choice of either:

- Relating the vault to a plant or other configuration level (for example, the ConfigurationTop level or a project within a plant).
- Relating the vault to one or more owning groups, where the owning group represents a set of users.

The configuration of these document management settings is performed using SmartPlant Foundation Desktop Client. The relationships can be established using drag-and-drop operations.

**NOTE** Your vaulting strategy can include relating vaults to particular object types or interfaces, as well as restricting the contents of vaults by associating a vault with particular object properties. For detailed information on vault configuration, refer to the *How to Configure Document Management* guide.

**Plant Configuration**

When relating a vault to a plant or other configuration level, document objects that are associated with that configuration level are stored in the related vault. A vault that is related to a particular configuration item, such as a plant, can contain objects associated with sub-configurations below that level, such as projects related to a plant. Separate vaults can also be created for each sub-configuration level.

For example, a vault related to the ConfigurationTop level can act as a default vault, since objects related to all sub-configurations can be published to that vault. While an object associated with a particular plant, such as PlantA, can be published to a vault related to ConfigurationTop, the object cannot be published to a vault that is related to another configuration at the same level, such as PlantB, or to a project within another plant hierarchy.

**Owning Group**

SmartPlant Foundation has two ownership relationships. You can configure an object to be owned by a user or by an owning group, which is why groups are more commonly referred to as owning groups. The link between users and owning groups is not a simple relationship; it is via the user’s role.

Owning groups are typically configured to set up ownership of data by department or discipline. Owning groups can be used to control the user’s access to an object or parts of an object based on its ownership. This control operates independently of domains and configurations, both within and across multiple domains and configurations. Access control by object ownership can be configured to control the following:

- Shortcut menu command access (for example, check out of a document)
- Menus and toolbar access (for example, for the process group)
- Query access to objects (for example, documents)

**IMPORTANT** In cases where an object might be placed in one vault because of its applicable configuration and another vault because of its relation to an owning group, the owning group relationship takes precedence over the configuration relationship. In this situation, the object would be stored in the vault that is associated with the owning group.
Force a Class of Object to a Vault

 Vaults can be configured for specific classes of objects by relating the vault to an interface instantiated on the object being vaulted. This interface is not a file interface but one on the object to which the file is attached (for example, ISPFDocumentVersion or ISPFNonSectionedTransmittal).

The basic rule is that once an interface is related to a vault:

- That vault is only valid for objects that instantiate that interface.
- Objects that instantiate that interface can no longer be vaulted in any vault that is not related to an interface instantiated on that object.

For example, to force all published documents to use a vault named PlantAVault, the vault could be configured as follows:

<table>
<thead>
<tr>
<th>Name:</th>
<th>PlantAVault</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Owning Groups:</td>
<td>None</td>
</tr>
<tr>
<td>Related Configurations:</td>
<td>PlantA</td>
</tr>
<tr>
<td>Related Interfaces:</td>
<td>ISPFTEFPublishedDocVersion</td>
</tr>
</tbody>
</table>

**IMPORTANT** Once a vault is configured for an interface of an object, that object can only go to vaults that are related to interfaces that the object instantiates. For example, if PlantA is configured as shown above, and a document is published for another plant, PlantB, and a similar vault is not configured for PlantB, the document will not be published to a vault. To publish to a vault, a PlantB vault must be configured and related to that interface.

Configuring Vault Replication

In many cases, the SmartPlant Foundation server and file server are on the end of a wide area network (WAN) from users. Slow connections can make accessing files across a WAN time consuming. To improve performance, administrators can configure remote vaults so that vaults are on a local network for the users who are accessing them.

When you attempt to view a file, the SmartPlant Foundation server checks to see whether the vault containing the file is replicated or not. If the vault is replicated, the server determines the local vault for the logged in user and then sends a request to the specified local file server to start the viewing process.

**NOTE** Files in replicated vaults can be viewed or modified. If these files are modified, however, they are copied to the replicated vault and then to the main file server to allow all other users to access the files, which can take additional time.
Setting Up SmartPlant Foundation File Servers

Viewing, Creating and Updating Documents
The following graphic shows how the SmartPlant Foundation client accesses a local, replicated vault for viewing documents and the main SmartPlant Foundation file server for creating and updating documents.
In the following example, vaults are located on file server 1, file server 2, and file server 3. File server 1 is replicated on file server 3 using third-party replication software.

Server Identification
If a file is viewed, and replicated vaults are being used, it is necessary to know which file server to view the file from. To achieve this:

- Create a new relationship definition between Host and Organization (SPFOrganizationFileServerHost).
  
  Because a user probably belongs to an Organization, a collection of the file hosts that a user wants to define as his local set can be configured by attaching the hosts to the organization object and ensuring that the user is a member of the correct Organization.

- When a file is viewed, its vault and therefore its host can be derived.

- If a host is related to the user’s organization, it is considered as a local host to the user (User-Organization-Host). If the host derived from the file is local to the current user, the file is directly viewed.

- If the host is not local to the current user, SmartPlant Foundation checks if this vault is replicated to any of the local hosts for the current user. If so then the file is directly viewed from the local host. If such a host is not found, the file is viewed remotely from the original host.
Considerations for Setting Up Vault Replication

If there is a large user base at a remote location that will be manipulating files, then you should consider what remote sites are required.

What do you want to replicate?
The answer depends on the remote user community you are going to support. You need to consider the time to view remotely versus the overhead of replicating large amounts of data. If for example, the remote site only views one type of documents/files, you can configure your vaults such that all the files for the remote location are in one vault location, and you can be very selective on the vault folders to replicate.

What replication software to use?
SmartPlant Foundation does not have built-in file replication. Depending on the complexities/volumes of data being replicated, you might use something as simple as Robocopy or consider some third-party replication software that is designed to build replication rules for copying across a WAN.

Vault Replication Configuration Checklist

The following is an overview of the process required for configuring vault replication:

- Configure remote file services on the remote file server(s) to support replication.
- Set up vault selection rules as necessary.
- Relate the remote vault(s) to the local vault (SPFVaultReplicatedTo).
- Configure the users to the relevant Organizations.
- Configure the local replicated vaults.
- Relate the remote file server hosts to the relevant organizations.
- Set up replication software to replicate files to remote file server(s) based on your replication rules.
- Test files attached by the local and remote users.
- Verify the files are placed in the relevant vault locations and file viewing works from all locations.

Set Up Remote File Services for Vault Replication

To set up a file server for vault replication at the remote site(s) where you want local file access

1. Copy the site's SPFFileService folder and its contents from the SmartPlant Foundation application server to the remote file server.

   **NOTE** On the application server, this folder is located within the default program folder location (for example, \Program Files\SmartPlant\Foundation\2014).

2. Rename the folder from SPFFileService to the name of your parent web site folder (for example, from \Program Files\SmartPlant\Foundation\2014\SPFFileService to \Program Files\SmartPlant\Foundation\2014\Web_Sites).

3. Create a virtual directory for this folder under the Default Web Site in Internet Information Services (IIS) Manager on the file server, giving it the same name as the file service virtual directory on the application server (for example, <your_site_name>FileServer).

4. Create a second virtual directory in IIS on the file server with the name SPFViewDir.
5. In the web.config file within the `<your_site_name>\FileService` folder on the file server, ensure that the following key is edited so that the value points to the location of the SPFViewDir directory on the file server:

```
<add key="SPFViewDir" value="" />
```

### Relate Replicated Vaults to Source Vaults

If creating replicated vaults, each replicated vault must be related to its source vault in SmartPlant Foundation Desktop Client.

1. Log into SmartPlant Foundation Desktop Client as a user with Engineer and System Administrator rights.
2. Select **Find > Administration > Vault** and show all vaults.
3. Drag the new replicated vault onto the source vault.
4. In the **New Relationship** dialog box, confirm that the new replicated vault is listed as a child object to the source vault with the relationship of **Replicated Vaults** and click **OK**.

**IMPORTANT** To keep the source and replicated vaults synchronized, third-party replication software may be required:

- When an item is created in the source vault, it must be synchronized with the replicated vault using third-party replication software.
- When an item is created in the replicated vault, it is synchronized with the source vault automatically by SmartPlant Foundation.

**NOTE** To relate two vaults for replication, each vault's **Sub directory property expression** and **Maximum file count** properties must match.
After you install software and set up database access on the SmartPlant Foundation server, you can configure SmartPlant Foundation to meet the needs of your company. The following sections describe some of the typical configuration tasks that might be necessary for SmartPlant Foundation.

For information about tasks in addition to the ones that are described in the sections that follow, please refer to the set of *How To Configure* guides for that task. Below is a partial list of some additional configuration tasks and the guide or guides in which you may find configuration information on that subject.

- **Configuring vaults**  
  *How To Configure Document Management*

- **Setting up printing**  
  *How To Configure Document Management*
  *How To Configure the Infrastructure Model*

- **Configuring scheduled tasks**  
  *How To Configure the Infrastructure Model*

- **Configuring Full Text Retrieval (FTR)**  
  *How To Configure Document Management*
  *How To Configure the Infrastructure Model*

- **Setting up the Plant Breakdown Structure (PBS)**  
  *How To Configure the Security Model*

- **Setting up Plants and Projects**  
  *How To Configure the Security Model*

For more information about these and other configuration tasks, see *How To Setup and Configure SmartPlant Foundation*.
Setting Up PDF Generation

Typically, PDF generation is part of issuing a transmittal. However, you can also configure SmartPlant Foundation to generate PDFs interactively from SmartPlant Foundation.

**NOTE** For information on PDF generation for SmartPlant Instrumentation file types (.brw, .spd, and .ssf), see Preliminary Settings for Publishing from SmartPlant Instrumentation in the Integration User's Guide.

Configuring PDF Generation with SmartPlant Markup Plus

You can use SmartPlant Markup Plus to generate PDF files for supported file types. SmartPlant Markup Plus generates a PDF file with the same name as the original file with the addition of a PDF extension. For example, if `border.dgn` is the source file name, the software generates a file named `border.dgn.pdf`. SmartPlant Foundation relates these PDF copies to the corresponding file in the SmartPlant Foundation database.

**NOTES**

- For a complete list of available .INI parameters, refer to the *SmartPlant Markup Plus User's Guide, Appendix A*.
- For SmartPlant file formats, a printer named “SmartPlant PDF Converter 452” is installed on the SmartPlant Foundation application server when SmartPlant Markup Plus is installed. This printer is used for PDF generation and should not be removed or used for any other purpose.
- For SmartPlant file formats, the command line `dmredl.exe -p obj.Name -pdf $OUTPUTDIR` is added as the Alternate Rendition application. For information on adding arguments to this command line, refer to the *SmartPlant Markup Plus User's Guide*.
- For non-SmartPlant file formats, either `spm -pdf` or `dmredl.exe -p obj.Name -pdf $OUTPUTDIR` can be added as the Alternate Rendition application. For information on adding arguments to this command line, refer to the *SmartPlant Markup Plus User's Guide*.
- For non-SmartPlant file formats, if the `dmredl.exe` command is used as the Alternate Rendition application, a separate scheduler task is created. If the `spm -pdf` command is used as the Alternate Rendition application, no scheduler task is created (and the PDF should generate faster).
- SmartPlant Instrumentation file types (.brw, .ssf, .spd) cannot be viewed by SmartPlant Markup Plus and cannot be generated into PDF format by SmartPlant Markup Plus. These files can be generated into PDF format within SmartPlant Instrumentation before being published to SmartPlant Foundation (which can then be viewed and printed using SmartPlant Markup Plus).

Configure a File Type to Use SmartPlant Markup Plus for PDF Generation

**NOTE** Perform this procedure for any file type supported by SmartPlant Markup Plus that has not been already configured to use SmartPlant Markup Plus for PDF generation.

1. Log into SmartPlant Foundation Desktop Client as a user with Engineer and System Administrator roles.
2. Click **Find > Administration > File Type**.
3. On the **Find File Type** dialog box, type * into the **Enter Name** box and click **OK**.
4. Select the file type you want to associate with PDF generation.
5. Drag the icon for the file type onto the icon for the **PDF** file type.

6. On the **New Relationship** dialog box, click **Maintain Attributes**.

7. On the **Create** dialog box, enter the following command line into the **Alternate Rendition Application** field for SmartPlant file formats:

   ```
   dmredl.exe -p obj.Name -pdf $OUTPUTDIR
   ```

   For non-SmartPlant file formats, enter: `spm -pdf`.

8. Click **OK**.

9. Click **OK** on the New Relationship dialog box.

   **IMPORTANT** The file type must also be defined as a MIME type on the IIS server. For example, Office 2007 file types should be added to the MIME list in order for PDF generation of Excel 2007 files to succeed. For more information, see Define MIME Types.

---

**PDF Generation with Custom .INI Settings**

**NOTES**

- Custom .INI file settings are supported for SmartPlant file formats only. For non-SmartPlant file formats, custom .INI file settings are not supported. The following instructions can only be used for SmartPlant file formats.
- For a complete list of available .INI parameters, refer to the *SmartPlant Markup Plus User's Guide, Appendix A*.

To generate a PDF with custom settings, you can specify the .INI file that contains the custom settings using the `-i` switch in the command line of the **Alternate rendition application** text box.

For example, to print a watermark diagonally on each page of the PDF, you can add the following to an .INI file (named `CustomSettingsFile1.ini` in this example):

```ini
[SPMParameters]
PrtWaterMarkText=TEST WATERMARK3
PrtWaterMarkPosition=2
PrtWaterMarkFontName=Arial
PrtWaterMarkFontSize=48
```

To include the custom settings for PDF generation, include the .INI file containing these settings in the command line as shown:

```bash
dmredl -p obj.Name $OUTPUTDIR -i "C:\CustomSettingsFile1.ini"
```

More than one .INI file can be included in the Alternate rendition path. The following is an example for specifying multiple .INI files:

```bash
```

All the settings in the .INI files supplied in the Alternate rendition path are concatenated on execution. If two or more .INI files contain the same settings, the settings in last .INI file listed in the Alternate rendition path will be take the precedence.

For example, if the file `CustomSettingsFile1.INI` contains the setting `PrintRange=0` (current view), but in the file `CustomSettingsFile3.INI` the setting value is `2(All)`, the PDF will be generated with `PrintRange=2(All)`, which is taken from the `CustomSettingsFile3.INI` file.
SmartPlant Foundation Settings for SmartPlant Markup Plus

NOTES

- Before completing the rest of the installation, you must install SmartPlant Foundation Server and Desktop Client on your computer. Be sure to create a site using SmartPlant Foundation Server Manager.

Set the View Rendition Auto Convert Option
1. Click **Start > SmartPlant Foundation Desktop Client**.
2. Type your required information in the **Logon Information** dialog box.
3. Select **Find > Administration > SmartPlant Foundation Options**.
4. Click **OK** on the **Find SmartPlant Foundation Options** dialog box.
5. Right-click **SystemOptions** and select **Update**.
6. Click to place a check mark in the **View Rendition Auto Convert** checkbox on the **Update - SPF System Options** dialog box.

![View Rendition Auto Convert Options](image)

Starting the Main Scheduler
1. Click **Start > SmartPlant Foundation Desktop Client**.
2. Type your required information in the **Logon Information** dialog box.
3. Click **Find > Administration > Schedulers**.
4. In the **Find Schedulers** dialog box, type **MainScheduler** and click **OK**.
5. Right-click **MainScheduler**.
6. Select **Scheduler > Start**.

Recycling the Application Pools
1. Click **Start > Administrative Tools > IIS Manager**.
2. Click **Sites > Default Web Site** to expand your server hierarchy.
3. Select **SPFRemoteServices** in the **Default Web Site** tree.
4. Click **Basic Settings** to display the **Edit Application** dialog box.
5. Check the Value in the **Application pool** field. For example, `SPFRemoteServices`.

6. Using **IIS Manager**, select the **Application pools** folder.
7. Select the **Application pool** found in steps 5.
8. Right-click and select **Recycle**.
9. Close **IIS Manager**.

**Settings for secure HTTPS connection**

If the application server is to be set up for a secure HTTPS connection, refer to the *SmartPlant Foundation Installation and Setup Guide (Set Up HTTPS topic)*.

**NOTE** If the server is setup using self-signed certificate, refer to the *SmartPlant Markup Plus Troubleshooting Guide, Appendix G* for instructions about generating a self-signed certificate.

**Diagnostic Tool Framework for SmartPlant Markup Plus Server**

There are tools available to check configurations for SmartPlant Markup Plus Server Microsoft Office conversions. For detailed information, refer to the *Diagnostic Tool Framework for SmartPlant Markup Plus Server* topic in the *SmartPlant Markup Plus Troubleshooting Guide*.

**Additional Settings and Tips Required for Generating a PDF/CSF**

If PDF generation fails, perform the following troubleshooting steps to determine the source of the problem.

**NOTE** SmartPlant Foundation can use SmartPlant Markup Plus and SmartPlant Instrumentation Title Block Component to generate PDF documents, depending on the type of file you are converting to PDF. For more information about configuring PDF generation on the application server, refer to either *SmartPlant Foundation Installation and Setup Guide* or the *Integration Setup Guide*.

1. Confirm that SmartPlant Markup Plus or SmartPlant Instrumentation Title Block Component is installed properly on the application server.

**TIP** For information on installing SmartPlant Markup Plus, refer to the *SmartPlant Markup Plus Installation Guide*. For more information on installing SmartPlant Instrumentation Title Block Component, refer to either the *SmartPlant Foundation Installation and Setup Guide* or the *Integration Setup Guide*. 
2. Confirm the special printers for PDF generation are installed on the server: **SmartPlant PDF Converter XXX**.

   **Tip:** If the appropriate printer is not present, you may need to either reinstall the printer or the component. For information on installing the printer for SmartPlant Markup Plus, see Missing SmartPlant PDF Converter Printer. If the title block component printer is missing, you may need to reinstall SmartPlant Instrumentation Title Block Component.

3. Execute the following command on the application server to test whether the application can generate PDF documents.

   - If using SmartPlant Markup Plus, substitute your source file name and full path for obj.Name and the full path to the target folder location for $OUTPUTDIR:
     
     ```
     dmredl.exe -p obj.Name -pdf $OUTPUTDIR
     Example: dmredl.exe -p "C:\PIDFiles\Turbine.pid" -pdf "C:\PIDFiles"
     ```
   
   - If using SmartPlant Instrumentation Title Block Component, substitute your source file name and full path for obj.Name and the full path to the target folder location for the $OUTPUTFILENAME:
     
     ```
     updatectb.exe obj.Name $OUTPUTFILENAME
     Example: updatectb.exe "C:\PIDFiles\c_192.brw" "C:\PIDFiles\c_192.brw.pdf"
     ```

4. Confirm that the source file type is configured for PDF generation in the SmartPlant Foundation Desktop Client.

   **Tip:** For information detailing the expected configuration for PDF generation in the SmartPlant Foundation Desktop Client, refer to the "Setting Up PDF Generation" topics within the "Configuring SmartPlant Foundation" section of either the **SmartPlant Foundation Installation and Setup Guide** or the **Integration Setup Guide**.

5. Confirm that the user executing SPFRemoteServices on the application server has permissions to all PDF-generation-related folders on the server.

   **Tip:** These folder locations include the installation folders for SmartPlant Markup Plus and the title block component and temporary folders on the server. For more information on security and permissions settings, refer to the "Configuring Security for the Application Server" topics within the "Setting Up the Application Server" section of either the **SmartPlant Foundation Installation and Setup Guide** or the **Integration Setup Guide**.

---

**Setting Launch and Active Permissions**

The user configured for SPFRemoteServices must have launch permissions set correctly.

1. Click **Start > Run**, and then type **dcomcnfg** to open Component Services.
2. In Component Services, expand **Component Services**, and then expand **Computers**.
3. Right-click **My Computer**, and then click **Properties**.
4. Click the **COM Security** tab.
5. In the **Launch and Activation Permissions** area, click **Edit Default**.
6. Click **Add**.
7. Type **Local Service**, and then click **OK**.
8. Select **Local Service**.
9. Check the **Allow** check box for the following items:

   - Local Launch
   - Local Activation
10. Click **OK**, and then click **OK** again.
Adding SPFRemoteServices to the Administrators Group

1. Click Start > Administrator Tools > Server Manager.
2. Click and expand the Configuration > Local Users and Groups > Groups tree.
3. Right-click Administrators.
4. Click Add to Group.
5. Click Add on the Administration Properties dialog box.
6. On the Select Users dialog box, type hostname\SPFRemoteServices in the Enter the object names to select field.

7. Click Check Names.
8. Click OK.
9. Click OK.

Defining Application Pool Settings for SPFRemoteServices

Locate the Application Pool Name for SPFRemoteServices

NOTE The user name and password must have administrative privileges.

1. Click Start > Administrative Tools > IIS Manager.
2. Click Sites > Default Web Site to expand your server hierarchy.
3. Select SPFRemoteServices in the Default Web Site tree.
4. Click Basic Settings to display the Edit Application dialog box.
5. Write down the value in the Application pool field. For example, SPFRemoteServices.
6. Click **Cancel**.

**Locate the Application Pool Identity Name**

1. Click **Start > Administrative Tools > IIS Manager**.
2. Click **Application Pools**.
3. Click **AppPoolName** (for example, SPFRemoteServices). This value was found using the Locate the Application pool name for SPFRemoteServices steps.
4. Click **Advanced Settings** to display the **Advanced Settings** dialog box.
5. Write down the value for **Identity** in the **Process Model** field. For example, SPRRemoteServices. This value will be the username.

6. Click **Cancel**.
Locate the User Password

1. Using the Identity value (username) located in the previous steps, type this path in Windows Explorer:
   
   C:\\Program Files  
   (x86)\\SmartPlant\\Foundation\\2014\\ServerManager\\UsersAndPermissionsScripts\\

2. Right-click CreateSiteScriptWithNewUserIIS6.bat and open the file using Notepad.

3. In the opened file, locate and confirm that the defined password is #1#2#3#4#a#b#c. Write down the password.

   **NOTE** If the default password has changed, write down the password. The change must be updated on the application pool's identity also. In other words, the user's password must match what is used for the application pool's identity.


Login Tasks

1. Log off the server.
2. Using the username and password located in the previous steps, login on the server.
3. Open Microsoft Word or Microsoft Excel.
4. Complete the Microsoft Office system dialog boxes and other activation dialog boxes.
5. Enter the following path in Windows Explorer:
   
   C:\Users\SPFRemoteServices\AppData\Local

   **NOTE** If you are unable to view the AppData folder because it is set to hidden, select Organize > Folder and search options. Click the View tab on the Folder Options dialog box. Click Show hidden files, folders, and drives.

6. Right-click on the Temp folder and select Properties.
7. Click the Security tab.
8. Click Edit.
9. Select SPFUsers in the Group or user names list on the Permissions for Temp dialog box.
10. Place a checkmark in the Modify check box.
11. Click OK.
12. Log off.
Configuring Microsoft Office Files for Generating a PDF/CSF

To allow office files with macros to convert to PDF/CSF renditions, the SaveAsXPS add-in for Microsoft Office 2007 needs to be used and macros need to be enabled in Microsoft Office Trust Center.

Smart Plant Markup Configuration Steps

1. If Microsoft Office 2007 is installed, download and install SaveAsXPS.exe add-in from:
   **NOTE** Microsoft Office 2010 has the SaveAsXPS add-in already installed.

2. Save the original copy. Then edit the C:\Program Files\IGC\IGCWriter\BIPrint.ini file delivered with SmartPlant Markup Plus. Add the following sections or edit them if they already exist.
   **NOTE** Only the [ConversionUsingIGCDriver] section is delivered by default.

   ![Code Snippet]

   In the previous example, you can customize the options listed under [SaveAsXPS] and [SaveAsXPSImplementedFor] based on your needs. Microsoft Excel, PowerPoint, Visio, and Word files will use the SaveAsXPS add-in to convert to the CSF/PDF file formats.
3. Save the original copy, and then edit the `C:\Program Files (x86)\SmartPlant\Markup\NetIt\NetIt_Enterprise\JobProcessor\BDLGenServer.exe.config` file delivered with SmartPlant Markup Plus. **NOTE** In the `<appSettings>` section of this file, the key named `STATTypes` must match the `FileExtensions` configured in the previously described `BIPrint.ini` file. The order of the extensions does not matter.

4. Edit this key to read like the following.
   ```xml
   <add key="STATTypes" value="doc,docx,ppt,pps,pptx,ppsx,vsd,vdx,xls,xlsx "/>
   ```

5. You must use the user account that is running the Job Processor service to configure Microsoft Office. Go to **Start > Control Panel > Administrative Tools > Services** to verify this account ID.

### Office 2007 Configuration Steps

1. Using the account that is running the Job Processor service, open a Microsoft Office document. For example, open a Microsoft Excel file.

2. Click the **Microsoft Office Button** 📂.

3. Click **Excel Options**.

4. Click **Trust Center**.

5. Click **Trust Center Settings**.

6. Click **Macro Settings**.

7. Click to select **Enable all macros (not recommended; potentially dangerous code can run)**.

8. Click to select **Trust access to the VBA project object model**.

9. Click **OK**.
10. Restart your Job Processor service. With the previous Microsoft Office configuration changes, Microsoft Excel files with macros will successfully convert to PDF/CSF formats.

**Office 2010 Configuration Steps**

1. Using the account that is running the Job Processor service, open a Microsoft Office file. For example, open a Microsoft Excel file.
2. Select **File > Options**.
3. Select **Trust Center**.
4. Click **Trust Center Settings**.
5. Click **Macro Settings**.
6. Click to select **Enable all macros (not recommended; potentially dangerous code can run)**.
7. Click to select **Trust access to the VBA project object model**.
8. Click **OK**.
9. Restart your Job Processor service. With the previous Microsoft Office configuration changes, Microsoft Excel files with macros will successfully convert to the PDF/CSF formats.

**Using Alternate Rendition Service Debug**

**Setting SmartPlant Foundation RemoteServices Debug**

If you do not see a `.csf` file, turn the debug on for alternate rendition service and `spf` server. Then, increase the wait time for alternate rendition in the service's `web.config` file (C:\Program Files (x86)\SmartPlant\Foundation\2014\SPFRemoteServices).<add key="ProcessTimeOutForAlternateRendition" value="300"/>

This value is in seconds. The default value is 300.

**NOTE** If the size of the file being converted is large, it will take longer to process. And, after conversion completes, SmartPlant Foundation will also require more time to process the update.

1. Edit the SmartPlant Foundation RemoteServices web.config file (for example, C:\Program Files (x86)\SmartPlant\Foundation\2014\SPFRemoteServices).
2. Set the **General** value to 4.
3. Debug log file `SPF42remoteservicetrace.txt` displays in C:\Temp.

```xml
<system.diagnostics>
  <switches>
    <add name="General" value="4"/>
  </switches>
</system.diagnostics>
```
4. Select the file you need to convert.
5. Select **Generate View Rendition** using SmartPlant Foundation. Check the message in the log file to determine the error.

**Setting SmartPlant Foundation File Server Debug**

**NOTE** If the .csf conversion fails continuously, and you have checked to be sure all the SmartPlant Foundation settings are correct, then the following steps are required. Using the following steps creates many log files (which increase in size over time). It is recommended to turn the log file generation off after the problem is resolved.

1. Edit the SmartPlant Foundation File Server web.config file (for example, C:\Program Files (x86)\SmartPlant\Foundation\2014\SPFFileService).
2. Set the **General** value to 4.
3. The debug log file SPF40fileservicetrace.log is collected in C:\temp folder.

**Setting SmartPlant Foundation Server Debug**

**For SmartPlant Foundation Server (4.3)**

1. Edit the tracesettings.config file (for example C:\Program Files (x86)\SmartPlant\Foundation\2009\Server).
2. Set **General** and **RemoteServices** values to 4.
<add key="GeneralfileOut_CLOSE" value="YES"/>
<add key="RemoteServicesfileOut_CLOSE" value="YES"/>

3. Edit the appsettings.config file to specify where the debug files should be sent.

<add name="fileOut" type="System.Diagnostics.TextWriterTraceListener"
initializeData="C:\temp\SPF4servertrace.log"/>
<add name="GeneralfileOut"
type="System.Diagnostics.TextWriterTraceListener" initializeData="C:\temp\SPFGeneralTrace.log"/>
<add name="RemoteServicesfileOut"
type="System.Diagnostics.TextWriterTraceListener" initializeData="C:\temp\SPFRemoteServicesTrace.log"/>
...

For SmartPlant Foundation Server (4.4 and later)

1. Edit the tracesettings.config file to set General and RemoteServices values to Verbose.

   <add switchValue="Verbose" name="General">
     <listeners>
       <!--<add name="XML Trace Listener"/>-->
       <add name="Rolling TraceListener"/>
     </listeners>
   </add>
   <add switchValue="Verbose" name="RemoteServices">
     <listeners>
       <!--<add name="XML Trace Listener"/>-->
       <add name="Rolling TraceListener"/>
     </listeners>
   </add>

Debug files with time stamps (for example, SPFServerTraceRolling.2013-02-14.1.log) will be collected in the TraceLogs subfolder under SmartPlant Foundation Server directory.
Setting Up E-mail for SmartPlant Foundation

SmartPlant Foundation can be configured to use either the mail component JMAIL from Dimac Corporation http://www.dimac.com or Collaboration Data Objects (CDOSYS).

Change the E-mail Transport Method for SmartPlant Foundation

To change the mail transport method for SmartPlant Foundation

1. Start Server Manager and select the SmartPlant Foundation Sites > (Site_Name) > Settings node.
2. Edit the following properties:
   - Email::MailClient -- Enter the type of mail client you are using. Valid values are JMAIL for JMAIL and CDO for CDOSYS. CDO is the default value.
   - Email::SMTPHost -- Enter the name of your SMTP mail server.
   - Email::DefaultFromAddress -- Enter the mail address to be used in the From field for system E-mails.

Set a Default Mail Server for JMAIL

To set the default mail server for JMAIL, create the following registry key and set it to the host name of the local mail server: HKEY_LOCAL_MACHINE\SOFTWARE\Dimac\w3JMail4\Default Mailserver.

Test Email Configuration Command

The SmartPlant Foundation Server Manager Database > Test Email Configuration command allows you verify that the server can successfully send E-mail.

Test Email Configuration Dialog Box

Allows you to verify the E-mail configuration on the server by sending a test E-mail.

SMTP host - Type the fully qualified name of the SMTP server.
SMTP port - Type or scroll up or down to the port number used by the SMTP service.
E-mail client - Select the E-mail client used by the server.
From - Type an E-mail address to appear as the sender of the message.
To - Type the E-mail address of the recipient.
Subject - Type a subject for the message (optional).
Body - Type the body text of the E-mail message (optional).
Attachment - Type the full path and file name for a file being sent as an attachment (optional).

See Also
Test Email Configuration Command (on page 125)
Setting Up an Alternate Scheduler Server

SmartPlant Foundation allows you to offload the scheduler from the primary SmartPlant Foundation server to an alternate secondary server.

1. Install SmartPlant Foundation software on the computer designated as the dedicated scheduler server. For more information see the SmartPlant Foundation Server Manager Guide.

2. Use SmartPlant Foundation Server Manager to set up the scheduler server secondary site. During site creation, unselect the Create the site as primary site option and provide the values for the Host name for the primary config service and the primary Config service name.

   **IMPORTANT** Ensure the secondary scheduler server is set to use the same Config Service Name as the primary server, for example SPFConfigService.

3. On the client computer, configure a server site (SPFSite object) that contains the URL to the dedicated scheduler server secondary site and relate it to the scheduler object.

4. On a client computer connected to the primary server, create a site object with the File > New > Administration > Server Site command. When you create the site object, select the Is Active option.

5. Find the scheduler object you want to run on the secondary alternate server with the Find > Administration > Schedulers command. You can also create new scheduler objects.

6. Drag and drop the site onto the scheduler to create the relationship. This relationship directs the scheduler tasks to the alternate server.

7. If the scheduler is already started, stop and restart the scheduler to make the change.

   **NOTES**
   - Only ReportScheduler and PublishFileScheduler are supported on alternate servers.
   - When configuring ReportScheduler on an alternate server, ensure the SPFViewDir path is the same as the primary server SPFViewDir path.
   - When configuring PublishFileScheduler on an alternate server, ensure the Oracle client software has TNS connections to the primary site database.

For more information on the scheduler, see the How to Configure the Infrastructure Model guide.
Setting Up Enhanced Mechanical Equipment Data Sheets

This subsection describes how to set up the Enhanced Mechanical Equipment Data Sheets for SmartPlant Foundation, also referred to as Enhanced SmartPlant Foundation data sheets.

Install Enhanced Mechanical Equipment Data Sheets

1. Double-click setup.exe to begin the installation.
2. Click Next in the Welcome window.
3. Enter your User Name, Company Name, and Serial Number in the Customer Information window, and click Next.
4. Review the information in the Registration Confirmation window, and click Yes to continue, or click No to go back and make changes.
5. In the Select Features dialog box, do one of the following:
   - Check the For Excel check box to install Enhanced Mechanical Data Sheets for Excel.
   - Check the For SmartPlant Foundation check box to install Enhanced Mechanical Data Sheets for SmartPlant Foundation.
6. To accept the default installation location, click Next.
7. To begin installing, click **Install**.
8. Click **Finish**.

**Setting Up Enhanced Mechanical Equipment Data Sheets**

After you install the Enhanced Mechanical Equipment Data Sheets for Intergraph SmartPlant Foundation, you must incorporate the delivered data sheet schema files into an existing SmartPlant Foundation site.

**Incorporate the Enhanced Mechanical Equipment Data Sheets into an Existing Site**

Follow the instructions below to load the Enhanced Mechanical Equipment Data Sheets into an existing site on your SmartPlant Foundation server.

1. Start SmartPlant Foundation Desktop Client and log on.
   
   **NOTE** The user name must be assigned a System Administrator role. For information about how to configure roles, see the guide *How to Configure the Security Model*.

2. Click **File > Loader**.

3. Click the **Browse** button to navigate to the directory where the Enhanced Mechanical Equipment Data Sheets setup installed the model files. Typically, this directory is `<drive>\Program Files\SmartPlant\Mechanical Equipment Data Sheets\For SPF`.

4. Select the file `EFSchema_MechEQDAuth_Additions.xmlldr`. The loader files appear in the **Selected load files** list in the Loader.

5. Click **Process** to begin loading the files.
   
   **NOTE** This process might take an hour.
6. When the files are loaded, verify that the load was successful. Green check mark icons indicate that a file was successfully loaded. Click **Load Results** to easily review load status information.

7. Optional. Example equipment data is delivered that can be used for demonstration purposes. The example data is not required to configure equipment data sheets.
   - Select the file `EFSchema_MechEQDAuth_Examples.xmlldr` and repeat steps 5 and 6 to load the example data.

8. Close the Desktop Client.
Mechanical Equipment Data Sheet Options and Functionality

After you incorporate the data sheet schema into your site, you can use data sheets to enter and view equipment data, as well as publish and retrieve equipment data. The following new functionality and commands have been installed on the system:

- Equipment tags, assets, and models, including the 16 equipment tags with data sheets configured for them. See Data Sheets for the list of delivered data sheets.
- New **SmartPlant** menu options (click **SmartPlant > Mechanical**)
  - Publish
  - Retrieve
  - Register
  - Compare Latest Retrieved Data for EQD
  - Mechanical Design Basis Items
- New data sheet commands available when you right-click a tag
  - Generate Mechanical Data Sheet (Offline)
  - Generate Mechanical Data Sheet
  - Publish Datasheet (EQD)

**NOTE** The user name must be assigned the Mechanical Engineer role to access these features. For information about how to configure roles, see the *How to Configure the Security Model* from Intergraph Corporation guide.

Delivered Data Sheets

The following data sheets are delivered with the Enhanced Mechanical Equipment Data Sheets.

- API 560 - Fired Heater
- API 560 - Fan
- API 560 - Soot Blower
- API 560 - Air Preheater
- API 610 - Centrifugal Pumps
- API 611 - General Purpose Steam Turbine
- API 616 - Combustion Gas Turbine
- API 617 - Centrifugal Compressor
- API 618 - Reciprocating Compressor
- API 619 - Rotary Type Positive Displacement Compressor
- API 660 - Shell And Tube Heat Exchanger
- API 672 - PIG Centrifugal Air Compressor
- API 673 - Centrifugal Fan
- API 673 - Electric Motor
- API 674 - Reciprocating Pump
- API 675 - Controlled Volume Pump
- API 676 - Rotary Pump
- API 685 - SL Centrifugal Pump
Configuring the Security Model

The SmartPlant Foundation security model is a flexible mechanism to control role-based user access to data and the operations that can be performed on that data.

The security model is comprised of:

- Users
- Roles, domains, and access groups
- Configurations
- Role assignments

A user is assigned a role in a configuration, for example, to work as a Designer in Project1. Roles are related to access groups, which control access to the different components of the system.

The security model controls user access to:

- Menus and toolbars
- Shortcut menu commands
- Relationship manipulation and navigation
- Data segregation based on user and tool ownership
- Conditional data access supported by query, FTR, and reporting

Security Model Configuration

The SmartPlant Foundation Desktop Client is used to configure the security model by creating and relating security objects. No additional schema modeling of classes, interfaces, or relationship definitions is required.

Once the security access model is designed, the various levels of access are modeled by creating access groups and relating them to roles. The access groups are related to the relevant methods, interfaces, and view definitions to which they have to grant access.

For more details about the security model, refer to How To Configure the Security Model.

Enhancing Performance

SmartPlant Foundation can be configured to enhance performance.

Remove Audit Domain from an Upgraded Database

The Audit domain is no longer installed with SmartPlant Foundation. The Audit History and Hot Fix Report functionality is also no longer installed.

With the Audit domain absent from the database, system performance improves: loading schema from the database is faster, and any queries that are not tied to a specific domain run faster.

If you upgrade a database, the Upgrade Wizard does not remove the Audit domain from existing installations, so it must be removed manually.

**IMPORTANT** Upgrade the system before you remove the audit domain.

If you would like to remove the Audit domain from your upgraded database, follow the directions in the ReadMe file located in RemoveAuditDomain folder (for example, browse to C:\Program Files\SmartPlant\Foundation\2014\Database\Database Scripts\RemoveAuditDomain).
SECTION 8

Setting Up a SmartPlant Foundation License Server

Intergraph recommends setting up SmartPlant Foundation license management on a server that is separate from the application server on which SmartPlant Foundation is installed. You must have already installed and configured the SmartPlant License Manager server software on a designated license computer on your network before you can perform the procedures in this section to set up a license server for SmartPlant Foundation.

NOTES

- For information on the recommended hardware and required software for a license server, see SmartPlant Foundation License Server (on page 26).
- If you are currently using FLEXlm as your license manager, you can continue to use it but must perform the additional configuration procedures in this section to use it with this version of SmartPlant Foundation.

For information on installing and setting up the SmartPlant License Manager server software, refer to the SmartPlant License Manager Installation and User’s Guide. For information on installing and setting up a new FLEXlm license server, refer to Appendix E: Setting Up a FLEXlm License Server (on page 183). FLEXlm is available only to existing customers who are already using FLEXlm for SmartPlant Foundation licensing.

License Server Setup Process Summary

The process of setting up a SmartPlant Foundation license server is summarized below. Each step is detailed in the subsections that follow.

1. Install prerequisite software.
2. Install the SmartPlant License Manager Client software.
3. Configure the license server, which includes running SmartPlant Foundation Server Manager to create application pools and users and to set permissions.
4. Set up a license manager site using Server Manager.
5. Link the license server to a SmartPlant Foundation site.
6. Configure the SmartPlant License Manager client to connect to the SmartPlant License Manager server.
Installing Prerequisite Software on the License Server

Before you begin to set up your license server, make sure the following prerequisite software is installed:

- Internet Explorer
- Adobe Acrobat Reader (required to view the Software License Agreement and Printable Guides)
- MSXML (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)
- .NET Framework (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)

For the full listing of required software, including the current version numbers, see SmartPlant Foundation License Server (on page 26).

**NOTES**

- The license server requires access to the database server. The recommended client for that database should be installed and tested before you begin to configure the license server.
- You should also make sure that the IIS service is installed on the server before installing the licensing software.

Installing the SmartPlant License Manager Client on the License Server

You must install the SmartPlant License Manager client software on the license server for SmartPlant Foundation. This client software allows the license server to communicate with the designated license machine for the enterprise.

**TIP** For information on installing and setting up the SmartPlant License Manager software, refer to the SmartPlant License Manager Installation and User’s Guide.

Configuring a License Server

The main configuration tasks for setting up a license server include:

- Running SmartPlant Foundation Server Manager to set the root path and create the folder structure required for SmartPlant Foundation.
- Setting permissions for users and groups.

**TIP** You should also ensure that IIS is running on the server and that you can connect to the database server.

After the server is properly configured, you can create a license manager site and link the site to your SmartPlant Foundation site on the application server.
Defining the Application Server Default Folder Structure

The application server root path defines one location for all of your SmartPlant Foundation server files and defines all of the paths needed to run SmartPlant Foundation. The root path is created and modified through Server Manager. The first time you launch Server Manager, you are prompted to define a root path or accept the default root path (C:\SmartPlant Foundation 2014 Server Files).

Server Manager also uses the root path to set default paths for specific Server Manager nodes. For example, the SmartPlant Foundation Sites node uses default paths for Web site creation and for debugging.

You can use the Tools > Options command to modify the default path.

The Default Server Root Path

If you launch Server Manager without defining a root path, a default folder structure containing the following folders is created.

- **Backups** - Used for database backups that are created by the Upgrade Wizard.
- **CacheServers** – Keeps all cache server files in one place.
- **FileSync** - Used by the SPFViewDir virtual directory and for operations involving checking in/out files associated with documents.
- **FTP_Vaults** - Keeps all the vaults in one location for easy management. Although this is named FTP_Vaults, all vault file transfers in current version are via HTTP.
- **LicenseServers** - Keeps all license server files in one place.
- **Temp** - Used to create subfolders and log files for the SmartPlant Foundation server and debugging.
- **TraceLogs** - Default location for the outputs of trace logs from the server, cache, config, and license server tracing.
- **Web_Sites** - Keeps all the sites in one location for easy management.
- **WebPortals** - Keeps all the Web Portal sites in one location for easy management.

Grant permissions

Some basic folder permissions must be set in order for SmartPlant Foundation to run. The following permissions are recommended in order for SmartPlant Foundation to run securely.

- The server user needs access to the SmartPlant Foundation server directory.
- The server user needs Read and Write access of the Temp folders (within the root path for Server Manager).
- The server user needs Read and List permissions for the Web_Sites folder (within the root path for Server Manager).

Permissions can be set manually, or administrators can run scripts in Server Manager to grant basic permissions.

Manually Grant Permissions

For more information about manually setting permissions and a comprehensive list of recommended permissions settings, see Permissions for SmartPlant Foundation Processes (on page 86).
Grant Permissions Using Batch Scripts
Permissions can be set using batch scripts in Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions. You can run the scripts from the prompt, or you can choose to run the scripts at a later time.

The first time you start Server Manager, the program creates a new local user group, SPFUsers. By default, the scripts grant permissions to the SPFUsers group. If you choose to run the scripts at a later time, you can edit the files to grant personalized permissions settings to specific users and groups.

The following three batch scripts set permissions.

<table>
<thead>
<tr>
<th>Script</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>SettingPermissions.bat</td>
<td>Grants permissions for the SPFUsers group on multiple folders.</td>
</tr>
<tr>
<td>SettingPermissionsOracleClient.bat</td>
<td>Grants permissions for the SPFUsers group on the Oracle client home directory</td>
</tr>
<tr>
<td>SettingPermissionsLocalService.bat</td>
<td>Grants permissions for Local Service if using a 64-bit operating system and IIS 7 on a Windows Server 2008.</td>
</tr>
</tbody>
</table>

All three batch files call XCACLS.vbs. All files are delivered in the UsersAndPermissionsScripts folder (for example, browse to C:\Program Files\SmartPlant\Foundation\2014\ServerManager\UsersAndPermissionsScripts). A log file for the permissions scripts can be found at \[drive]\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log. For more information, see Permissions Script Files (on page 52).

Run Server Manager permissions scripts
1. Start SmartPlant Foundation Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions.
2. Click Yes on the dialog box to have Server Manager set up basic permissions.
3. Click OK on the dialog box when permissions are set up.
4. Review the log files for the permissions at \[drive]\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

Manually edit and run Server Manager permissions scripts
The first time you start Server Manager, the program creates a new local user group, SPFUsers. By default, the scripts grant permissions to the SPFUsers group. If you choose to manually edit and run the scripts at a later time, you can edit the files to grant personalized permissions settings to specific users and groups.

NOTES
- For more information, see Permissions Script Files (on page 52).
- Intergraph suggests you make a copy of the script file. Edit the copy, and then run the script file from the copy.

1. Start SmartPlant Foundation Server Manager. The first time you start Server Manager, the program prompts you to run batch scripts to set basic permissions.
2. Click No on the dialog box to set up permissions at a later time.
3. Browse to the script files. The scripts can be found in the \UsersAndPermissions\Scripts folder (for example, browse to C:\Program Files\SmartPlant\Foundation\2014\ServerManager\UsersAndPermissions\Scripts).

4. Make a copy of the script file.

5. Using the copy of the script file, edit the keywords in the permissions script with the required values.

6. Double-click the script name to run and set permissions.

7. Repeat steps 3-6 for each script file.

8. Review the log files for the permissions at [drive]:\SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

Permissions Script Files

The first time you open Server Manager, the SPFUsers local user group is created. The following script files are used to set permissions for the SPFUsers group. A log file can be found at SmartPlant Foundation 2014 Server Files\Temp\ServerManager\Permissions.log.

SettingPermissions.bat

For Windows Server 2008, this file gives the following permissions to the SPFUsers group in the following folders.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SystemRoot%\Temp This folder, subfolders, and files</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>%SystemRoot%\System\inetsrv\config This folder, subfolder, and files</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>&lt;drive&gt;:\Program Files\SmartPlant\Foundation This folder, subfolder, and files</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>&lt;drive&gt;:\Program Files\Common Files\Intergraph This folder, subfolder, and files</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>&lt;drive&gt;:\SmartPlant Foundation 2014 Server Files This folder, subfolder, and files</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys This folder, subfolder, and files</td>
<td>Read, Execute, List</td>
</tr>
</tbody>
</table>

The following table lists the variables for the script file.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1%</td>
<td>Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.</td>
</tr>
<tr>
<td>2%</td>
<td>Common Files\Intergraph directory. For example, C:\Program Files\Common Files\Intergraph.</td>
</tr>
<tr>
<td>3%</td>
<td>SmartPlant Foundation installed directory. For example, C:\Program Files\SmartPlant.</td>
</tr>
<tr>
<td>4%</td>
<td>SmartPlant Foundation server files directory. For example, C:\SmartPlant Foundation 2014 Server Files.</td>
</tr>
</tbody>
</table>
Setting Up a SmartPlant Foundation License Server

Variable Description
5% RSA directory. For example, C:\Program Data\Microsoft\Crypto\RSA.

SettingPermissionsOracleClient.bat
For Windows Server 2008, this file gives the following permissions to the SPFUsers group on the Oracle client home directory.

Directory Permissions

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Client installation directory</td>
<td>Read, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists the variables for the script file.

Variable Description
1% Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.
2% Oracle Home Client directory. For example, C:\app\Administrator\Product\11.2.0.

SettingPermissionsLocalService.bat
For Windows Server 2008, this file sets permissions for Local Service if using a 64-bit operating system and IIS 7.

Directory Permissions

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;\SmartPlant Foundation 2014 Server Files</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td></td>
</tr>
<tr>
<td>%SystemRoot%\Temp</td>
<td>Read, Write, Execute, List</td>
</tr>
<tr>
<td>This folder, subfolders, and files</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists the variables for the script file.

Variable Description
%1 Permission log file path. For example, C:\SmartPlant Foundation 2014 Server Files\Backups\Permissions.log.
%2 SmartPlant Foundation server files directory. For example, C:\SmartPlant Foundation 2014 Server Files.
Set Up a License Manager Site

The Server Manager New License Server Wizard allows you to create a new SmartPlant License Server virtual directory. This wizard performs the basic steps required for creating a new license server.

**IMPORTANT**

- Intergraph recommends that you add and delete sites only through the Server Manager application. Do not use IIS to delete any virtual directories created using this wizard.
- Only one license server virtual directory is allowed to be configured per machine.
- If you already use FLEXlm as your license server, you must configure a new license server in order to continue using it with this version of SmartPlant Foundation.
- FLEXlm is only supported on 32-bit operating systems. SmartPlant License Manager is supported on both 32-bit and 64-bit operating systems.

**NOTE** Creating a license server site also creates a virtual directory in IIS that points to the licensing data source.

Start the license server wizard

To start the New License Server Wizard right-click the SmartPlant License Manager node in the tree view and click New.

**TIP** Users can also select New License Server from the Edit menu.

The New License Server Wizard displays the Server Information page. You can now create your new license server and select between the two license server types, FLEXlm or SmartPlant License Manager. The license server type you choose is dependent on whether you are reconnecting an existing FLEXlm implementation or starting a new SmartPlant License Manager implementation.

**NOTES**

- The new license server wizard checks for the existence of a web.config file. If none is present an error message is displayed. If one exists the process continues.
- FLEXlm and SmartPlant License Manager both handle the general check in and check out of licensing. You can track how many users concurrently access the software, helping you to comply with the Software Licensing Agreement.

Define server information

1. In the Server Information page, type the new License server virtual directory name and License server virtual directory path.
2. Select the license server type, either FlexLM or SmartPlant License Manager.

**NOTES**

- The wizard displays the Create local operating system users for site application pools option. The option is selected by default, and it creates local users on the operating system, sets them to run as the identity of the related application pool, sets permissions for the users, and adds the local user to the SPFUsers group. If you prefer to perform this process manually, do not select the option and refer to Appendix D: Configuring IIS Application Pools and User Accounts Manually in the SmartPlant Foundation Installation Guide.
- Do not use special characters in the virtual directory name. Special characters cause errors if used.
Setting Up a SmartPlant Foundation License Server

- Server names should not exceed 20 characters. If you allow the wizard to create local users for the license server application pools, your server name should not exceed 20 characters. The wizard uses the license server name for the user name and Windows local user names cannot exceed 20 characters.
- The wizard creates an application pool with the same name as the virtual directory value.

**Update sites with new license server**

1. Select the site or sites from the Update Sites list that you want to use with the license server. Click Next.

    **NOTES**

    - The wizard updates the SPFAppServer.config files of the sites selected at the end of the process. It will add a new entry to the SPFAppServer.config file, which allows the administrator to direct each site to a license server. For example:
      
      `<add key="LicenseServerURL" value=http://localhost/SPFLicenseServer />

    - If no site was selected or none exists, click Next and the license server site creation continues. However, you have to manually go to the SmartPlant Foundation site's settings in Server Manager and add the license server URL you want to use. See *Link the License Server to a SmartPlant Foundation Site* (on page 143) for further information.

2. Click Next.

**Define database system information**

1. In the Database type box, select Oracle or SQL Server. The required information on the Database System page varies according to your selection.

2. Enter the following information, depending on the selection made in the Database Type box:

   - Oracle: In the Oracle alias box, type the Oracle Net alias to the server that hosts this server (for example, the name of the database instance that contains the tablespace being created here).
   - SQL Server: In the site Database server box, type the name of the Microsoft database server that hosts the database being created here.

   **TIP** To create a new Oracle tablespace or a new SQL Server physical database file and log file using the delivered dump file, clear the Use existing database option, and enter the following information:

   - In the System user box, type the name of the Oracle or SQL Server user who has privileges to create SmartPlant Foundation or SmartPlant Basic Integrator users. (If using a SQL Server database, you can select the Use Windows authentication option to use the credentials of the logged in user, instead of supplying a system user to connect to SQL Server.)
   - Type the System password.

   **NOTE** If you want to use an existing database, select the Use existing database option.

3. Click Next. The wizard tests the database connection using the supplied credentials. If the test succeeds, the Data Schema page displays. If it fails, an error message displays.

   **NOTE** If you are using Oracle, refer to *Create an Oracle database* (on page 141). If you are using SQL Server, refer to *Create a SQL server database* (on page 142).
Setting Up a SmartPlant Foundation License Server

Create an Oracle database

If you are using an existing Oracle database, skip to step 5. Otherwise, type, or browse to, the Location of the scripts to create tables to specify the scripts used to create the tables.

**Tip** This script is the default script installed with Server Manager.

**Notes**

- An example of the default script to create tables for an Oracle site can be found at:
  
  C:\Program \Files(x86)\SmartPlant\Foundation\2014\ServerManager\DatabaseScripts\Template_SP LMDbaseTablesOracle.sql

- If you are using an existing Oracle database, this option and the boxes for the Oracle tablespace and temp tablespace are disabled.

1. If you want to save the script path for future operations, select the Save as default option.
2. Select the Oracle tablespace from the list of valid tablespaces, or type the name of the tablespace.

**Notes**

- By default, the name of the new tablespace created appears in the list as the name of the site with a suffix of _Data.
- The name of the temp tablespace created appears in the list as the name of the site with a suffix of _DataTemp.

3. Select an Oracle temp tablespace, or type the name of the temp tablespace.

**Note** The name of the temp tablespace to be created appears in the list as the name of the site with a suffix of _DataTemp.

4. In the Database username box, type the name of the Oracle user who owns the objects in the Data database schema.

5. Type and then confirm the Database password for the Oracle database user.

6. Click Next to display the Ready to Create License Server page.

7. Review the new server parameters, and click Back to make any changes.

8. Click Next. The Server Creation Status displays as the site is created, and then the After License Server Creation page displays.

9. Read the information about the additional steps required to fully configure the new server, and then click Finish to create the server. The new server appears in the tree view.

**Note** At the end of the process the wizard adds a new entry to each selected site’s SPFAppServer.config file, which allows the user to direct each site to a license server. For example:

```
<add key="LicenseServerURL" value=http://localhost/SPFLicenseServer />
```
Create a SQL Server database

1. If you are using an existing SQL Server database, skip to step 5. Otherwise, type, or browse to, the Location of the scripts to create tables to specify the scripts used to create the database.
   
   TIP This script is the default script installed with Server Manager.

   NOTES
   
   • An example of the default script to create tables for a SQL server site can be found at: C:\Program Files (x86)\SmartPlant\Foundation\2014\ServerManager\DatabaseScripts\Template_SPLMD baseTablesSQL.sql
   
   • If you are using an existing SQL Server database, this option and the boxes for the physical database file and log file location are disabled.

2. If you want to save the current path for future operations, select the Save as default option.
3. Accept the default Physical database file location.
4. Accept the default Log file location.
5. In the Database username box, type the name of the database user who owns the objects in the data database schema.
6. Type and then confirm the Database password for the SQL Server database user.
7. Click Next. The Ready to Create License Server page displays. Review the new server parameters, and click Back to make any changes.
8. Click Next. The Server Creation Status displays as the site is created, and then the After License Server Creation page displays.
9. Read the information about the additional steps required to fully configure the new site, and then click Finish to create the site. The new site displays in the tree view.

   For more information about fully configuring the server, see Configure the license server for performance (on page 142).

   NOTE At the end of the process the wizard adds a new entry to each selected site's SPFAppServer.config file, which allows the user to direct each site to a license server. For example:

   <add key="LicenseServerURL" value=http://localhost/SPFLicenseServer />

Configure the license server for performance

After you have created your new license server site, verify that the new license server is fully configured for optimum performance in the SmartPlant Foundation environment. To fully configure a new license server site, Intergraph recommends the services of the following experts:

• A qualified network system administrator, who can configure IIS 7 and properly assign security settings.
• A qualified database administrator, who can make the necessary adjustments to the physical database design and performance.

IMPORTANT

• For detailed information and procedures on configuring the license server, and IIS and security settings in particular, refer to the Configuring Windows Server 2008 section of the SmartPlant Foundation Installation and Setup Guide or the Integration Setup Guide.
The product installation documentation provides additional information about configuring license servers; however, the documentation is not a substitute for a qualified expert.

**Link the License Server to a SmartPlant Foundation Site**

1. Start SmartPlant Foundation Server Manager on the application server.
2. Expand the node for the SmartPlant Foundation site to which your license server needs to connect.
3. Display the properties for the **Settings** node for the site.
4. In the **LicenseServerURL** property, enter the URL for the remote license server.
   
   **NOTE** If you set up your license server before you create the site on the SmartPlant Foundation application server, this property is defined automatically.

**Configuring the SmartPlant License Manager Client**

To allow the license server to participate in the SmartPlant License Manager implementation, you must set up the SmartPlant License Manager client software to communicate with the SmartPlant License Manager server.

**TIP** For details on how to configure the SmartPlant License Manager client software, refer to the *SmartPlant License Manager Installation and User’s Guide*. 
SECTION 9

Configuring Web Portals

The Web Portals node in SmartPlant Foundation Server Manager is used to configure settings for the Web Portals installed on the server. A Web Portal can be installed on the same server as SmartPlant Foundation, or it can be installed on another server. In a stand-alone installation, SmartPlant Foundation Server Manager is also installed so the Web Portal can be configured.

NOTE For information on performance tuning and settings, refer to How To Configure SmartPlant Foundation Performance.

Create a New Web Portal

1. In SmartPlant Foundation Server Manager, right-click the SmartPlant Foundation Web Portals node in the tree view.
2. Select the New command from the pop-up menu.
   TIP You can also access the New command in Server Manager by selecting the node in the tree view and then clicking Edit > New.
3. In the Web portal name box, enter a name for the Web Portal, such as SPFWebPortal.
4. In the Web portal directory box, enter the path to the location of the Web Portal files.
   NOTE
   - An application pool is created with the same name as the web site virtual directory value.
   - The Create local operating system users for site application pools option is selected by default, and it creates local users on the operating system, sets them to run as the identity of the related application pool, and adds the local user to the SPFUsers group. If you prefer to perform this process manually, uncheck this option and refer to Appendix D: Configuring IIS Application Pools and User Accounts Manually (on page 177).
5. Click OK and the Web Portal is added as a sub-node under the root Web Portals node.
   NOTES
   - When installing a Web Portal on the same server as the SmartPlant Foundation server, any sites that have already been created are added to the Web Portal automatically. If the Web Portal is being added on a stand-alone server, or if a site has not been created before the Web Portal is created, you must add the server manually. For more information, see Add a Web Portal Server (on page 146).
   - After a Web Portal has been created, the Web Portal Path property is read-only and cannot be modified. To change the location of the files, a new Web Portal must be created.
Delete a Web Portal

1. In the SmartPlant Foundation Server Manager tree view, right-click the Web Portal you want to delete from the **SmartPlant Foundation Web Portals** node.
2. Select the **Delete** command from the context menu.
3. In the confirmation window, click **Yes** to delete the Web Portal.
4. The Web Portal is removed from the **SmartPlant Foundation Web Portals** node.

**NOTE** When you delete a Web Portal, the underlying directory structure is not deleted.

Add a Web Portal Server

1. In SmartPlant Foundation Server Manager, right-click the Web Portal node under the root **SmartPlant Foundation Web Portals** node in the tree view.
2. Select the **New** command from the pop-up menu.
   
   **TIP** You can also access the **New** command in Server Manager by selecting the Web Portal in the tree view and then clicking **Edit > New**.
3. In the **Name** box, enter a name for the Web Portal server, which will appear in the drop-down list of servers when a user logs into the Web Portal.
4. In the **Web host** box, enter the computer name of the SmartPlant Foundation server.
5. In the **Web directory** box, enter the SmartPlant Foundation site name.
6. Click **Validate** to ensure that Server Manager can locate the server and site.
7. Click **OK** at the prompt and the Web Portal server is added as a property of the Web Portal node.

**NOTES**
- You can add more than one server to a Web Portal if you have multiple sites on your SmartPlant Foundation server.
- If your web server uses an alternate port number (other than port 80), add a colon and the port number in the **Web host** property value, as in `localhost:8080`.

Modify Web Portal Server Settings

1. In SmartPlant Foundation Server Manager, right-click the server in the list of properties for the Web Portal node under the root **SmartPlant Foundation Web Portals** node in the tree view.
2. Select the **Properties** command from the pop-up menu.
   
   **TIP** You can also access the **Properties** command in Server Manager by selecting the server in the tree view and then clicking **Edit > Properties**.
3. In the **Name** box, enter a name for the Web Portal server, which will appear in the drop-down list of servers when a user logs into the Web Portal.
4. In the **Web host** box, enter the computer name of the SmartPlant Foundation server.
5. In the **Web directory** box, enter the SmartPlant Foundation site name.
6. Click **Validate** to ensure that Server Manager can locate the server and site.
7. Click **OK** at the prompt and the Web Portal server is updated.
### Configuring Web Portals

**NOTE**: If your web server uses an alternate port number (other than port 80), add a colon and the port number in the **Web host** property value, as in `localhost:8080`.

### Delete a Web Portal Server

1. In SmartPlant Foundation Server Manager, right-click the server in the list of properties for the Web Portal node under the root **SmartPlant Foundation Web Portals** node in the tree view.
2. Select the **Properties** command from the pop-up menu.
   - **TIP**: You can also access the **Properties** command in Server Manager by selecting the server in the tree view and then clicking **Edit > Properties**.
3. Click **Delete**.
4. Click **Yes** to confirm the deletion.
5. Click **OK** and the Web Portal server is removed from the Properties list.

**NOTE**: When you delete a server from the Web Portal, the site will not be deleted from Server Manager if this is not a stand-alone Web Portal installation.

### Configure the Web Portal Authentication Method

The authentication method you choose for the Web Portal's web site directory may be dependent on the method of authentication chosen for the web directory of the SmartPlant Foundation server. You may also need to edit the Web Portal's **web.config** file to allow authentication to work properly. Refer to the following table to determine how to configure authentication for the Web Portal's web directory.

<table>
<thead>
<tr>
<th>If the SmartPlant Foundation server's authentication method is</th>
<th>Set the Web Portal's authentication method to</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous Authentication</td>
<td>Anonymous access</td>
<td>Web Portal can also be set to <strong>Integrated Windows or Basic</strong>, but the credentials are ignored by the SmartPlant Foundation server. No changes are required to the web.config file.</td>
</tr>
<tr>
<td>Integrated Windows Authentication</td>
<td>Integrated Windows Authentication</td>
<td>The web.config file must be edited to set the Impersonate attribute to True, which ensures that the login credentials are passed to the SmartPlant Foundation server. Then, the user can &quot;auto-login&quot; to the Web Portal using the login user name.</td>
</tr>
<tr>
<td>Basic Authentication</td>
<td>Basic Authentication</td>
<td>Allows the user to &quot;auto-login&quot; to the Web Portal using the login user name. No changes required to the web.config file.</td>
</tr>
</tbody>
</table>

To edit the web.config file and set the Impersonate attribute to True

1. Open the **web.config** file for editing in Notepad (or another text editor).
   - **TIP**: The file is located at the root of the Web Portal web directory (for example, `C:\SmartPlant Foundation 2014 Server Files\WebPortals\SPFWebPortal`).
2. Locate the `<system.web>` section of the file.
3. Edit the following attribute as shown:
   `<system.web>`
   
   `<identity impersonate="true" />`  
   
   `</system.web>`
4. Save the file.

**NOTE** To view or set the authentication method for a web site, start Internet Information Services (IIS) Manager on the server hosting the web site, select the site from the tree view under the server's Sites node, and double-click Authentication in the IIS features list.

## Configuring Integrated Windows Authentication (IWA) in a Double Hop Web Portal Configuration

The Web Portal server and the SmartPlant Foundation application server can be installed on different machines. For instance, the Web Portal server can run on a Microsoft SharePoint server separate from the SmartPlant Foundation application server. In this type of configuration, when a client attempts to log in to the Web Portal using Integrated Windows Authentication (IWA), the credentials must pass from the SharePoint server to a domain controller (or other authenticating server) and then on to the application server, completing a double hop. In order to authenticate domain credentials for IWA in this double hop configuration, you must perform some additional setup procedures on the servers.

If Integrated Windows Authentication (IWA) is required for logging in to the Web Portal in a double hop configuration, perform the following steps.

1. On the SmartPlant Foundation application server:
   a. Set up HTTPS. For more information, see Set Up HTTPS (on page 83).
   b. Configure IWA. For more information, see Set Up Integrated Windows Authentication (on page 80).
2. On the Web Portal server, configure one of the following authentication methods:
   - Basic authentication (passwords are sent in clear text)
   - Negotiate (Kerberos) authentication

   The following subsections describe the process for setting up each method.

### Set Up Basic Authentication for a Double Hop Web Portal Configuration

2. Configure the Web Portal's virtual directory to enable Basic Authentication as its authentication method.

   **TIP** This setting can be configured in SharePoint or in IIS Manager if SharePoint is not running.
3. Edit the `web.config` file in the SPFWebPortal site directory (located under the SharePoint site or web server virtual directory) and perform the following:
   - Add the value `True` to the end of each server key entry.
     Example: `<add key="localhost_SiteName" value="localhost:SiteName:True" />`
   - Search for the string "Impersonate" and set the value of this key to `True`.
Configuring Web Portals

- Search for the string "requireSSL =" and set the value to True. You must also uncomment this line.

4. In IIS, open the Authentication feature for the web site.
5. Select Windows Authentication and click Providers.
6. Ensure that NTLM is set as the top provider in the list.


Set Up Kerberos Authentication for a Double Hop Web Portal Configuration

When you use Kerberos authentication, you can either run the Web Portal on a secure server (and use HTTPS) or use only IWA.

1. Configure the SharePoint site (or web server, if not running SharePoint) for delegation in Active Directory.

   a. Open Active Directory Users and Computers and expand the Computers tree node.
   b. Right-click the server in the tree list and select Properties.
   c. Click the Delegation tab and select Trust this computer for delegation to any service (Kerberos only).
   d. Click OK.

2. Set up HTTPS on the Web Portal server, if you prefer this extra level of security. See Set Up HTTPS (on page 83).

3. Configure the Web Portal's virtual directory to enable Basic Authentication as its authentication method.

   This setting can be configured in SharePoint or in IIS Manager if SharePoint is not running.
4. Edit the `web.config` file in the SPFWebPortal site directory (located under the SharePoint site or web server virtual directory) and perform the following:
   - Add the value `True` to the end of each server key entry.
     
     Example: `<add key="localhost_SiteName" value="localhost:SiteName:True" /></add>`
   - Search for the string "Impersonate" and set the value of this key to `True`.
   - Search for the string "requireSSL =" and set the value to `True`. You must also uncomment this line.

5. In IIS, open the **Authentication** feature for the web site.

6. Select **Windows Authentication** and click **Providers**.

7. Ensure that **Negotiate** is set as the top provider in the list.

![Providers](image)


**Move a Web Portal onto a New Server**

**NOTE** Follow this procedure to move a Web Portal server instance from one server to another server.

1. Make a backup copy of the existing Web Portal on the original server.

   **NOTE** This folder is identified in the Server Manager properties for the Web Portal as the **Web Portal Path**. For example, by default, Web Portal files are installed in `[drive]\SmartPlant Foundation 2014 Server Files\WebPortals\[WebPortal_server_name]`.

2. Create a new Web Portal Server on the new server using SmartPlant Foundation Server Manager. See **Create a New Web Portal** (on page 145).

**IMPORTANT** The new Web Portal server must be created using the same version of SmartPlant Foundation as the original Web Portal.
3. Copy the contents of the original Web Portal server from the original server to the new location on the new server.
   
   **NOTE** This folder is identified in the Server Manager properties for the Web Portal as the **Web Portal Path**. For example, by default, Web Portal files are installed in \[drive]\SmartPlant Foundation 2014 Server Files\WebPortals\[WebPortal_server_name].
4. On the new server, in Server Manager, select the new Web Portal server and create a new connection to the SmartPlant Foundation application server.

**Using the Web Portal with Microsoft Internet Explorer 8 or 9**

The Web Portal is not compatible with Internet Explorer 8 or 9 Standards mode. The Web Portal only supports Internet Explorer 8 or 9 running in Internet Explorer 7 (IE7) Standards mode. If you are using Internet Explorer 8 or 9, perform one of the following procedures to ensure that the Web Portal displays correctly.

**Add a Custom HTTP Header on the Web Portal Server**

1. Launch the **IIS Manager**.
2. Select the Web Portal site in the tree view.
3. Double-click **HTTP Response Headers** in the IIS section.
4. Click Add in the Actions section.
5. Type **X-UA-Compatible** in the Name box, and type IE=EmulateIE7 in the Value box.
6. Click OK.
7. Reset IIS.

**TIP** You can also edit the Web Portal file directly (either default.aspx or defaultall.aspx) and add the meta tag at the top of the <Head> section:

```
<meta http-equiv="X-UA-Compatible" content="IE=EmulateIE7" />
```
Add a Server to the Compatibility View Settings in Internet Explorer 8 or 9

To ensure that all Web Portal sites on a server display correctly with Internet Explorer 8 or 9, you can add individual servers to your compatibility view settings in Internet Explorer on each client.

**IMPORTANT** If your administrator has added the custom header described in *Add a Custom HTTP Header on the Web Portal Server* (on page 151), it is not necessary to change the Compatibility View settings on individual client machines.

1. On the client workstation, open Internet Explorer 8 or 9, and click **Tools > Compatibility View Settings**.
   
   The **Compatibility View Settings** dialog box appears.

   ![Compatibility View Settings](image)

   - **Add this website:**
     - Type the name of the server to add in the **Add this website** box.
     - Click **Add** to add the server to the **Websites you've added to Compatibility View** list.

   - **Websites you've added to Compatibility View:**
     - Server

   - **Options:**
     - Include updated website lists from Microsoft
     - Display intranet sites in Compatibility View
     - Display all websites in Compatibility View

2. Type the name of the server to add in the **Add this website** box.
3. Click **Add** to add the server to the **Websites you've added to Compatibility View** list.
   
   **NOTE** All Web Portal sites on the server added to this list are displayed in compatibility mode.

4. Click **Close**.
   
   **TIP** To ensure that Web Portal sites viewed directly on the Web Portal server display correctly, add **localhost** to the compatibility view list for the instance of Internet Explorer 8 or 9 installed on the Web Portal server.
SECTION 10

Setting Up Client Workstations

A client workstation can be set up for user access to data the SmartPlant Foundation application server. The workstation can also be set up as an administrative client to maintain and configure SmartPlant Foundation. Both uses require SmartPlant Foundation Desktop Client. The security settings of the logged-in user determine the type of work the user can do in SmartPlant Foundation Desktop Client.

Also, if you are implementing SmartPlant Foundation Web Portals, users can work from any workstation with an Internet browser that can access the Web Portal site.

IMPORTANT If the client workstation is being used in an integrated environment, the SmartPlant Client and authoring tool software must be installed on the workstation. For information on installing these components and other important integration configuration details, refer to the Integration Setup Guide.

NOTE You can also run the Desktop Client remotely with no local installation using Citrix®. For more information about running SmartPlant Foundation using Citrix, see Appendix C: Configuring Citrix® for SmartPlant Foundation (on page 175).

Install Prerequisite Software on the Client Workstations

SmartPlant Foundation Desktop Client

If you want to use the SmartPlant Foundation Desktop Client on a workstation, make sure the following prerequisite software is installed:

- Microsoft Data Access Components (MDAC) (installed with your operating system)
- Internet Explorer
- Microsoft XML (MSXML) (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)
- Microsoft .NET Framework (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)

NOTES

- The software checks for these prerequisites during installation.
- For a listing of specific versions of pre-requisite software required by Intergraph, refer to the hardware and software recommendations for SmartPlant Foundation Workstation (on page 29).

Web Browser Connection to a SmartPlant Web Portal

To allow users to connect via Web browser to a SmartPlant Foundation Web Portal, no local SmartPlant Foundation software is required on the client workstation. However, make sure the following prerequisite software is installed:

- Internet Explorer
Setting Up Client Workstations

- Microsoft XML (MSXML) (available during Setup from the Prerequisite Software link in the SmartPlant Foundation Installation window)

**NOTES**

- If a workstation will be used only to connect to a SmartPlant Foundation Web Portal via a Web browser, you do not need to perform any other installations on the client workstation.
- The Web Portal is not compatible with Internet Explorer 8 or 9 Standards mode. To connect to a Web Portal with Internet Explorer 8 or 9, you must use Internet Explorer 8 or 9's Compatibility View functionality. See Add a Server to the Compatibility View Settings in Internet Explorer 8 or 9 (on page 152) for more information.
- To connect to a SmartPlant Foundation Web Portal, enter the server name and Web Portal virtual directory name in the Address line of the Web Browser, using the form http[s]://<spf_server_name>/<web_portal_name> (ex.: http://SPFServer/SPFWebPortal).
- For more information on using a SmartPlant Foundation Web Portal, refer to the SmartPlant Foundation Web Portal User's Guide.

**See Also**
Install the Desktop Client (on page 155)
Setting Up Client Workstations (on page 153)

**Permissions for Users on a Windows 7 Client with UAC Enabled**

For a Windows 7 client workstation with UAC turned on, if a user wants to use the SmartPlant Foundation Loader, additional permissions need to be set on the client.

The **Users** group on the client workstation must have the following permissions:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;:\Program Files\SmartPlant</td>
<td>READ, EXECUTE, LIST, WRITE</td>
</tr>
<tr>
<td>This folder, subfolder, and files</td>
<td>WRITE</td>
</tr>
</tbody>
</table>

**Install Schema Component.NET**

The Schema Component.NET software installs the Schema Editor, which is required for editing the SmartPlant Foundation data model.

**NOTE** You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see Installing the Software in Silent Mode (on page 44).

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click setup.exe on the CD.
2. Click SmartPlant Software in the SmartPlant Foundation Installation window.
3. Click SmartPlant Schema Component.NET Installation.

**TIPS**

- If you have previously installed Schema Component.NET, the software prompts you to remove the older version of the Schema Component.NET before installing the new version. After you uninstall the older version, click Schema Component.NET Installation again in the SmartPlant Foundation Installation window.
- The installation process checks whether Microsoft Excel is installed on the server. If Excel is not installed, the Schema Component.NET installation will display a message
box stating that Excel is required. Click No to dismiss the message box and continue the Schema Component.NET installation.

4. Click Next in the Welcome to SmartPlant Schema Component.NET Setup and Select Optional Features dialog boxes.

   **TIP** The Schema Editor, which allows you to view and edit the SmartPlant schema, tool schemas, and authoring tool mapping, is installed with the Schema Component.NET by default.

5. In the Select Program Folder dialog box, select an installation location and click Next.

6. Click Finish.

   **NOTE** In order to uninstall Schema Component.NET when it is installed on the same machine as SmartPlant Foundation, you must always uninstall SmartPlant Foundation before uninstalling Schema Component.NET.

---

**Install the Desktop Client**

If you want to use the Desktop Client on your client computer, you must install the Desktop Client software. Before you install SmartPlant Foundation, be sure that you know the Web server host name.

   **NOTE** You can install the software in silent mode, which requires no user interaction as the software installs. For more information, see Installing the Desktop Client in Silent Mode (on page 156).

1. Insert the SmartPlant Foundation CD into the CD-ROM drive. If the installation does not start automatically, double-click setup.exe on the CD.

   **NOTE** On a workstation running Windows 7, if you are not logged in with administrative rights, before launching the Setup, you may need to right-click the setup.exe icon and select Run as Administrator.

2. Click SmartPlant Foundation Installation in the SmartPlant Foundation Installation window.

3. Click Next.

   **TIP** At any time during installation, you can press F1 for context-sensitive Help.

4. Enter your User Name, Company Name, and Serial Number and click Next.

5. Verify the registration information, and then click Yes.

6. Select your country from the list, and click Display to view the license agreement.

   **IMPORTANT** The license agreement is delivered as a PDF file; consequently, you must have Acrobat Reader installed on your computer to view the license agreement.

7. Carefully read the licensing agreement. When you are finished, close the PDF file and click Yes to accept the terms.

8. To accept the default installation location for the software, click Next.

   **TIP** If you want to change the installation location, click Browse and navigate to the new folder. Then, click Next.

9. In the Setup Type dialog box, make sure that Client-Only is selected, and click Next. Client-Only is selected by default.

10. Type the name of the Web server, and click Next.

    **TIP** You can edit this value in Desktop_Client.exe.config and SPFDDataLoader.exe.config in the SmartPlant Desktop Client program installation folder (for example, C:\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion).
Setting Up Client Workstations

11. Type the name of the virtual Web directory that maps to the physical folder that contains the client.asp pages, and click **Next**. By default, the name of this folder is SPFServer, but the name may be different, depending on your configuration.
   
   **TIP** You can edit this value in Desktop_Client.exe.config and SPFDataLoader.exe.config in the SmartPlant Desktop Client program installation folder (for example, C:\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion).

12. Select the program folder where you want SmartPlant Foundation to appear on your **Start** menu, and click **Next**.

13. Verify the installation settings, and click **Next** to copy files to your computer.
   
   **TIP** If the settings are not correct, click **Back** to change the installation options.

14. Click **Finish**.

Installing the Desktop Client in Silent Mode

Silent mode installation is a two-stage process. First, you perform a normal installation by running the setup.exe file from the command line, using special parameters that cause the software to record the installation session and the options you choose in an .iss file. Then, you can run setup in silent mode on another computer, using the recorded .iss file to provide the necessary setup information.

See the silent installation procedure in *Install in Silent Mode* (on page 44).

**IMPORTANT**
- The environment of the computer on which you run the normal setup to create the .iss file and of the workstations on which you perform the silent mode installation must be identical; that is, they must have the same database platforms, software versions, installed files, and so forth. For example, if you create the .iss file and install the software on D drive, you must have a D drive on all the workstations.

Disabling the Business Intelligence Module

The SmartPlant Foundation Business Intelligence module is delivered and installed with SmartPlant Foundation Desktop Client version 2014. However, customers who do not want to see the Business Intelligence module in the SmartPlant Foundation Dashboard can disable the Business Intelligence module by removing the .dll file from the installation folder.

To disable the Business Intelligence Module:

1. Locate the Intergraph.SPF.Client.Modules.BI.dll in the modules folder at C:\Program Files (x86)\SmartPlant\Foundation\2014\SPFDesktopClient\CurrentVersion\Modules.
2. Remove the Intergraph.SPF.Client.Modules.BI.dll from the modules folder location.
3. Repeat step 2 for every SmartPlant Foundation Desktop Client installation, where the Business Intelligence module is not desired.

**IMPORTANT** Do not rename the Intergraph.SPF.Client.Modules.BI.dll as this will still allow the Business Intelligence module to display in the SmartPlant Foundation Dashboard. Remove it completely from the modules folder location.
Back Up the SmartPlant Foundation Server

The SmartPlant Foundation server should have a routine backup plan, with full system backups occurring at least once per week and incremental backups occurring daily. Special consideration should be given to continuous hardware backup, an uninterruptible power supply, RAID, and mirroring.

Ensuring data integrity on the SmartPlant Foundation server requires backing up several key components on the server:

- **SmartPlant Foundation Server Software** - The server operating system and the SmartPlant Foundation application software.
- **SmartPlant Foundation Configuration and Metadata** - The SmartPlant Foundation configuration data and metadata, which are stored in the SmartPlant Foundation data database schema.
- **SmartPlant Foundation File Data** - The SmartPlant Foundation files stored in the SmartPlant Foundation vaults.
- **SmartPlant Schema Files** - The delivered EFSchema.xml file and any customized versions of the schema file.
- **IIS Configuration** - Virtual directories, application pools, security settings, and so forth. Refer to your Windows documentation for details about backing up your IIS configuration.

The following sections provide recommendations for backing up each of these components.

**SmartPlant Foundation Server Software**

The SmartPlant Foundation server operating system and application software needs to be backed up only when the SmartPlant Foundation software changes, such as installation of a new version, a change to a custom application, or after a modification to a custom icon or custom report.

System image or snapshot software is recommended for the SmartPlant Foundation system backup. Examples of this type of software include ShadowProtect from ShadowStor, Live State Recovery and Ghost from Symantec, True Image from Acronis, and DiskXtender from Legato. These software packages take full system snapshots, which allow quick recovery after a system failure.
SmartPlant Foundation Configuration and Metadata

The SmartPlant Foundation configuration is stored in a relational database schema in Oracle or SQL Server. This data needs to be backed up only when a change occurs in the database, such as a change in access permissions or the addition of a new user or role. The SmartPlant Foundation metadata, also known as the data database, changes with every SmartPlant Foundation transaction, so its backup is essential for the protection and recovery of a SmartPlant Foundation installation. Because SmartPlant Foundation uses metadata to access file data in the software itself, the metadata (data database) backups and file data (SmartPlant Foundation vault) backups must be synchronized to avoid mismatches between the two forms of data.

SmartPlant Foundation File Data

SmartPlant Foundation files are stored in disk areas logically grouped into vaults, as specified in the SmartPlant Foundation configuration. SmartPlant Foundation file storage vaults should be located on fault tolerant, redundant storage devices, such as RAID arrays. Every file transaction causes changes to the relevant vault, so frequent backups are recommended to prevent data loss from a system failure. Because SmartPlant Foundation uses metadata to access file data in the Foundation software itself, the metadata (data database) backups and file data (SmartPlant Foundation vault) backups must be synchronized to avoid mismatches between the two forms of data.

SmartPlant Schema Files

Back up the delivered EFSchema.cmf file and any customized versions of the schema file. The SmartPlant schema file is delivered by default to \Program Files\Common Files\Intergraph\EFSchema. Customized SmartPlant schema files should be stored in your site folders (for example, \SmartPlant Foundation 2014 Server Files\Web_Sites\<site_name>\EFSchema).

Templates

Make backups of any templates stored in the \Program Files\SmartPlant\Foundation\2014 folder (for example, Excel templates, report templates, or data sheet templates).

IIS Configuration

Refer to your Windows documentation for details about backing up your IIS configuration.

Data Protection and Recovery for Installations Using Oracle

This section provides recommendations for protecting and recovering data for SmartPlant Foundation installations using Oracle databases.

Oracle provides the following tools for backing up data stored in an Oracle database.

- **RMAN** - A utility that reduces the administrative work associated with a backup strategy that uses backup and archive logs.
- **Oracle Data Pump** - A utility that exports Oracle data in a proprietary format that can subsequently be imported back into the database.
- **Oracle Import/Export** - A utility that exports Oracle data in a proprietary format that can subsequently be imported back into the database.

We recommend that you enable Oracle Archive Logging for all SmartPlant Foundation schemas. In addition, redo logs record all changes made to the Oracle database. When applied to an older
copy of an Oracle database, these logs can bring the database up to date, up to the last transaction before the point at which the system failed.

For more information on these tools, please refer to the *Backup and Recovery Concepts Guide*, available from Oracle, and other appropriate documentation for the Oracle version you are using.

**IMPORTANT** When performing a backup, make sure the versions of the database client and server match. For example, for an Oracle 10gR2 server, use a 10gR2 client. For an Oracle 11gR2 server, use an 11gR2 client. If the matching client version is not currently installed on your application server, you can perform the backup directly on that server.

Third Party Oracle Backup Utilities

Many popular backup software suites have add-on utilities that are designed to interface with Oracle databases. These suites can be used to back up and restore all four components of the SmartPlant Foundation system (system, configuration, metadata, and file data). These suites include:

- Veritas Backup Exec
- Computer Associates Brightstor ARCserver
- Legato Networker

Data Protection and Recovery for Installations Using SQL Server

This section provides recommendations for protecting and recovering data for SmartPlant Foundation installations using SQL Server databases.

SQL Server provides an integrated backup toolkit. Please refer to the SQL Server documentation for detailed information on creating a backup scenario for your database. We recommend that you enable the SQL Server Full Recovery Model for all SmartPlant Foundation schemas. In addition, transaction logs record all changes made to the SQL Server database. When applied to an older copy of a SQL Server database, these logs can bring the database up to date, up to the last transaction before the point at which the system failed.

Third Party SQL Server Backup Utilities

Many popular backup software suites have add-on utilities that are designed to interface with SQL Server databases. These suites can be used to back up and restore all four components of the SmartPlant Foundation system (system, configuration, metadata, and file data). These suites include:

- Veritas Backup Exec
- Computer Associates Brightstor ARCserver
- Legato Networker
Performing a Cold Database Backup on the SmartPlant Foundation Server

Database backups are sometimes described as "hot" or "cold." Hot backups are performed while the database is online, while cold backups are performed when the database is offline. Refer to your database documentation for more information on hot and cold backups.

When performing a cold database backup of the application server, if possible, stop IIS before running the backup, and then restart when the backup is complete. If stopping IIS is not possible, stop the three virtual directories: <SPF_Site_Name>, <SPF_Site_NameFile>, and <SPF_Site_NameFTR>.

Restore SmartPlant Foundation Databases Using Oracle

If you have your Oracle backups set up to work correctly, then you should be able to recover the data in your databases using the Oracle redo logs. In the event of a database failure, Oracle can redo all changes and take the database data back to the state it was when the last redo record was written.

If your Oracle redo logs are corrupt, however, use the following procedures to restore a SmartPlant Foundation database from a previous backup.

Make sure that all users are logged out of SmartPlant Foundation and the SmartPlant Foundation Common UI.

On the SmartPlant Foundation Server:
- Stop the SmartPlant Foundation Scheduler.

On the SmartPlant Foundation Oracle Server:
1. Stop and restart the Oracle<SID> service to disconnect all connected users.
   - IMPORTANT: Contact your DBA to disconnect and kill any sessions before restarting the instance.
2. Open an MS-DOS window.
3. At the DOS prompt, execute the svrmgrl.exe command from within your backup folder.
4. At the Server Manager prompt, type the following command:
   sqlplus system/system@ORAinstance
5. At the SQL Plus prompt, type the following:
   drop user #DATA_USER# cascade;
   grant connect to #DATA_USER# identified by #DATA_PWD#;
   grant resource to #DATA_USER#;
   alter user #DATA_USER# quota unlimited on #DATA_TS#;
   alter user #DATA_USER# default tablespace #DATA_TS#;
   alter user #DATA_USER# temporary tablespace #DATA_TEMP_TS#;
   grant dba to #DATA_USER#;
   grant unlimited tablespace to #DATA_USER# with admin option;
   exit
6. At the DOS prompt, type the following commands:

```bash
imp #USER_ID#/#USER_PWD#@#DATASOURCE# fromuser=#FROM_USER#
touser=#TO_USER# full=n file='#DUMP_FILE#' log='#DUMP_LOG#' commit=y;
exit
```

**NOTE** Examine the scripts and batch files in drive:\Program
Files\SmartPlant\Foundation\2014\ServerManager\DatabaseScripts for more detailed
information on the object created by Server Manager.

**On the SmartPlant Foundation Server:**
1. If you are restoring to a new location, use the Server Manager application to point to the
new paths.
2. Reconfigure IIS, including your application pools. See the Windows documentation for
details about reconfiguring IIS.
3. Restore vault and schema files.

### Restore SmartPlant Foundation Databases Using SQL Server

1. Locate the backup file on the database server and copy it to the server that will host the new
database.
2. Launch SQL Server Management Studio.
3. In a Query window, execute the following command, substituting your actual back file name
and location if it differs with what is shown below.

```sql
USE [master]
go
restore filelistonly from disk='d:\temp\SPFbackup.bak'
```

4. In a Query Window execute the following command to restore the backup to a new
database.

```sql
USE [master]
go
RESTORE DATABASE [#DATA_DB#] from disk=N'#DUMP_FILE#' WITH
    MOVE '#FROM_USER#' TO '#MDF_PATH#',
    MOVE '#FROM_USER#_Log' TO '#LDF_PATH#',
    REPLACE
GO
use #DATA_DB#
go
sp_changedbowner #USER_ID#
go
```

**NOTE** If you have problems getting the required exclusive access to the database required for
the restore, stop the application pools. Once the restore is complete, look in Enterprise Manager
to ensure the database, tables, and so on appear to have been restored correctly.
For the latest support information for this product, use a World Wide Web browser to connect to http://support.intergraph.com (http://support.intergraph.com).
Send documentation comments or suggestions to PPMdoc@intergraph.com (mailto:PPOdoc@ingr.com?subject=Documentation Comments).
Organizations may choose to have no installation on the client and run the SmartPlant Foundation client software from a central server. There are many advantages to running the application this way, including no deployment issues, no initial install, and access control. You can run the Desktop Client from a central server using a network share or using a URL. See the following topics for more information:

- Running Desktop Client from a UNC Share (on page 165)
- Running Desktop Client from a URL (on page 166)

**IMPORTANT** In both cases, the clients still need to have the .NET Framework runtime installed, the client needs to trust the application server containing the client software, and you must give full trust to the server hosting the client using the .NET Framework Code Access Security Policy (Caspol) tool. See Increasing Trust for Deploying the Desktop Client (on page 167) for more information.

### Running Desktop Client from a UNC Share

Running the Desktop Client from a share requires that the client assemblies, help, and icons exist in the server share.

1. Create the new directory to be shared (for example: `SPFDesktopClientRemote`).
2. Copy the following contents into the new shared folder on the host computer with Desktop Client installed.
   - Copy all files and subfolders in the `\Program Files\SmartPlant\Foundation\2014\SPFDesktopClient` folder.
   - Copy the `\Program Files\SmartPlant\Foundation\2014\Icons` folder.
   - Copy the `\Program Files\SmartPlant\Foundation\2014\BitmapsMisc` folder.
3. Right-click the `SPFDesktopClientRemote` share and select **Sharing and Security**.
4. Click the **Security** tab, and give **Read** permission to the users who will access the share.
5. Click the **Sharing** tab, click **Share this folder**, and then click **Permissions**.
6. On the **Share Permissions** tab, give Everyone **Read** access to the share.

**NOTES**

- The copied and shared directory structure should have no less than what is shown below:

![Directory Structure Diagram]

- The **CurrentVersion** folder contains the client assemblies, so the path to the executable would be similar to this:

  ```bash
  \<SPFServer\><SPFDesktopClientShare>\CurrentVersion\Desktop_Client.exe
  ```

  where `<SPFDesktopClientShare>` is the name of the share.

- For information about parameters for launching the Desktop Client, see *Desktop Client Command Line Parameters* (on page 169) in the *SmartPlant Foundation Installation and Setup Guide*.

## Running Desktop Client from a URL

The `SPFLaunch.exe` command allows users to run the Desktop Client from a URL. By default, this command can be accessed using the following syntax:

```bash
http://server_name/virtual_directory/DesktopClient/Apps/SPFLaunch.exe
```

**IMPORTANT**

- Before you can run the software using a URL, you must:
  - Have a valid client installation, either local or UNC install.
  - Start the Desktop Client manually to create the `settings.xml` file in the `C:\Documents and Settings\[YourUserName]\Application Data\SmartPlant\Foundation\[version]\` folder. Then, when you use the `SPFLaunch.exe` command, the `settings.xml` file is updated to include an entry for the local computer.
  - Set the **Execute Permissions** for the virtual directory to **Scripts only**.

**NOTE** For information about parameters for running the Desktop Client from a URL, see *Desktop Client Command Line Parameters* (on page 169).
Appendix A: Alternate Desktop Client Deployment

Increasing Trust for Deploying the Desktop Client

To run the SmartPlant Foundation Desktop Client using a UNC/Network path, server share, or URL, the client needs to trust the application server containing the client software. Microsoft .NET 2.0 includes the Code Access Security Policy (Caspol.exe) command line tool for modifying .NET trust. Run this tool on each client to increase its level of trust. The command examples below include one example for more restrictive security and one example for less restrictive security. There is also a sample syntax that works on Windows 7.

**IMPORTANT** On a 64-bit system, Caspol.exe must be run twice, from both the 32-bit and 64-bit .NET folders.

For additional Caspol command options, refer to the MSDN Library and search for Code Access Security Policy Tool.

Increase Trust for a Specific UNC Path

The example command below increases trust for a specific Desktop Client UNC path:

```
[SystemDir]\Microsoft.NET\Framework\[version]\caspol.exe -m -ag LocalIntranet_Zone -url file://servername/sharename/* FullTrust
```

On a 64-bit system, run the command again from the 64-bit .NET folder:

```
[SystemDir]\Microsoft.NET\Framework64\[version]\caspol.exe -m -ag LocalIntranet_Zone -url file://servername/sharename/* FullTrust
```

Increase Trust for the Local Intranet

The example command below increases trust for any computer on the local intranet:

```
[SystemDir]\Microsoft.NET\Framework\[version]\Caspol.exe -cg LocalIntranet_Zone FullTrust
```

On a 64-bit system, run the command again from the 64-bit .NET folder:

```
[SystemDir]\Microsoft.NET\Framework64\[version]\Caspol.exe -cg LocalIntranet_Zone FullTrust
```

Increase Trust on a Windows 7 Workstation

For a Windows 7 workstation, use the Caspol command syntax as shown in the following example:

```
[SystemDir]\Microsoft.NET\Framework\[version]\Caspol.exe -machine -addgroup 1 -site <ServerName> FullTrust
```

On a 64-bit system, run the command again from the 64-bit .NET folder:

```
[SystemDir]\Microsoft.NET\Framework64\[version]\Caspol.exe -machine -addgroup 1 -site <ServerName> FullTrust
```

**NOTE** In the examples, [version] is v2.0.xxxx.
Appendix B: Desktop Client and Web Portal Launch Parameters

The SmartPlant Foundation Desktop Client supports a set of parameters that can be used when launching the application from the command line or URL. When you run the Desktop Client from a URL, the URL points to SPFLaunch.exe on the server. SPFLaunch.exe parses the URL and converts it to a format that will invoke the Desktop Client from the command line. The URL format for the parameters is slightly different from that for the command line.

The SmartPlant Foundation Web Portal also supports a set of parameters that can be used when it is launched from a URL. The following sections explain the parameters that can be used when launching these applications.

Desktop Client Command Line Parameters

Command line parameters are typically used when launching the Desktop Client from another application or via a URL. They allow you to control who the user logs in as and what plant/project access they have. The command line parameters can also be used to log in to the Desktop Client, find an item, such as a tag, and perform an action on that tag, for example display a detail form.

Parameter Formatting

- When launching the Desktop Client from the command line, all parameters that begin with a slash ( / ) are uppercase and require a space between the parameter and the value. If the value contains spaces, it must be enclosed inside double quotation marks (" "), as shown in the following example.
- When launching the Desktop Client using a URL, the command line parameters must be specified in a URL format. In this case, the first parameter must be separated from the SPFLaunch.exe command with a question mark ( ? ), and subsequent parameters must be separated by an ampersand ( & ). Spaces in the URL format are denoted by a tilde (~). Forward slashes (/) must be replaced with %5C. You might use forward slashes in the path to the log file, for example.
Appendix B: Desktop Client and Web Portal Launch Parameters

Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>User name</td>
</tr>
<tr>
<td>P</td>
<td>Password</td>
</tr>
<tr>
<td>PLANT</td>
<td>Plant name</td>
</tr>
<tr>
<td>PROJECT</td>
<td>Project name</td>
</tr>
<tr>
<td>H</td>
<td>Host</td>
</tr>
<tr>
<td>S</td>
<td>Server name (as defined in the logon dialog box)</td>
</tr>
<tr>
<td>W</td>
<td>Web directory</td>
</tr>
<tr>
<td>CURRDIR</td>
<td>Current directory</td>
</tr>
<tr>
<td>SECURE</td>
<td>True/False: if logging on to server using SSL</td>
</tr>
<tr>
<td>DEBUGLOG</td>
<td>Path and file name for a debug file. This parameter is only valid for URLs.</td>
</tr>
</tbody>
</table>

The following details logon parameter behavior, depending on what you specify in the command line or URL. The following are provided in command line format. They can also be used in the URL format.

/U /P /PLANT /PROJECT /S
Logs you in as the user specified with the plant/project specified on the given server if the server is not authenticated. The user and password are ignored if the server is authenticated. If the server is authenticated, the Logon dialog box appears with the User name and Password boxes disabled, and the Server list to select the correct server.

/U /P /PLANT /PROJECT /H /W
Same as the previous example, but uses the host and web directory instead of the server.

/U /P /PLANT /PROJECT
A Logon dialog box appears with the User name and Password boxes populated.

/S /PLANT /PROJECT
If the server is authenticated, this command logs you on to the Desktop Client. Otherwise, the Logon dialog box appears with the Server list disabled, but displays the specified server.

If the server specified is not defined, a message box appears to inform the user, and the logon process stops.

/H /W /PLANT /PROJECT
Same as the previous example except that if the specified Web host and Web directory have not been defined, a new server is created from these. If the new server is authenticated, this logs you on. Otherwise, the Logon dialog box appears with the Server list disabled, but displays the specified server.

/PLANT /PROJECT
Displays the Logon dialog box, but once you select a server and log on, the specified Plant and Project is honored.

NOTES
- If you do not specify any command line parameters, the Logon dialog box appears.
- If you select an authenticated server from the list, the User name and Password boxes are disabled. They are enabled if you select a server that is not authenticated.
Appendix B: Desktop Client and Web Portal Launch Parameters

- If a server is not responding, a message box appears to tell the user, and the OK button is disabled. The OK button is enabled if you select another server that is responding.

- When using the /SECURE switch, you may need to adjust the timeout setting in your web.config file to keep the login attempt from timing out while the secure login is processing. If this occurs, add or edit the following key in the web.config file with the following value:

  `<add key="IsResponding.Timeout" value="600" />

- The logon parameters are case-sensitive.

**Examples**

Desktop_Client.exe /U abc /P /S SPF42
Desktop_Client.exe /U abc /P /PLANT Plant1 /PROJECT Project1 /S SPF42


### API Parameters

At logon, it is possible to launch any of the APIs available. APIs are divided into those that require an object and those that do not.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>API name</td>
<td>The name of the API to be called. This object is case sensitive.</td>
</tr>
<tr>
<td>SINSTANCE</td>
<td>True or False</td>
<td>Specifies whether to use a single instance or multiple instances of Desktop Client.</td>
</tr>
<tr>
<td>ARG1</td>
<td>First argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG2</td>
<td>Second argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG3</td>
<td>Third argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG4</td>
<td>Fourth argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG5</td>
<td>Fifth argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG6</td>
<td>Sixth argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG7</td>
<td>Seventh argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>ARG8</td>
<td>Eighth argument</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>CRITERIA</td>
<td>Search criteria</td>
<td>Specifies the search criteria for queries.</td>
</tr>
</tbody>
</table>

To launch an API from the command line, you need the /API parameter. The arguments are optional and depend on the API being used. To launch an API from a URL, use the API= syntax followed by the name of the API and any parameters for that API. For example, API=QFindObject&ARG1=Change&ARG4=*

To launch an API on an object, the following parameters are mandatory.

CLASS classname
NAME name of item

The CRITERIA argument is optional.

**Examples**

Desktop_Client.exe /PLANT Plant1 /PROJECT ProjectA /API Navigate /ARG1 FRAME /CLASS DocRevision /Name DOC-ACCREP-003
Appendix B: Desktop Client and Web Portal Launch Parameters

Desktop_Client.exe /U abc /P dFs9921j /PLANT Plant1 /PROJECT ProjectA /S /API
ViewAndMarkup /ARG1 FRAME /CLASS DocRevision /Name DOC-ACCREP-003
Desktop_Client.exe /PLANT Plant1 /PROJECT ProjectA /API Navigate /ARG1 FRAME /CLASS
DocRevision /Name DOC-ACCREP-003
Desktop_Client.exe /API CMClientEditObj /ARG2 "List of Work" (Inbox)
Desktop_Client.exe /API QFindObject /ARG1 DocRevision /ARG2 False /CRITERIA * (General
find)
tEditObj&ARG2="Inbox"
antName&H=server&DEBUGLOG=C:\temp\spflaunch.log&W=SPFServer&API=QFindObject&ARG1=ISPFWorkflowItem&CRITERIA=folder%20with%20spaces
Appendix B: Desktop Client and Web Portal Launch Parameters

Web Portal URL Parameters

You can launch the Web Portal from a URL and execute one or more APIs. There are several optional parameters that you can add to the login URL. These parameters should be separated with an ampersand (&). Spaces in the URL format are denoted by a percent symbol followed by 20 (%20).

<table>
<thead>
<tr>
<th>URL Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user or u</td>
<td>User name</td>
</tr>
<tr>
<td>password or p</td>
<td>User password</td>
</tr>
<tr>
<td>plant</td>
<td>Plant name</td>
</tr>
<tr>
<td>project</td>
<td>Project name</td>
</tr>
<tr>
<td>configuid</td>
<td>UID of the configuration</td>
</tr>
<tr>
<td>roles</td>
<td>Role name</td>
</tr>
<tr>
<td>server or s</td>
<td>Server name (as defined in the Login option)</td>
</tr>
<tr>
<td>host or h</td>
<td>Host name</td>
</tr>
<tr>
<td>webdir or w</td>
<td>Web directory</td>
</tr>
<tr>
<td>secure</td>
<td>&quot;True&quot; or &quot;False&quot; to indicate if &quot;https&quot; is used</td>
</tr>
<tr>
<td>task</td>
<td>Name of the customized task to start. The task may also require additional input parameters.</td>
</tr>
<tr>
<td>DisableAutoLogin</td>
<td>If the value of this parameter is true, then auto-login is disabled. If this value of this parameter is false, then auto-login is enabled. This parameter overrides the DisableAutoLogin setting in the SmartPlant Foundation server web.config file.</td>
</tr>
</tbody>
</table>

Launching Web Portal using a URL uses parameters including a single character (u) or the full name (user). The following are valid parameters: user or u, password or p, server or s, host or h, and webdir or w. For example:

http://nodename/directory/Default.asp?user=jqpublic&password=MyPassword&class=userinbox or

When both user and u are used in URL parameters, the full-named parameter will be used. For example, if the following is provided by the user,

the URL will become,

To launch the API, you need the &api parameter. The arguments are optional and depend on the API being used.
Appendix B: Desktop Client and Web Portal Launch Parameters

To launch the API of an object, the following class and name parameters are mandatory.

<table>
<thead>
<tr>
<th>API Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>api</td>
<td>The name of the API to be called. This object is case-sensitive.</td>
</tr>
<tr>
<td>class</td>
<td>Class name</td>
</tr>
<tr>
<td>name</td>
<td>Name of the item.</td>
</tr>
<tr>
<td>uid</td>
<td>UID of the item (used instead of class and name)</td>
</tr>
<tr>
<td>arg1 - arg14</td>
<td>Depends on the API called.</td>
</tr>
<tr>
<td>criteria</td>
<td>Specifies the search criteria for queries.</td>
</tr>
</tbody>
</table>

In order to call an API, you must provide an API name and its required and proper arguments for that API (in order to run API from URL). Each API has its own arguments, and you can find the arguments for a client API by searching for that API.

The following is an example URL to call ViewAndNavigate which displays SmartPlant Markup Plus in the Web Portal.


This URL logs in to the SmartPlant Foundation Web Portal site url-demo with user name jdoe and password jdoepwd. Once logged in, a design document of 3D-CivilPlans_003 is located (including an attached file). Then, SmartPlant Markup Plus displays in the Web Portal as a frame. If there are any redline objects in the file, they also display.

Example URLs

The following URL launches the Web Portal and uses the Navigate API to open a specific version (revision 2A, version 2) of the specified document (SB101).


The following example URL launches the Web Portal and displays the details dialog box for the SPFPlant named PlantA.

http://SPFServer/SPFWebPortal/?&api=ShowObj&class=SPFPlant&name=PlantA

The example below opens the appropriate drawing using the value specified for ARG1, and highlights in the drawing the object specified by the CLASS and NAME arguments.


As shown in the following example, you must include the SECURE parameter, and set the value to true, if you are using a secure site (https).

https://spfsrv64a/spfwebportal/default.aspx?user=sbarakam&password=&secure=true&server=localhost_SPFsrv64aAUTH&api=QFindObject&arg1=ISPFDesignDocVersion&arg2=False&Criteria=*
SECTION 15

Appendix C: Configuring Citrix® for SmartPlant Foundation

The following section is useful for organizations that want to run SmartPlant Foundation remotely using Citrix®.

**IMPORTANT**
- When you access applications via Citrix, we strongly recommend that you do not perform any administration activities that run automatically for a long time on a client machine. When you run administration activities via Citrix client, the software actually performs these activities on the server side, while the client remains idle, and the connection to Citrix becomes inactive. This disconnects the current session and can even cause applications to close on the server. A connection break off during such an activity can cause damage to your database.
- We suggest that you perform administrative activities either on your database server computer or on a client computer using a configuration other than Citrix.

System Requirements for Citrix Servers

**SmartPlant Foundation Prerequisites**
To run SmartPlant Foundation on a Citrix server, you must install the prerequisite software for SmartPlant Foundation on the Citrix server.

**Citrix Prerequisites**
See the Citrix documentation for system hardware and software requirements for the Citrix software.

**IMPORTANT** To install software on a Citrix server, you must log on to the computer as an administrator.

Install Citrix Software

Before you configure SmartPlant Foundation on the Citrix server, you must install and configure Citrix software on the server. See the Citrix documentation for more information.
Appendix C: Configuring Citrix® for SmartPlant Foundation

Install and Configure the Software for Citrix

To run the Desktop Client software using Citrix, you are not required to install any software on the Citrix server. Instead, you create a shared installation of the Desktop Client on another server. For more information about installing the Desktop Client, see Install the Desktop Client (on page 155).

Because the Desktop Client is a .NET application and requires no installation or registration on a computer for users to run it, you can create a shortcut to the shared installation on the desktop of the Citrix server. For more information about creating shortcuts to applications, see the Microsoft Windows Help.

Then, users can connect to the Citrix server and double-click the Desktop Client shortcut on the desktop to run the Desktop Client software. For more information about connecting to a Citrix server, see the Citrix documentation.
SECTION 16

Appendix D: Configuring IIS Application Pools and User Accounts Manually

When creating a new site using SmartPlant Foundation Server Manager, the New Site Server Wizard provides a **Create local operating system users for site application pools** option that creates local users on the operating system and sets them to run as the identity of the related application pool. If you do not select this option, you can create local users and create and configure application pools manually.

To prevent application processes from adversely affecting one another, you can deploy worker process isolation mode. By isolating one or more applications within the process boundaries of an application pool, you can increase the stability and security of your server. You can place a single application into its own application pool or group multiple applications into a shared application pool.

To configure SmartPlant Foundation to run independently of other applications, you must create a new user account and configure application pool identities. Running SmartPlant Foundation independently of other applications is intended to increase stability on Windows Server 2008. For SmartPlant Foundation to run securely, the SmartPlant Foundation server-side components need to be run using a controlled user, such as SPF_Server. Running the server-side components this way requires the creation of a user. If you are using Windows Server 2008, you must allocate that user to the IIS_IUSRS group. Then, an application pool from which worker applications are started must be created for the SmartPlant Foundation application using the identity of the controlled SmartPlant Foundation user you created.

You should also isolate the SPFRemoteServices and SPFFileService virtual directories in separate application pools, and create a controlled user to be identified with each application pool that runs these services.

Create a New User Account for Application Isolation

1. On the application server, create a new user account, such as SPF_SERVER, to be identified with an application pool.

   **IMPORTANT** On Windows Server 2008, to enable Windows Authentication, your SmartPlant Foundation application pool identity must be set to a domain user account, not a local user account, and this domain user account must be a member of the SPFUsers group on that server. If a local account is used, logging on will result in a 401(unauthorized access) error.
Appendix D: Configuring IIS Application Pools and User Accounts Manually

2. Add the new account to the IIS_WPG group.

The IIS_WPG group has Read and Execute, List Folder Contents, and Read permissions on every Web site directory by default. When this account is not in the IIS_WPG group and does not have the appropriate permissions, the worker process will fail to start.

3. Repeat this procedure for each new user account you have created.

Creating and Configuring Application Pools in Windows Server 2008

If you are using Windows Server 2008, use the following instructions to create and configure application pools.
Create a New Application Pool in Windows Server 2008

If you are using Windows Server 2008, follow the instructions below to create a new application pool.

1. On the application server, logged in as a user with administrative rights, open the Control Panel.
2. Open Administrative Tools > Internet Information Services.
3. In the Internet Information Services tool, expand the local computer, and click Application Pools.
4. In the Actions window, click Add Application Pool.
5. On the Add Application Pool dialog box, in the Name box, type the name of the new application pool.
6. In the .NET Framework version list, select the default version (.NET Framework v 2.0 .50727).
7. In the Managed pipeline mode list, select Integrated.
8. Click OK.

Configure an Application Pool Identity Using a Configurable Account in Windows Server 2008

If you are using Windows Server 2008, the default application pool is set to LocalService the first time you open Server Manager. To change the identity of the Default Application Pool from local service or to configure another application pool identity, follow the instructions below.

**IMPORTANT** On Windows Server 2008, to enable Windows Authentication, your SmartPlant Foundation application pool identity must be set to a domain user account, not a local user account, and this domain user account must be a member of the SPFUsers group on that server. If a local account is used, logging on will result in a 401(unauthorized access) error.

1. On the SmartPlant Foundation server, open the Control Panel.
2. Open Administrative Tools > Internet Information Services (IIS) Manager.
3. In the Internet Information Services (IIS) Manager, expand the local computer, and select Application Pools.
4. In the middle pane, select an application pool, such as DefaultAppPool.
5. In the Actions window, click Advanced Settings. You can also right-click the application pool and select Advanced Settings from the shortcut menu.
6. In the Process Model section, select Identity, and click the Properties button.
7. In the Application Pool Identity dialog box, select the Custom account option.
8. Click Set.
9. In the Set Credentials dialog box, type the account name in which you want your worker process to run in the User Name box. This account name should be in the IIS_IUSRS group.
10. In the Password box, type the password associated with this account. If there is no password associated with the account, leave the Password box blank.
11. Type the password again for confirmation, and click OK.
12. Click OK.
Assign the Software to an Application Pool in Windows 2008

If you are using Windows Server 2008, follow the instructions below to assign the software to an application pool.
1. On the application server, logged in as a user with administrative rights, open the Control Panel.
2. Open Administrative Tools > Internet Information Services.
3. In the Internet Information Services tool, expand the Sites node and navigate to your virtual directory.
4. In the Actions window, click Advanced Settings.
5. In the General section, click Application Pool, and click the Properties button.
6. In the Select Application Pool dialog box, select the name of the application pool to which you want to assign the Web site.
7. Click OK.
8. Repeat this procedure for each virtual directory that you want to assign to an application pool.

Permissions for users must also be set if manually assigning the software to an application pool.

Configuring COM+ Applications in Windows Server 2008

If you are using Windows Server 2008, each SmartPlant Foundation COM+ application is set to LocalService the first time you open Server Manager.

SmartPlant Foundation installs the following COM+ applications:
- SPFSchemaUpgradeComPlus
- SmartConverter42ComPlus
- TransformerComPlus
- FLEXLMComPlus (installed only if FLEXlm is used as the license server)

To configure the identity of the SmartPlant Foundation COM+ applications from local service to a configurable account, follow the instructions below.
2. In the Component Services tool, expand the local computer, and select COM+ applications.
3. Right-click a COM+ application, and select Properties from the shortcut menu to open the Properties dialog box.
4. Select the Identity tab on the Properties dialog box.
5. Select the option This user: to change the account preference.
   By default, the application runs under the Local Service setting using the System Account.
6. Type an account name the User box.
7. In the Password box, type the password associated with the account. If there is no password associated with the account, leave the Password box blank.
8. Type the password again for confirmation, and click OK.
9. Click OK.
10. Repeat steps 3-9 for each SmartPlant Foundation application.

### Configuring Folder Permissions in Windows Server 2008

The first time you open Server Manager, a permissions script runs, giving LocalService access to folders. Follow the instructions below to change folder permissions from LocalService to a configurable account.

1. Navigate to the folder you want to set permissions for.
   
   **NOTE** For more information, see Permissions for SmartPlant Foundation Processes (on page 86).

2. Right-click the folder and select **Properties** from the shortcut menu.

3. Select the **Security** tab on the Properties dialog box.

4. Click **Edit** to open the **Permissions** dialog box.

5. Remove LocalService, if desired.

6. Click **Add** to open the **Select Users, Computers, Service Accounts, or Groups** dialog box.

7. Type the name of a user.

8. Click **Check Names** to verify the name of the user.

9. Select a user name and click **OK**.

10. Click **OK**.

   **TIP** For more information about creating user accounts or adding users to groups, see the Microsoft Windows documentation.
Appendix E: Setting Up a FLEXlm License Server

Intergraph recommends installing FLEXlm License Manager on a remote server and sharing the License Manager installation folder.

After performing the procedures in this appendix for installing and configuring FLEXlm License Manager, you must also set up a SmartPlant Foundation License Server using SmartPlant Foundation Server Manager in order to allow SmartPlant Foundation to manage licenses. See Setting Up a SmartPlant Foundation License Server (on page 133) for more information.

For a FLEXlm licensing implementation, the FLEXlm server software must be installed on a 32-bit operating system. For a SmartPlant License Manager licensing implementation, the SmartPlant License Manager server software can be installed on a 32-bit or 64-bit operating system.

For further information on setting up either a FLEXlm or a SmartPlant License Manager server, see the SmartPlant Foundation Server Manager User's Guide.

Installing License Manager on a Remote Server

When you install FLEXlm License Manager on a remote server, the SmartPlant Foundation Server Manager component is also installed automatically. You can use SmartPlant Foundation Server Manager to edit the License Manager configuration when installation is complete.

1. Insert the SmartPlant Foundation CD into the CD-ROM drive on the new License server. If the installation does not start automatically, double-click setup.exe on the CD.
2. Click SmartPlant Foundation Installation in the SmartPlant Foundation Installation window.
   - If you are using SmartPlant Enterprise, do the following:
     a. Insert Disc 1 of the SmartPlant Enterprise DVD set.
     b. Click Information Management Software in the SmartPlant Enterprise Installation window.
3. Click Next to continue with the setup program.
4. Enter your User Name, Company Name, and Serial Number, and then click Next.
5. Review the registration information in the Registration Confirmation dialog box and click Yes to continue or No to change the information.
6. Read the license agreement, and click Yes to accept the terms.
   - You must have Adobe Reader to view the license agreement.
7. In the Choose Destination Location dialog box, click Browse to select an installation location.
   - Intergraph recommends that you do not install License Manager in the default SmartPlant Foundation location. You should install License Manager in a folder one level up, for example: c:\LicenseManager.
8. Click Next.
9. In the Setup Type dialog box, click Custom, then click Next.
Appendix E: Setting Up a FLEXlm License Server

10. In the **Select Features** dialog box, click **License Manager**, clear any other selected software, and then click **Next**.

11. Check the destination location (for example: c:\LicenseManager), and click **Next**.

12. Select the **Program Folder** where you want SmartPlant Foundation to appear on your **Start** menu, and click **Next**.

13. In the **Start Copying Files** dialog box, click **Next**.

14. Click **Finish** to complete the installation.

**NOTE** By default, the License Manager is installed as a Windows Service. You must start the Service manually after you receive and activate your token files. See *SmartPlant Foundation Licensing Guide*, available with the **Help > Printable Guides** command from within the product, for more information about configuring License Manager.

### Obtaining Your Host ID and Disk Serial Number

When you request your license files from Intergraph, you will need to specify the Host ID and/or Disk Serial Number of your computer.

- To obtain the **Host ID**, open a command prompt window and change directories to the LicenseManager directory. Type the following command:
  
  `lmutil lmhosid`

- If the server has multiple network cards, use the following command to obtain the **Disk Serial Number** for the appropriate drive:
  
  `lmutil lmhosid -vsn`

### Activating Licensing

The **SmartPlant Foundation License Manager** node in SmartPlant Foundation Server Manager is used to configure a SmartPlant Foundation license server to use either a FLEXlm license or a SmartPlant Foundation License Manager license.

#### FLEXlm Properties

- **Site Path** – Physical path to the SmartPlant Foundation license server files (physical location of the virtual directory).
- **Site Virtual Directory** – Name of the license server as defined in IIS
- **LicType** – Specifies that the license is a FLEXlm license type
- **File** - Location of the notification file the software sends to the system administrator. The notification file is a text file that you can customize with a message reminding your system administrator to order more tokens.
- **License** - Location of the token pool license file (tknpool.dat). If License Manager is installed on another server, enter the port number on the License Manager server, followed by @, and the name of the License Manager server computer (for example, 8575@SPFLicenseServer).
- **Log** - Location of License Manager log file (SPFtkn.rpt), which is parsed by the token report and the token recall utilities.
- **Output file** - Location of the local License Manager token output file (token_output.txt).
- **System administrator e-mail** - Address of the system administrator to whom e-mail notifications should be sent.
Appendix E: Setting Up a FLEXlm License Server

**Tokens** - Location of the daily token file (daily.dat). (This property applies to SmartPlant Foundation installations only.)

**IMPORTANT** SmartPlant Basic Integrator does not use a daily.dat file. For SmartPlant Basic Integrator installations, this value must remain blank for License Manager to work properly.

**Token 1** - Number of tokens available in the token pool when the software sends the first e-mail notification message to the system administrator.

**Token 2** - Number of tokens available in the token pool when the software sends the second, and final, e-mail notification message to the system administrator.

**TIP** Intergraph recommends that you set the value of tokens for the first reorder e-mail notification (Token 1) to the number of tokens you would use in 30 days and the value for the second, and final, notification (Token 2) to the number you would use in 2 weeks. These settings ensure that you have sufficient tokens available when you reorder. When daily tokens have been depleted, only users with perpetual tokens can access the software.

**IMPORTANT**
- Microsoft security patch #262701 prevents the SmartPlant Foundation e-mail notification feature from working properly because the patch blocks e-mail generated by a command line program. However, Microsoft Outlook Express settings can be edited to enable the e-mail notification feature. In Microsoft Outlook Express,
  - Click **Tools > Options > Security**.
  - Clear the **Warn me when other applications try to send e-mail as me** security feature.

For more information about licensing for SmartPlant Foundation, see *SmartPlant Foundation Licensing Guide* available from the **Help > Printable Guides** command in SmartPlant Foundation Server Manager.

**Activate the Token License File**

Intergraph will send you an e-mail message with your encrypted license files attached. You must use the SmartPlant Foundation License Manager utility in Server Manager to activate the token license files.

1. Save the attached license files from the e-mail message to your license server.

**NOTE** If the License Manager is running, open a command prompt, navigate to the License Manager installation directory, and stop the License Manager as shown in the following example:

```
>cd LicenseManager
>lmutil lmdown
```
2. In SmartPlant Foundation Server Manager, select the **SmartPlant Foundation License Manager** node.

3. Click **Edit > Activate License Files** to open the **Activate License Files** dialog box.

4. Type your SmartPlant Foundation serial number in the **Serial number** box.

   **TIP** The serial number is located on the SmartPlant Foundation CD.
5. Select the country in which you are licensing the software, and click Display to open the 
Software Licensing Agreement.
6. Carefully read the Software License Agreement. Once you have finished reviewing the 
document, if you agree to the terms provided, close the .pdf file, and click I accept.
7. Type the path to the license files in the Path box, or click Browse and navigate to the 
correct folder.
8. Click OK.
9. If you have purchased perpetual tokens, navigate to the License Manager installation 
directory, and open the perpet.dat file in Notepad.
10. Edit the perpet.dat file to have the same number of perpetual tokens as you ordered. (All 
tokens must have a login name assigned.)
11. From the same directory, open the tknpool.dat file in Notepad.

Sample License File for SmartPlant Foundation

SERVER host-name 0002a5e766a4 port-number
DAEMON Token token-daemon-path-including-name path-to-perpet.dat

NOTE If you did not purchase perpetual tokens for SmartPlant Foundation because you are 
using daily tokens only, the DAEMON line should contain only the Token path.
12. Change host-name to the name of the computer on which you will be running the License 
Manager.
13. Change port-number to the unique TCP port that you will be using.
14. Change token-daemon-path-including-name to point to:
\license manager installation directory\token.exe
15. If you have purchased perpetual tokens for SmartPlant Foundation, change 
path-to-perpet.dat to point to:
\license manager installation directory\perpet.dat

Sample License File with Edits (SmartPlant Foundation)

SERVER test23 d0002b795c2b2 8575
DAEMON Token c:\flexlm\Token.exe c:\flexlm\perpet.dat

NOTE If you are using daily tokens only, Intergraph recommends that you make the 
following changes in order for licensing to work properly:
 Make sure that the path to perpet.dat is removed (if present), for example:
   DAEMON Token c:\flexlm\Token.exe
 Remove or rename the sample perpet.dat file delivered with the software.
16. Restart the License Manager by running lmgrd.exe from the command line. See the 
SmartPlant Foundation Licensing Guide for more information.
Glossary

A

active scope
A configuration in which you may view, create, modify, and delete information in the SmartPlant Foundation client.

adapter
Authoring tool software that facilitates the sharing of data between the authoring tool and other integrated tools. Tool adapters generate XML files for publish operations and consume XML when tools retrieve documents. Adapters are also called SmartPlant adapters.

API
The Application Programming Interface.

as-built
The set of data that describes the existing conditions of a plant or site; the completed and approved state of a project.

attribute
An object characteristic.

authoring tools
Applications where documents are created and then shared through integration. Integrated authoring tools include Aspen Basic Engineering, SmartPlant P&ID, SmartPlant Electrical, SmartPlant Instrumentation, SmartPlant 3D, SmartPlant Materials, and SmartPlant Foundation.

B

batch printing
Printing files at a specified date and time from the SmartPlant Foundation client.
**brownfield**
An existing plant or site that is modified by one or more projects.

**C**

**cache**
Memory that stores recently-accessed data so that subsequent requests to access the same data can be processed quickly.

**cases**
Configurations for instruments that may include specific parameters, settings, or even components for use in a specific situation.

**change notification**
An e-mail message sent to a user when an action is performed on an object in SmartPlant Foundation.

**check out**
Allows you to make changes to an existing document in SmartPlant Foundation. Only the user who has checked out a document can save changes to it.

**checklist**
A series of items, tasks, or questions that the user finishes before completing a step in a workflow. Checklists can be optional or required.

**claim**
- To take responsibility for a step in a SmartPlant Foundation workflow.
- To identify the scope of a project by adding items to the project from a drawing or a 3-D model. When authoring tools are integrated, SmartPlant P&ID claims items that are shared among tools. Other authoring tools, such as SmartPlant Instrumentation and SmartPlant 3D, claim items that they create and modify that are not shared.

**client API**
A .dll (dynamic link library) that performs a particular function in SmartPlant Foundation. Client APIs are processed by a specific section of code in a component.
**common UI**

An ActiveX component (.dll) that provides a standard user interface for integration functionality, such as publish, retrieve, and register. The authoring tools display the common UI when the user clicks particular SmartPlant commands in the authoring tool.

**compare**

To view the differences between two revisions of the same document in SmartPlant Foundation.

**component**

A .dll (dynamic link library) that handles requests on the SmartPlant Foundation server. Components are also called business service layers (BSLs).

**component schema**

A subdivision of the complete SmartPlant schema that contains the set of class definitions that are used within a specific domain or application area.

**condition**

An object that can restrict access to a method, workflow, or relationship based on specified criteria.

**configuration tree**

A representation in a tree list, which may include plant, areas, units, and projects that indicates the structure in which the data is stored in SmartPlant Foundation.

**container**

An object used by the tool adapters and the SmartPlant software components to pass data back and forth between a tool and SmartPlant Foundation. A container may hold data or metadata related to the data model or actual instance data.

**contract**

A group of documents that are collected and issued for bid, construction, review, and so on.

**correlation**

The relationship between items that represent the same object in multiple authoring tools.
create scope
A configuration for data creation, modification, and termination in SmartPlant Foundation.

current document
A document that has been signed off. Current documents can be revised in SmartPlant Foundation, but not checked out or in.

cut-off date
Any date on which progress information is calculated. Official cut-off dates are scheduled in advance and are typically part of a reporting schedule. Unofficial cut-off dates are random dates when rollups are not scheduled but progress is calculated anyway.

D
data list
A list of plant items that can be modified outside SmartPlant Foundation. You can generate data lists to view and edit SmartPlant Foundation data in Microsoft Excel, and then save the data back into SmartPlant Foundation.

data sheet
A file that allows users to view, edit, and print object data in a customizable format.

data sheet template
An Excel file that defines the layout of a data sheet.

database
Collection of files of comprehensive information that have predefined structure and organization; a specific program can communicate, interpret, or process these files.

design basis
An item in an authoring tool that represents an item from an upstream application (an application used earlier in the lifecycle of the plant). Plant items placed with the authoring tool correspond to a particular design basis item.

Design basis items provide a means of determining if the plant items within the authoring tool are consistent with the items from the upstream application and help users maintain consistency as changes are made in all authoring tools.
**design file**
A file generated by a design tool, such as SmartPlant P&ID or Aspen Basic Engineering.

**digest**
See e-mail digest.

**display item**
Object used to present data or relationships on a form in SmartPlant Foundation.

**distribution matrix**
A list of people who will receive a transmittal created in SmartPlant Foundation and an indication of what is expected from each recipient. Workflows can also be configured to use a distribution matrix for sending To Do List or e-mail notifications to workflow step recipients.

**document**
An object used to track revisions to a design file in SmartPlant Foundation.

**document master**
An object used to group all the revisions of a document in SmartPlant Foundation.

**document revision**
An officially recognized change to a document.

**domain**
A set of data (for example: tool data, SmartPlant Foundation administration data, and schema data) that is segregated and managed independently in SmartPlant Foundation. Data segregation improves performance and maintains data integrity. The SmartPlant Enterprise authoring tools create data in one SmartPlant Foundation domain and publish into another domain.

**downstream forecasting**
A feature that uses timestring information and actual dates when steps were completed to provide an estimated completion date for subsequent steps.
**dump file**
A file that contains data exported from the SmartPlant Foundation data or system administration database. You can import database dump files using SmartPlant Foundation Server Manager.

**edge definition**
Single or multiple relationship definitions with direction. In the SmartPlant schema, an edge definition is used to traverse from a starting object to related objects.

**effectivity date**
The period of time for which historical data is displayed in SmartPlant Foundation.

**e-mail digest**
A collection of notification messages from SmartPlant Foundation that are sent together instead of separately. You can set a user preference in the Desktop Client to receive digests instead of individual e-mail messages.

**enumerated entry**
A member of an enumerated list that defines one possible value for a property in the SmartPlant schema. Enumerated values are sometimes called enumerated entries.

**enumerated list**
A list of possible string property values defined for a property definition in the SmartPlant schema. Enumerated sets are sometimes called enumerated lists, picklists, codelists, and lookups.

**exposes**
The relationship between interface definitions and property definitions in the SmartPlant schema. Interface definitions expose the property definitions for class definitions.
**file server**

A service that handles direct file transfer between vaults and the SmartPlant Foundation client.

**file type**

A setting in SmartPlant Foundation that specifies the format of attached files based on file extension. This setting determines how files are viewed, edited, and printed in SmartPlant Foundation.

**folder**

A grouping object that can contain a number of items. A folder can contain other folders, to build up a folder hierarchy. A folder can have an owner, which makes it visible only for that user, and it can have an owning group, which allows access for members of the group. Some uses of a folder include grouping objects, putting a folder's contents through a workflow, and generating a data list from a folder's contents.

**form**

A part of the SmartPlant Foundation client user interface that allows users to specify values for class definition properties.

**FTR**

Full-Text Retrieval; a separate module of SmartPlant Foundation that allows you to store, index, and search for text contained in or associated with objects managed by SmartPlant Foundation. Full-text retrieval creates an inverted index (a list of the individual words with locations in the files) and uses this index at search time.

**G**

**governing case**

The specific case used for an instrument.

**graph definition**

A connected network of edge definitions with structure. Each graph definition in the SmartPlant schema starts at an interface definition and traverses through one or more relationship definitions to another interface definition at the other end. Graph definitions are sometimes referred to as directed graph definitions.
**graphic report**
A filtered view of a drawing or model, displayed graphically in SmartPlant Foundation.

**graphic report definition**
A set of rules defined to display a drawing or model as a graphic report. The report definition is saved and is also available for use with any number of drawings or models in SmartPlant Foundation.

**greenfield**
A new plant on a site with no existing infrastructure.

**H**

**hierarchy**
A classified structure with superiors, or roots, and subordinates, or dependents, used for grouping data.

**host**
A computer that stores files.

**hotspot**
Graphical notification that a user can click a drawing item in a drawing or viewable file to display the properties for the item in SmartPlant Foundation.

**I**

**implies**
The relationship between two interface definitions in the SmartPlant schema. If an interface definition implies another interface definition, then any class definition that realizes the first interface definition can also realize the implied interface definition.

**integration**
Technology that standardizes and improves the communication among the various SmartPlant Enterprise authoring tools used in the course of designing, constructing, and operating a plant. Integration manages data exchange among these authoring tools, which enables sharing and re-use of plant information throughout the plant lifecycle.
**interface definition**
A named collection of property definitions that represents a role for a class definition in the SmartPlant schema.

**issue**
To release a document as part of a transmittal. The document is not considered issued until the status of the transmittal has been changed to issued.

**issue request**
A staging of documents and drawings to be issued with a transmittal. An issue request means that the documents or drawings are ready to be issued with a transmittal, but does not actually cause the transmittal to be issued.

**master file**
A document file that references other files.

**meta schema**
A set of schema objects that describe the objects in the SmartPlant schema. The meta schema provides the building blocks upon which the SmartPlant schema is built.

**method**
A call to an API that allows users to perform actions on objects or interfaces in SmartPlant Foundation.

**owning group**
The user group to which an object is assigned in SmartPlant Foundation.
Glossary

**picklist**
A list of applicable values for a given property in SmartPlant Foundation.

**plant**
An object that can represent the top level in the delivered SmartPlant Foundation data hierarchy. If you use a custom hierarchy, the object at the top level of the hierarchy may have a different name.

**Plant Breakdown Structure (PBS)**
The composition of the plant based on the grouping of physical objects by their function in the plant. The plant usually occupies the top level of the hierarchy and is typically followed by areas and units.

**print server**
A computer that processes print requests for a defined list of printers in SmartPlant Foundation.

**process cases**
Configurations for instruments that may include specific parameters, settings, or even components for use in a specific situation.

**profile**
See user profile.

**progress**
Functionality that allows users to track the development of deliverables, such as documents or items, against a project plan, indicating any deviations from the original plan.

**project**
A logical unit of data that is a subset of the items that make up a plant. A project is used for making controlled, incremental changes to the data in a plant. There can be multiple projects for a plant at any given time.

**property**
An object characteristic.
**property definition**
A basic attribute shared by all members of a class. Property definitions are grouped using interface definitions in the SmartPlant schema.

**publish**
To share a document and its data with other authoring tools by exporting an XML file containing the document data and relationships. When a document is published, the software places the XML file in the appropriate SmartPlant Foundation vault and loads the data from the XML file into the SmartPlant Foundation database. After the document is published, users can retrieve the data from the XML file located in the SmartPlant Foundation vault into other authoring tools.

**punchlist**
Provides a running to do list of outstanding scope for completions.

Q

**query**
A detailed search based on object properties.

**query scope**
A configuration for data queries and relationship expansions in SmartPlant Foundation.

R

**realizes**
The relationship between class definitions and interface definitions in the SmartPlant schema. Class definitions realize interface definitions. The interface definitions that are realized by a class definition expose the properties for that class definition.

**Reason For Issue (RFI)**
The reason a document is released as part of a transmittal.

**Reason For Receipt (RFR)**
The reason why a specific recipient was included on a transmittal or workflow step.
**reference file**

Files associated with a master file in SmartPlant Foundation.

**register**

To map an authoring tool and all its projects to a SmartPlant Foundation URL, which points to one SmartPlant Foundation database. You must register your authoring tool plant before you can publish and retrieve in an integrated environment.

**relationship**

An association between two objects.

**relationship definition**

Associations between interface definitions in the SmartPlant schema. Relationship definitions identify two specific objects that fulfill the roles on each end of the relationship.

**resurrected object**

A deleted authoring tool object that is reintroduced to the SmartPlant Foundation database when recovered tool data is republished. For example, a tool initially publishes a document containing an object, but later deletes the object and republishes. SmartPlant Foundation then detects that the object is deleted. However, if the tool restores data that was backed up before the object was deleted, through a data restoration or other tool-specific mechanism, and republishes, then SmartPlant Foundation recognizes that the object was previously deleted but has been reintroduced (resurrected).

**retrieve**

To import document data from an .XML file that was published by another authoring tool for the purpose of maintaining consistency of data across tools. When you retrieve a document, most authoring tools analyze the impact of the newly retrieved data on the existing database and then place tasks on the authoring tool's *To Do List*. The tasks on the *To Do List* allow you to create, delete, or modify items at the appropriate time in the design process.

**revision**

An officially recognized change to a document. Each revision of a document may have multiple versions.
**revision scheme**

A numbering convention for document revisions.

**role**

A role determines a user's level of access to data and functionality in a specific plant/project configuration. Users can belong to more than one role per configuration. Roles are defined by system administrators and are based on related access groups, domains, and owning groups.

**rollup**

The process of calculating progress data. Progress is calculated for every deliverable at every level of the hierarchy, and all of that information is available for viewing or reporting when you run a rollup. Rollups can be scheduled with official cut-off dates or can be run manually at any time.

**schema**

A model used to describe and validate the structure of XML files.

**Schema Component**

A suite of ActiveX components that provide functionality surrounding the creation, parsing, validation, and comparison of the SmartPlant schema and data. The tool adapters interact with the Schema Component to read the SmartPlant schema, to create data for publish, and to retrieve data.

**scoped by**

The relationship between property definitions and property types in the SmartPlant schema. The scoped by relationship specifies the property type that defines acceptable values, or scopes, a particular property definition. Every property definition in the SmartPlant schema is scoped by one and only one property type. All properties of that property definition must be of that property type.

**section**

A collection of display items used on SmartPlant Foundation forms.
**server**
A computer that stores or processes files.

**shared object definition**
A schema object used to group together similar class definitions that define the same object in different domains. Class definitions that can be shared have a Sharing relationship with shared object definitions in the SmartPlant schema.

**sharing**
The relationship between class definitions and shared object definitions in the SmartPlant schema. This relationship indicates that a class definition can be shared.

**SI**
International System of Units, sometimes referred to as the metric system. When values for units of measure are published, they are converted to SI units and stored, regardless of the units of measure selected when the user defined the value in the authoring tool.

**sign off**
To approve a particular revision of a document in SmartPlant Foundation. Signing off a document sets the document to be the current released revision, makes it official, and supersedes any previous released revisions. Document revisions that have been signed off are frozen and cannot be checked out.

**site**
Refers to the SmartPlant Foundation server settings that point to SmartPlant Foundation Administration and Data databases and vaults. Each site allows you to run SmartPlant Foundation operations on data associated with plants and projects configured in the database.

**SmartPlant Enterprise**
A suite of Intergraph engineering applications that are delivered together.

**SmartPlant schema**
An XML file that describes the structure of the XML files generated by integrated authoring tools in much the same way as a data dictionary describes the structure of a database. As tools publish documents in XML format, those documents must adhere to the format defined by the schema to ensure that the XML data can be loaded into SmartPlant Foundation and retrieved into the other authoring tools.
**status**
The state of a change object at the completion of each step in a workflow.

**step**
A process that must be performed in order to complete a workflow.

**subscribe**
To register interest in an object so that you receive a notification when the object is modified. You can manually subscribe to change notifications in the SmartPlant Foundation client.

**superseded**
Indicates that a newer, working version of the selected document exists.

**symbology**
Settings that determine how a drawing or model will appear when displayed as a graphical report in SmartPlant Foundation.

**T**

**TEF**
The Engineering Framework; technology behind the integration of SmartPlant Enterprise products.

**terminate**
To change the status of a SmartPlant Foundation object to terminated without removing it from the SmartPlant Foundation database. Terminating objects, instead of deleting them, allows you to continue to see the history of the object after termination.

**timestring**
A schedule that assigns a certain number of days for the completion for each step in the lifecycle of a deliverable.
**title block**

The portion of a drawing that contains information about the drawing, such as who created the drawing, when it was created, who approved it, and so on. The type of information included in the title block varies by drawing type, industry, and organization.

**To Do List**

A graphical list of tasks that require attention from the user. In SmartPlant Foundation, the To Do List contains workflow steps assigned to the user. In the authoring tools, such as SmartPlant P&ID and SmartPlant Instrumentation, the To Do List contains create, delete, and update tasks generated when a user retrieves a document.

**token**

A license that provides timed access to users of SmartPlant Foundation. When a user opens the software, a token is activated.

There are two types of tokens: daily and perpetual. Daily tokens are available to all users and are valid for 12 consecutive hours after the user logs on to SmartPlant Foundation. When a daily license token is checked out, a token is depleted from the daily token file. If there are no tokens left in the daily token file, then other users cannot access the software. Perpetual tokens are only available to a select group of system users and provide unlimited access to the software.

**tombstone**

Delete instructions for an object that has been removed in one of the authoring tools. Upon retrieval of a tombstone, delete tasks are created in the authoring tool's To Do List to allow the tool to delete the object from its database.

**tool**

See authoring tool.

**tool adapter**

See adapter.

**tool schema**

A set of schema objects that describe the data in the authoring tool databases before it is transformed into the format prescribed by the SmartPlant schema. The tool schema also specifies the mapping between objects in the tool database and the SmartPlant schema.
tool signature
A unique identifier for the relationship between a plant in SmartPlant Foundation and a specific plant in an authoring tool database. The relationship is created when an authoring tool registers with SmartPlant Foundation.

transmittal
A controlled package of documents used to perform, track, and record the distribution of project documentation among different design teams.

U
unit
Group of parts of the schematic and individual worlds of a plant that together perform a given process function. The identifying number of the unit is unique within the project and within the plant. Most companies, but not all, use the concept of unit.

unit of measure list
A collection of different units that measure the same property in SmartPlant Foundation.

UoM
A unit of measurement.

user
An object that specifies data about a person who is authorized to use SmartPlant Foundation.

user profile
Information about windows, configuration, and interface settings, saved by the SmartPlant Foundation client when you close the application and used to configure the application when you reopen it.

V
vault
A folder where files are stored on a host computer.
version
An intermediate update to an existing document that is tracked by the SmartPlant Foundation software.

view definition
A named group of properties extracted from the possible properties that a graph definition exposes. View definitions are used in an integrated environment to provide a different view of data from that provided by the underlying schema.

virtual directory
A Web folder created in IIS that points to a physical folder on the Web server. Virtual directories are used by SmartPlant Foundation to run applications and services from the SmartPlant Foundation server and to transfer files between file servers and clients.

W

Web Portal
Provides the functionality of the SmartPlant Foundation client system through an easy-to-deploy Internet Explorer web browser. Based on the software configuration and authorization of the System Administrator, you can perform the following functions:
- View information from the database about a specific object
- Search for objects in the database
- View drawings and 3D models
- View a history for a particular object
- View relationships between objects

weighting
The percentage of a project that is made up by a step, sub-step, or deliverable. When you create a step or sub-step for a deliverable or assign a deliverable to workpack, you must indicate what percentage of the work that item represents. For example, if a deliverable is 30 percent complete when a particular step is finished, the weighting for that step is 30.

wildcard
A character that helps you narrow your search for objects in the SmartPlant Foundation database. You can use wildcards in any text box in the Find and Query dialog boxes. Text wildcards in SmartPlant Foundation include the following:
- ? - Finds any single character
- * - Finds any string of characters
- % - Performs the same function as *
**Work Breakdown Structure (WBS)**

The composition of the plant based on the construction work to be completed. The plant usually occupies the top level of the hierarchy; it is typically followed by projects, contracts, and documents.

**Workflow**

A series of steps defining actions to be taken on an object in SmartPlant Foundation.

**Working document**

A document that has not been signed off in SmartPlant Foundation.

**XML**

Extensible Markup Language; the format for all documents published or retrieved in an integrated environment. These XML files must conform to the structure defined by the SmartPlant schema.
Index

Configuring Folder Permissions in Windows Server 2008 • 181
Configuring FTR and Remote Services for HTTPS • 85
Configuring Integrated Windows Authentication (IWA) in a Double Hop Web Portal Configuration • 148
Configuring Microsoft Office Files for Generating a PDF/CSF • 120
Configuring PDF Generation with SmartPlant Markup Plus • 112
Configuring Security for the Application Server • 73
Configuring SmartPlant Foundation • 111
Configuring the Application Server • 48
Configuring the Security Model • 131
Configuring the SmartPlant License Manager Client • 143
Configuring Vault Replication • 105
Configuring Vaults on the File Server • 100
Configuring Virtual Directories for a Remote File Server • 97
Configuring Web Portals • 145
Configuring Windows Server 2008 R2 • 64
Considerations for Setting Up Vault Replication • 108
container • 191
contract • 191
correlation • 191
Create a Folder on the SmartPlant Foundation Application Server • 71
Create a New Application Pool in Windows Server 2008 • 179
Create a New Host • 101
Create a New Site • 54
Create a New User Account for Application Isolation • 177
Create a New Vault • 103
Create a New Web Portal • 145
Create a Relationship Between a Host and an Organization • 103
Create a SQL Server database • 142
Create an Oracle database • 141
create scope • 192
Create the SmartPlant Foundation Database Instance • 34
Creating and Configuring Application Pools in Windows Server 2008 • 178
current document • 192
Customer Support • 163
cut-off date • 192

D
data list • 192
Data Protection and Recovery for Installations Using Oracle • 158
Data Protection and Recovery for Installations Using SQL Server • 159
data sheet • 192
data sheet template • 192
database • 192
Database Creation Script Files • 59
Define database system information • 140
Define MIME Types • 66
Define server information • 139
Define the site schema location • 55
Defining Application Pool Settings for SPFRemoteServices • 117
Defining the Application Server Default Folder Structure • 49, 135
Delete a Web Portal • 146
Delete a Web Portal Server • 147
Delivered Data Sheets • 130
design basis • 192
design file • 193
Desktop Client Command Line Parameters • 169
digest • 193
Disabling the Business Intelligence Module • 156
display item • 193
distribution matrix • 193
document • 193
document master • 193
document revision • 193
domain • 193
downstream forecasting • 193
dump file • 194

eedge definition • 194
Edit IIS Site Bindings • 69
effectivity date • 194
e-mail digest • 194
Enable Integrated Windows Authentication for IIS 7 • 80
Enabling HTTPS for the Business Intelligence Service • 84
Enabling Integrated Windows Authentication for the Business Intelligence Service • 82
Enhancing Performance • 131
enumerated entry • 194
enumerated list • 194

210 SmartPlant Foundation Installation and Setup Guide
Index

exposes • 194

F
file server • 195
file type • 195
folder • 195
Force a Class of Object to a Vault • 105
form • 195
FTR • 195

G
governing case • 195
Grant permissions • 135
Granting Permissions • 50
graph definition • 195
graphic report • 196
graphic report definition • 196
greenfield • 196

H
hierarchy • 196
host • 196
hotspot • 196

I
IIS Requirements for an Integrated Environment • 65
IIS Security • 80
implies • 196
Incorporate the Enhanced Mechanical Equipment Data Sheets into an Existing Site • 128
Increasing Trust for Deploying the Desktop Client • 167
Install an SSL Certificate • 83
Install and Configure the Software for Citrix • 176
Install Citrix Software • 175
Install Database Software on the Application Server • 36
Install Database Software on the Database Server • 33
Install Enhanced Mechanical Equipment Data Sheets • 127
Install in Silent Mode • 44
Install Prerequisite Software on the Client Workstations • 153
Install Schema Component • 41
Install Schema Component.NET • 40, 154
Install SmartPlant Foundation • 42
Install the Desktop Client • 155
Install the File Server Software • 97
Installing Hot Fix Packages • 47
Installing License Manager on a Remote Server • 183
Installing Prerequisite Software on the Application Server • 39
Installing Prerequisite Software on the License Server • 134
Installing Software on the Application Server • 40
Installing the Desktop Client in Silent Mode • 156
Installing the SmartPlant License Manager Client on the License Server • 134
Installing the Software in Silent Mode • 44
integration • 196
interface definition • 197
issue • 197
issue request • 197

L
Limit Access to the SmartPlant Foundation Server Web Site for IIS 7 • 88
Link the License Server to a SmartPlant Foundation Site • 143

M
Manually Edit and Run Server Manager Permissions Scripts • 51
master file • 197
Maximum Positive and Negative Database Values • 35
Mechanical Equipment Data Sheet Options and Functionality • 130
meta schema • 197
method • 197
Minimum IIS Application Mappings • 66
Modify the Default Folder Structure • 49
Modify Web Portal Server Settings • 146
Modifying File Service Settings • 58
Modifying FTR Settings • 59
Modifying Site Settings • 56
Modifying Site System Settings • 59
Move a Web Portal onto a New Server • 150

O
Obtaining Your Host ID and Disk Serial Number • 184
Optimizing Oracle Databases • 36
Oracle Database Port Assignments • 89
Index

Oracle Template Files • 60
owning group • 197

P
Parameter Formatting • 169
PDF Generation with Custom .INI Settings • 113
Performing a Cold Database Backup on the SmartPlant Foundation Server • 160
Permissions for SmartPlant Foundation Processes • 86
Permissions for Users on a Windows 7 Client with UAC Enabled • 154
Permissions Script Files • 52, 137
picklist • 198
plant • 198
Plant Breakdown Structure (PBS) • 198
Port Assignments for SmartPlant Enterprise • 89
Preface • 9
print server • 198
process cases • 198
profile • 198
progress • 198
project • 198
property • 198
property definition • 199
publish • 199
punchlist • 199

Q
query • 199
query scope • 199

R
realizes • 199
Reason For Issue (RFI) • 199
Reason For Receipt (RFR) • 199
reference file • 200
register • 200
Relate Replicated Vaults to Source Vaults • 109
relationship • 200
relationship definition • 200
Relationships Between Hosts and Organizations • 102
Remote File Service Overview • 96
Remove Audit Domain from an Upgraded Database • 131
Restore SmartPlant Foundation Databases Using Oracle • 160
Restore SmartPlant Foundation Databases Using SQL Server • 161
resurrected object • 200
retrieve • 200
revision • 200
revision scheme • 201
role • 201
rollup • 201
Run Server Manager Permissions Scripts • 51
Running Desktop Client from a UNC Share • 165
Running Desktop Client from a URL • 166

S
schema • 201
Schema Component • 201
scoped by • 201
section • 201
Secure the Host for HTTPS • 83
Security for IIS Sites • 87
Security Model Configuration • 131
server • 202
Set a Default Mail Server for JMAIL • 125
Set Permissions for Running SmartPlant Foundation Loader • 51
Set Security on the Oracle Home Folder • 35
Set Up a License Manager Site • 139
Set Up Basic Authentication for a Double Hop Web Portal Configuration • 148
Set Up Database Access • 37
Set Up HTTPS • 83
Set Up Integrated Windows Authentication • 80
Set Up Kerberos Authentication for a Double Hop Web Portal Configuration • 149
Set Up Remote File Services for Vault Replication • 108
Setting HTTPS on the DefaultSPFServerURL • 83
Setting Launch and Active Permissions • 116
Setting the Theme for Running the Desktop Client on the Server • 72
Setting up a Host for the File Server • 101
Setting Up a SmartPlant Foundation License Server • 133
Setting Up an Alternate Scheduler Server • 126
Setting Up Client Workstations • 153
Setting Up Database Access on the Application Server • 36
Setting Up Databases • 33
Setting Up E-mail for SmartPlant Foundation • 125
Setting Up Enhanced Mechanical Engineering Data Sheets • 127, 128
Setting Up PDF Generation • 112
Setting Up Sites • 53
Setting Up SmartPlant Foundation File Servers • 95
Setting Up the Application Server • 39
Setting Up the Database Server • 33
shared object definition • 202
sharing • 202
SI • 202
sign off • 202
site • 202
SmartPlant Enterprise • 202
SmartPlant Foundation Alternate Server • 27
SmartPlant Foundation Application Server • 25
SmartPlant Foundation Database Server • 23
SmartPlant Foundation File Server • 28
SmartPlant Foundation Hardware and Software Recommendations • 21
SmartPlant Foundation Internationalization • 17
SmartPlant Foundation License Server • 26
SmartPlant Foundation Port Assignments • 89
SmartPlant Foundation Recommendation Summary • 22
SmartPlant Foundation Settings for SmartPlant Markup Plus • 114
SmartPlant Foundation Web Portal Client • 30
SmartPlant Foundation Web Portal Server • 30
SmartPlant Foundation Workstation • 29
SmartPlant schema • 202
SQL Server Port Assignments • 91
SQL Server Template Files • 61
Start the license server wizard • 139
status • 203
step • 203
subscribe • 203
Suggested IIS Configuration Settings • 69
superseded • 203
symbology • 203
System Requirements for Citrix Servers • 175

T
TEF • 203
terminate • 203
Test Email Configuration Command • 125
Test Email Configuration Dialog Box • 125
timestring • 203
title block • 204
to Do List • 204
token • 204
tombstone • 204
tool • 204
tool adapter • 204
tool schema • 204
tool signature • 205
transmittal • 205

U
unit • 205
unit of measure list • 205
UoM • 205
Update sites with new license server • 140
Upgrading SmartPlant Foundation • 93
user • 205
user profile • 205
Using Alternate Rendition Service Debug • 122
Using Server Manager to Configure the Application Server • 47
Using the Web Portal with Microsoft Internet Explorer 8 or 9 • 151

V
vault • 205
Vault Replication Configuration Checklist • 108
version • 206
view definition • 206
virtual directory • 206

W
Web Portal • 206
Web Portal URL Parameters • 173
weighting • 206
Welcome to SmartPlant® Foundation • 15
wildcard • 206
Work Breakdown Structure (WBS) • 207
workflow • 207
working document • 207
Index

X
XML • 207